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Preface

Lenovo® XClarity Administrator is a centralized hardware resource management application 
that is integrated with Lenovo server systems that reduces data center complexity, speeds 
system provisioning, and reduces labor that is required for ongoing administration. 

XClarity Administrator provides agent-free, out-of-band management for System x servers 
and Flex System™ compute nodes and components, including the Chassis Management 
Module and networking.

In this book, we provide instructions and recommendations about how to plan for and install 
XClarity Administrator, and guidance about its use to manage endpoint devices that are 
based on best practices.

This book is meant for administrators who want to learn from experts about how to get the 
most out of XClarity Administrator to simplify data center infrastructure management while 
maximizing productivity.

Lenovo servers are based on Intel Xeon processors.
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Chapter 1. Introduction

Lenovo XClarity is a new software solution for centrally managing large pools of Lenovo data 
center hardware. Designed to simplify and speed foundational infrastructure management 
tasks, XClarity helps administrators implement a modern, software-driven approach to data 
center management. 

Figure 1-1 shows a broad overview of the capabilities of Lenovo XClarity Administrator.

Figure 1-1   Overview

1
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1.1  Lenovo XClarity focus

Lenovo XClarity is focused on the following key systems management functions:

� Automatic network-based discovery of end points
� Visualizing asset and status information of managed end points
� Monitoring with real-time alerting, event management, and call home services
� Taking basic action on managed end points, such as powering systems on or off
� Managing firmware through user-defined compliance policies
� Managing configuration settings through templates that are called configuration patterns
� Installing operating systems and hypervisors to bare metal servers 

XClarity is available as a virtual appliance, which makes it easy to deploy as needed locally or 
remotely to managed end points. It provides extensive Windows PowerShell support for 
scripting and extensive REST APIs to enable scalable web services. REST APIs enable 
organizations that are investing in cloud orchestration and management to extend those 
investments to view and control Lenovo data center hardware from external automation or 
service management tools. XClarity also provides immediately available Integrators for key 
management tools, such as Microsoft System Center and VMware vCenter, with which 
administrators can centrally manage software and physical infrastructures.

Lenovo XClarity is available in two editions: Lenovo XClarity Administrator and the Lenovo 
XClarity Pro bundle. XClarity Administrator is the foundational element in the XClarity solution 
and can be used by itself to simplify hardware management across multiple systems. XClarity 
Pro includes Administrator and XClarity Integrators for Microsoft System Center and VMware 
vCenter, which enables managing Lenovo hardware from those external tools and provides 
advanced automation in clustered environments. 

Table 1-1 lists the differences between the editions.

Table 1-1   Comparing Lenovo XClarity editions

Lenovo XClarity Feature Lenovo XClarity
Administrator

Lenovo XClarity
Pro

Resource 
Management

Auto-discovery and monitoring 
with real-time alerts and events

Included Included

Firmware updates and 
compliance

Included Included

Configuration patterns Included Included

OS and hypervisor deployment to 
bare metal servers

Included Included

Extensibility REST APIs Included Included

SNMP and Syslog forwarding Included Included

Supported platforms Lenovo Flex System Included Included

Lenovo M5 and X6 servers Included Included

Older System x platforms Included
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For customers who use older System x hardware management tools, Table 1-2 lists the 
differences between these older tools and XClarity.

Table 1-2   Comparing Lenovo XClarity Administrator with other management products

Management and 
automation in ESXi 
and Hyper-V clusters

Manage hardware from 
virtualization management 
console

Included

Non-disruptive server updates Included

Non-disruptive server restarts Included

VM evacuation on user-defined 
platform alerts

Included

Lenovo XClarity Feature Lenovo XClarity
Administrator

Lenovo XClarity
Pro

Feature Lenovo 
XClarity 
Administrator

Lenovo 
XClarity Pro

Flex System
Manager

Systems
Director

Fabric
Manager

Architecture and supported platforms

Software virtual 
appliance

Supported Supported No support No support No support

Hardware appliance No support No support Supported No support No support

Agent-based No support No support Supported Supported No support

Compute, network, 
storage support

No support No support Supported
(Flex System I/O, 
IBM Storage)

No support No support

Blade and rack server 
support

Supported Supported Supported Supported No support

Virtualization 
management

No support No support Supported Supported No support

Hardware management

Automatic discovery Supported Supported Supported No support No support

Monitoring, alerting, 
event management

Supported Supported Supported Supported No support

Policy-based firmware 
updates

Supported Supported No support No support No support

Configuration 
templates

Supported Supported Supported No support No support

Virtualization of 
address pools

Supported
(Flex System)

Supported No support No support Supported
(Flex System 
and 
BladeCenter)

OS and hypervisor 
deployment

Supported Supported Supported No support No support
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1.2  This book

This guide is based on best practices that were learned from real-world usage in production 
environments by subject matter experts across the globe, and available technical 
documentation. Use this guide to help you prepare and plan setting up and configuring 
Lenovo XClarity Administrator, and to make full use of XClarity Administrator functionality to 
discover and manage physical endpoints.

Automation in clusters

Non-disruptive server 
restarts

No support Supported Supported Supported No support

Non-disruptive server 
updates

No support Supported Supported Supported No support

VM evacuation on 
platform alert

No support Supported Supported Supported No support

Extensibility

REST APIs Supported Supported No support No support No support

Feature Lenovo 
XClarity 
Administrator

Lenovo 
XClarity Pro

Flex System
Manager

Systems
Director

Fabric
Manager
4 Lenovo XClarity Administrator Planning and Implementation Guide



Chapter 2. Planning and licensing

Before you install and implement Lenovo XClarity Administrator, we recommend reviewing 
the recommendations in this chapter, which can help you plan for installation and day-to-day 
management.

This chapter includes the following topics: 

� 2.1, “Hardware and software requirements” on page 6
� 2.2, “Port requirements” on page 16
� 2.3, “Management considerations” on page 19
� 2.4, “Network considerations” on page 22
� 2.5, “Managed server limitations” on page 31
� 2.6, “High availability considerations” on page 31
� 2.7, “Licensing” on page 33

2
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2.1  Hardware and software requirements

Before you install Lenovo XClarity Administrator and manage any rack servers or Flex System 
chassis, you must ensure that the hardware and software in your environment is supported by 
Lenovo XClarity Administrator.

This section includes the following topics:

� 2.1.1, “Virtual appliance prerequisites”
� 2.1.2, “Supported hardware” on page 7
� 2.1.4, “Supported firmware” on page 14
� 2.1.5, “Supported web browsers” on page 16

2.1.1  Virtual appliance prerequisites

The XClarity Administrator appliance runs in a virtual machine (VM). Ensure that you meet 
the prerequisites that are described in this section before you attempt to install Lenovo 
XClarity Administrator.

NTP server prerequisites
Ensure that there is a Network Time Protocol (NTP) server in your network that can be used 
as the NTP server for Lenovo XClarity Administrator. An NTP server is required to ensure 
synchronization between the XClarity Administrator and all managed endpoints.

Host prerequisites 
The XClarity Administrator appliance runs as a VM on the host system. The following 
Hypervisors are supported for installing the XClarity Administrator appliance:

� VMware ESXi 5.1 update 1 or Version 5.5 or later
� Microsoft Windows Server 2012 or higher with Hyper-V installed

The host system that is running the XClarity Administrator appliance VM has the following 
minimum requirements:

� Two 4-core Intel Xeon processors.
� 6 GB of memory
� A minimum of 64 GB of storage for use by XClarity Administrator

Configuring the NTP server: Consider using the host on which XClarity Administrator is 
installed as NTP server when you are deciding where to configure the server. If you decide 
as such, ensure that the host is accessible over the management network (typically the 
Eth0 interface).
6 Lenovo XClarity Administrator Planning and Implementation Guide



2.1.2  Supported hardware

Lenovo XClarity Administrator supports several System x servers and Flex System compute 
nodes and other devices.

At the time of this writing the latest version of XClarity Administrator was v1.0.3 build 2, the 
following tables Table 2-1 and Table 2-3 on page 8 list the System x servers and Flex System 
endpoints that can be managed by XClarity Administrator. For the latest information about 
supported systems, see the support site for Lenovo XClarity Administrator at the following 
URL: 
http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.lenovo.lxca.doc/pl
an_supportedhw.html

Table 2-1   Lenovo System x Rack Servers: Supported servers

Installing XClarity Administrator on a Flex System compute node: XClarity 
Administrator can be installed on a Flex System compute node; however, considerations 
must be made when firmware updates are deployed. 

When firmware updates are applied via XClarity Administrator, the managed system must 
be restarted. Therefore, if XClarity Administrator is hosted on a managed Flex System 
compute node, you cannot use XClarity Administrator to apply firmware updates to all 
servers in that entire chassis (specifically, this managed compute node). Restarting this 
managed compute node or host system also restarts XClarity Administrator, which makes 
XClarity Administrator unavailable to complete the updates on the Managed compute node 
or host system. Therefore, you must clear this Flex node when updates are made on the 
Flex Chassis.

Requirements for IMMv2 Advanced FoD key on System x rack servers: Operating 
System Deployment and Remote Control features of Lenovo XClarity Administrator require 
that the IMMv2 Advanced Feature on Demand (FoD) key is installed on System x servers.

However, XClarity Administrator still can manage the server if the IMMv2 Advanced FoD 
key is not enabled. In the case of Remote Control, if the FoD key is not detected on a 
server, the remote-control session displays the “Missing activation key” message for the 
server when the list of available servers is shown.

Support with limitations: Some endpoints are supported with limitations, as listed in 
Table 2-1 and Table 2-3 on page 8. For more information about these limitations, see 2.1.3, 
“Restrictions on supported hardware” on page 10.

Product Lenovo XClarity Administrator Support

Lenovo System x M5 servers (v3 processors)

x3500 M5 (5464) Supported. Consider the following points:
� Lenovo XClarity Administrator v1.0.1 or later is 

required.
� This server displays as a rack server, even if it is 

configured as a tower server.
� This server is not supported in the rack view.
� This server requires dual processors if you want to 

configure I/O adapters in the server by using 
configuration patterns.
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http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.lenovo.lxca.doc/plan_supportedhw.html


Table 2-3 lists the supported NeXtScale Nodes. 

Table 2-2   NeXtScale supported Servers

Table 2-3 lists the Flex Chassis and components and the level of support for Lenovo XClarity 
Administrator. For more information about limitations, see 2.1.3, “Restrictions on supported 
hardware” on page 10.

Table 2-3   Flex Systems: Supported compute nodes, chassis, and switches

x3550 M5 (5463) Supported

x3650 M5 (5462) Supported

Lenovo System x X6 servers (v2 processors)

x3850, x3950 X6 (6241) Supported

Product Lenovo XClarity Administrator Support

nx360 M5 (5465) Supported
Note:
� Lenovo XClarity Administrator v1.0.2 or later is required.
� For servers running ESXi, ESXi 5.1 u3 or later is required to 

support operating-system deployment.
� Power and thermal metrics are not supported for this server.
� This server is not supported in the rack view.

Product Lenovo XClarity Administrator support

Flex System Chassis

Carrier-Grade Chassis (7385) Supported 
Note:
� (Lenovo XClarity Administrator v1.0.1 

or later is required)

Enterprise Chassis (7893) Supported

Enterprise Chassis (8721) Supported

Enterprise Chassis (8724) Supported

Flex System Chassis Management Modules

 CMM (First Generation) Supported with limitations

 CMM2 Supported

Flex system Compute Nodes

x220 (2585, 7906) Supported with limitations

x222 (2589, 7916) Supported with limitations

x240 (2588, 7162, E5-2600 v2) Supported 

x240 (7863, 8737, 8738, 8956, E5-2600) Supported with limitations

x240 (8737, E5-2600 v2) Supported with limitations

x240 M5 (2591, 9532) Supported 

Product Lenovo XClarity Administrator Support
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x280, x480, x880 X6 (4258, 7196) Supported 

x280, x480, x880 X6 (4259, 7903) Supported with limitations

x440 (2590, 7167) Supported 

x440 (2584, 7917) Supported with limitations

Network switches

Cisco Nexus B22 Fabric Extender for IBM Flex System 
(94Y5350)

Supported with limitations

Cisco Nexus B22 Fabric Extender with FET bundle for 
IBM Flex System (94Y5355)

Supported with limitations

CN4093 10 Gb Converged Scalable Switch 
(00FM510)

Supported
Note: For Lenovo XClarity Administrator 
v1.0.1, downlink ports cannot be 
configured using configuration patterns. 
They must be configured using the 
management interface for the Flex switch.

CN4093 10 Gb Converged Scalable Switch (00D5823) Supported with limitations

EN2092 1 Gb Ethernet Scalable Switch (49Y4294) Supported with limitations

EN4023 10 Gb Scalable Switch (94Y5212) Supported with limitations

EN4093 10 Gb Scalable Switches (49Y4270) Supported with limitations

EN4093R 10 Gb Scalable Switches (00FM514) Supported
Note: For Lenovo XClarity Administrator 
v1.0.1, downlink ports cannot be 
configured using configuration patterns. 
They must be configured using the 
management interface for the Flex switch.

EN4093R 10 Gb Scalable Switches (95Y3309) Supported with limitations

EN6131 40 Gb Ethernet Switch (90Y9346) Supported with limitations

FC3171 8 Gb SAN Switch (69Y1930) Supported with limitations

FC5022 12-port 16 Gb SAN Scalable Switch 
(88Y6374)

Supported with limitations

FC5022 24-port 16Gb SAN Scalable Switch 
(00Y3324)

Supported with limitations

FC5022 24-port 16Gb ESB SAN Scalable Switch 
(90Y9356)

Supported with limitations

IB6131 InfiniBand Switch (90Y3450) Supported with limitations

Network interconnect and pass-thru modules

EN4091 10 Gb Ethernet Pass-thru (88Y6043) Supported with limitations

FC3171 8 Gb SAN Pass-Thru Module (69Y1934) Supported with limitations

Product Lenovo XClarity Administrator support
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2.1.3  Restrictions on supported hardware

As listed in Table 2-1 on page 7 and Table 2-3 on page 8, some endpoints are supported with 
limitations. The limitations are described next.

Processor and memory usage data
For servers that are supported with limitations, some functions are not available under the 
Power and Thermal sections in the System Summary Status and Health section.

As an example of the difference between supported systems and systems with limited 
support for XClarity Administrator, the CPU Subsystem-Level Utilization history for an x3550 
M5 (a supported system) is shown in Figure 2-1.

Figure 2-1   Example of CPU Subsystem-Level Utilization for a supported system (x3650 M5)

SI4091 System Interconnect Module (00FE327) Supported
Note: For Lenovo XClarity Administrator 
v1.0.1, downlink ports cannot be 
configured using configuration patterns. 
They must be configured using the 
management interface for the Flex switch.

SI4093 System Interconnect Module (00FM518) Supported
Note: For Lenovo XClarity Administrator 
v1.0.1, downlink ports cannot be 
configured using configuration patterns. 
They must be configured using the 
management interface for the Flex switch.

SI4093 System Interconnect Module (95Y3313) Supported with limitations

Product Lenovo XClarity Administrator support
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The Memory Subsystem-Level Utilization history for the same server is similar to the graph 
that is shown in Figure 2-2 on page 11.

Figure 2-2   Memory Subsystem-Level Utilization history for a supported system (x3550 M5)

Notes: Consider the following points:

� CPU subsystem-level utilization represents the percentage of the total CPU bandwidth 
that is in use as measured by performance counters that are built in to the CPU. (It 
might differ slightly from the CPU utilization that is reported by the operating system.)

� Figure 2-1 shows one data point per 30-second interval. This display might differ from 
the actual management module interface display.

Historical memory data: Under some circumstances, historical memory usage is not 
available. At the time of this writing, this issue is a known defect and currently being 
investigated.

Note: Consider the following points:

� Memory subsystem-level utilization represents the percentage of the total memory 
channel controller bandwidth that is in use (it does not reflect the amount of memory 
that currently is used).

� The chart that is shown in Figure 2-2 shows one data point per 30-second interval. This 
display might differ from the actual management module interface display.
Chapter 2. Planning and licensing 11



Figure 2-3 shows a server with limited support.

Figure 2-3   CPU and Memory Utilization data not supported

Configuring network ports through configuration patterns 
Configuring network ports through configuration patterns is the ability configure the Flex 
Network Switches internal ports via configuration patterns for the I/O adapters, as shown in 
Figure 2-4 on page 12.

Figure 2-4   Option to Apply settings to Chassis switch internal ports, where applicable

At the time of this writing, the switch-related settings can apply only to the following types of 
switches: 

� Flex System Fabric CN4093 10Gb Converged Scalable Switch
� Flex System Fabric EN4093R 10Gb Scalable Switch
� Flex System Fabric SI4093 System Interconnect Module
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� Flex System Fabric SI4091 System Interconnect Module

Power Systems compute nodes
Flex System compute nodes with POWER processors are not supported; however, these 
systems still are displayed in the chassis views and you can view the properties and status for 
these compute nodes.

Chassis Management Module 
For full support, chassis require one or two Chassis Management Module II (CMM2) units 
installed (part number 00FJ669). 

Chassis that feature CMMs are supported with limitations. The following functions are not 
available:

� Aggregated event and audit logs from I/O Modules

� Network configuration (configuring the Flex Network Switches internal ports via 
configuration patterns for the I/O adapters, as shown in Figure 2-4)

Flex System I/O Modules
Flex I/O modules with firmware that is signed by IBM are supported, but with limitations as 
listed in Table 2-3 on page 8. Therefore, the following functions are not available: 

� Aggregated event and audit logs

� Network configuration (configuring the Flex Network Switches internal ports via 
configuration patterns for the I/O adapters, as shown in Figure 2-4 on page 12) 

At the time of this writing, the switch-related settings apply only the following types of 
switches:

– Flex System Fabric CN4093 10Gb Converged Scalable Switch
– Flex System Fabric EN4093R 10Gb Scalable Switch
– Flex System Fabric SI4093 System Interconnect Module
– Flex System Fabric SI4091 System Interconnect Module

Lenovo Flex switches are supported with Lenovo CMMs only.

If a switch is in stacked or protected mode, you cannot update its firmware by using XClarity 
Administrator.

For more information about IO adapter support, see this Lenovo XClarity Supported Devices 
website:

https://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-XCLACOM

Incompatibility with CMM and CMM2: A CMM and a Lenovo CMM2 cannot be installed 
in the same chassis at the same time. The firmware on a CMM cannot be upgraded to 
change it to a Lenovo CMM2 because they contain different hardware.
Chapter 2. Planning and licensing 13
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V7000 Storage Node
Limited support is provided for Flex System V7000 Storage Nodes, including displaying 
status and detailed information, powering on and off, virtually reseating the canisters, and 
launching the management module, as shown in Figure 2-5.

Figure 2-5   Supported actions performed on Storage Node v7000

Table 2-1 on page 7 lists the Rack Server Models and the level of support for Lenovo XClarity 
Administrator.

2.1.4  Supported firmware

Before Lenovo XClarity Administrator is used to manage your endpoints, ensure that the 
firmware on each endpoint is at the minimum required level, as listed in Table 2-4.

Table 2-4   Minimum Firmware Requirements

Server Required firmware level

Flex Systems endpoints

Enterprise Chassis with CMM2 Compute nodes:
� x240 (2588, 7162, E5-2600 v2)
� x240 M5 (2591, 9532)
� x440 (2590, 7167)
� x280, x480, x880 X6 (4258, 7196)

Network switches:
� CN4093 10 Gb Converged Scalable Switch (00FM510)
� EN4093R 10 Gb Scalable Switches (00FM514)

Network interconnect and pass-thru modules:
� SI4091 System Interconnect Module (00FE327)
� SI4093 System Interconnect Module (00FM518)

Flex stack release 2.0 or later

For more information about Flex Chassis minimum 
supported firmware versions, see this website:

https://www-304.ibm.com/software/brandcatalog/pur
esystems/centre/update?uid=S_PUREFLEX
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If your firmware is not at a supported level, use the following tools and methods to update the 
firmware to the supported level so that the endpoint can be discovered and managed:

� Chassis

Use the CMM web interface to update firmware on the CMM.

For more information about firmware for Flex System chassis and devices, see this 
PureSystems Center website:

https://ibm.com/software/brandcatalog/puresystems/centre/

� Servers

Use the following ToolsCenter™ update tools to update firmware on System x servers:

– Lenovo Bootable Media Creator™ website:

http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-BOMC 

Enterprise Chassis with CMM 
Compute nodes:
� x220 (2585, 7906)
� x222 (2589, 7916)
� x240 (7863, 8737, 8738, 8956, E5-2600)
� x240 (8737, E5-2600 v2)
� x280, x480, x880 X6 (4259, 7903)
� x440 (2584, 7917)

Network switches:
� Cisco Nexus B22 Fabric Extender (94Y5350)
� Cisco Nexus B22 Fabric Extender with FET bundle 

(94Y5355)
� CN4093 10 Gb Converged Scalable Switch (00D5823)
� EN2092 1 Gb Ethernet Scalable Switch (49Y4294)
� EN4023 10 Gb Scalable Switch (94Y5212)
� EN4093R 10 Gb Scalable Switches (95Y3309)
� EN6131 40 Gb Ethernet Switch (90Y9346)
� FC3171 8 Gb SAN Switch (69Y1930)
� FC5022 12-port 16 Gb SAN Scalable Switch 

(88Y6374)
� FC5022 24-port 16Gb SAN Scalable Switch (00Y3324)
� FC5022 24-port 16Gb ESB SAN Scalable Switch 

(90Y9356)
� IB6131 InfiniBand Switch (90Y3450)

Network interconnect and pass-thru modules:
� EN4091 10 Gb Ethernet Pass-thru (88Y6043)
� FC3171 8 Gb SAN Pass-Thru Module (69Y1934)
� SI4093 System Interconnect Module (95Y3313)

Flex stack release 1.3.2.1 or later

Note: Flex stack release 1.3.2.1 is the minimum that is 
required to discover and manage the chassis. 

For more information about the minimum supported 
firmware versions, see this website:

https://www-304.ibm.com/software/brandcatalog/pur
esystems/centre/update?uid=S_PUREFLEX#version=fsm
132

You must update chassis endpoints to the latest firmware 
level for full management support. After the Flex Chassis 
is managed within XClarity Administrator, the firmware 
must be updated. For more information about updating 
firmware, see Chapter 9, “Deploying firmware updates” 
on page 205.

Note: If you intend to manage CMMs that are running 
firmware level of Flex stack release 1.3.2.1 2PET12K - 
2PET12Q, are running for more than three weeks, and 
are in a dual-CMM configuration, you must virtually 
reseat the CMMs before updating the firmware by using 
Lenovo XClarity Administrator.

Lenovo System x Rack Servers

� x3500 M5 Type 5464
� x3550 M5 Type 5463
� x3650 M5 Type 5462
� x3850 X6 Type 6241
� x3950 X6 Type 6241

April 2015 level or later

NeXtScale Servers 

� nx360 M5 (5465) April 2015 level or later

Server Required firmware level
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– Lenovo UpdateXpress website:

http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-XPRESS

For more information about firmware for server and devices, see this Fix Central website:

http://ibm.com/support/fixcentral/

� Flex switches

Use the CMM web interface or CMM command-line interface (CLI) to update with the 
switch.

2.1.5  Supported web browsers

Ensure that you can access Lenovo XClarity Administrator by using one of the following 
supported browsers:

� Chrome (all versions)
� Firefox ESR 31.x
� Microsoft Internet Explorer 9, 10, or 11
� Safari (IOS7 or later and OS X)

2.2  Port requirements

There are several ports that must be available, depending on how firewalls are implemented 
in your environment. If these ports are blocked or used by another process, some Lenovo 
XClarity Administrator functions might not work.

Review the following to determine which ports need to be opened based on your 
environment:

� Access to the Lenovo XClarity Administrator server

If the Lenovo XClarity Administrator server and all managed endpoints are behind a 
firewall and you intend to access those devices from a browser that is outside of the 
firewall, you must ensure that the Lenovo XClarity Administrator ports are open. If SNMP 
and SMTP are used for event management, you might also need to ensure that the ports 
that are used by the Lenovo XClarity Administrator server for event forwarding are open.

The Lenovo XClarity Administrator server listens on (and responds through) the ports that 
are listed in Table 2-5.

Table 2-5   Ports that must be open for the Lenovo XClarity Administrator Server

Using the latest versions: Browser support is tied to tested web browsers. If you have a 
newer browser version than the versions that are listed here, the browser might not be 
supported. However, this lack of support does not mean that the browser does not work. 
We recommend the use of the documented supported web browsers.

Port TCP or 
UDP

Direction Affected devices Purpose

80 TCP Inbound/
Outbound

Support website
Address range: 129.42.0.0/18

Used for HTTP and DDP file downloads as part 
of the Update process (Call Home).
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Optionally, the ports that are listed in Table 2-6 must be open for event forwarding from the 
Lenovo XClarity Administrator server to other event management tools.

Table 2-6   Ports that must be open for other event management tools (SMTP and SNMP)

� Access between Lenovo XClarity Administrator and managed endpoints

If the managed endpoints, such as compute nodes or rack servers, are behind a firewall 
and you intend to manage those devices from a Lenovo XClarity Administrator server that 
is outside of that firewall, you must ensure that all ports that are involved with 
communications between Lenovo XClarity Administrator and the IMM on each managed 
endpoint are open. These ports are listed in Table 2-7.

If you intend to install operating systems on managed endpoints through the Lenovo 
XClarity Administrator server, make sure that you review the list of ports in Table 2-8 on 
page 18. 

Table 2-7   Ports that must be open between Lenovo XClarity Administrator and managed endpoints

443 TCP Inbound/
Outbound

Client computers that access 
Lenovo XClarity Administrator

Used by HTTPS for web access and REST 
communications. Outbound direction is used if 
Call home is enabled.

4944 HTTPS Inbound Client computers that access 
Lenovo XClarity Administrator

Used for the help system server.

Port TCP or 
UDP

Direction Affected devices Purpose

Port TCP or 
UDP

Direction Affected devices Purpose

25 UDP Outbound The SMTP server that is 
receiving the events.

Used when SMTP event forwarding is 
configured. This port number is configurable from 
the Lenovo XClarity Administrator interface.

161 UDP Inbound The SNMP manager that 
receives the traps.

Used when SNMP event forwarding with user 
authentication is configured.

162 UDP Outbound The SNMP manager that 
receives the traps.

Used when SNMP event forwarding is 
configured. This port number is configurable from 
the Lenovo XClarity Administrator interface.

514 UDP Outbound The Syslog server that is 
receiving the events.

Used when Syslog event forwarding is 
configured. This port number is configurable from 
the Lenovo XClarity Administrator interface.

Port TCP or 
UDP

Direction Affected devices Purpose

22 TCP Inbound/ 
Outbound

� IMM on each managed server
� CMMs in each managed 

chassis
� Flex switches in each managed 

chassis

Used by Secure Shell (SSH) for SFTP 
access.

162 UDP Inbound Flex switches in each managed 
chassis

Used to receive SNMP traps from Flex 
switches.
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� Access between Lenovo XClarity Administrator and data network for OS deployment

To install operating systems on managed endpoints, ensure that the ports that are listed in 
Table 2-8 are open to the network that is used as the data network (or operating system 
deployment network).

Table 2-8   Ports that must be available to deploy operating Systems

For more information about ports that must be available for deployed operating systems, 
see the following Information Center page:

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.lenovo.lxca.doc
/operating_system_firewall_rules_for_deployment.html 

If you are deploying Microsoft Windows, the ports that are listed in Table 2-9 must be 
available for Windows profiles.

427 TCP Inbound/ 
Outbound

� IMM on each managed server
� CMMs in each managed 

chassis
� Flex switches in each managed 

chassis

Used by Service Location Protocol (SLP) 
for Chassis Discovery.

3888 TCP Inbound/ 
Outbound

IMM on each managed server Used for remote control tunneling.

5989 TCP Inbound/ 
Outbound

CMM Used for CIM communications with CMM.

Note: This port number is configurable from 
the CMM interface.

6091 TCP Inbound/ 
Outbound

CMM Secure TCP command Mode port

Note: This port is configurable from the 
CMM interface.

9090 TCP Inbound/ 
Outbound

� IMM on each managed server
� CMMs in each managed 

chassis
� Flex switches in each managed 

chassis

Used by HTTPS for CIM indications

50636 TCP Inbound IMM on each managed server Used by the authentication server for 
secure traffic. Receives client certificates.

50637 TCP Inbound � MM on each managed server
� CMMs in each managed 

chassis

Used by the authentication server for 
secure traffic.

Port TCP or 
UDP

Direction Affected devices Purpose

Port TCP or 
UDP

Direction Affected devices Purpose

3001 TCP Inbound/ 
Outbound

IMM and host on each managed 
server

Used for operating system deployment

8443 TCP Inbound/ 
Outbound

IMM and host in each managed 
server 

Used for operating system deployment.
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Table 2-9   Ports that must be available

2.3  Management considerations

There are several alternatives to choose from when managing endpoints. Depending on the 
endpoints that are managed, you might need multiple management solutions that are running 
at the same time.

Lenovo XClarity Administrator provides hardware management for System x rack servers and 
Flex System devices, including the CMM, compute nodes, and Flex switches.

Consider the following factors regarding chassis management by XClarity Administrator:

� A specific chassis or rack server can be managed by only one instance of XClarity 
Administrator.

� If a chassis is managed by XClarity Administrator, you cannot use the following 
management alternatives for the same chassis:

– Flex System Manager management node
– IBM Fabric Manager

However, you can use the following other management solutions: 

– Microsoft System Center
– VMware vCenter 

Port TCP or 
UDP

Direction Affected devices Purpose

137 UDP Inbound/ 
Outbound

Host operating system on 
each managed server to 
which Microsoft Windows is 
deployed.

Used for Windows operating 
system deployment (SMB 
client/server communications).

138 UDP Inbound/ 
Outbound

139 UDP Inbound/ 
Outbound

445 TCP Inbound/ 
Outbound

Note: Lenovo offers Lenovo XClarity Integrator for Microsoft System Center and the 
Lenovo XClarity Integrator for VMware vCenter to enable more System x and Flex 
monitoring and management from within the Microsoft and VMware Interfaces. For 
more information about these solutions, see the following websites:

� Lenovo XClarity Integrator for VMware vCenter:

http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-VMWARE 

� Lenovo XClarity Integrator for Microsoft System Center:

http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-MANAGE 
Chapter 2. Planning and licensing 19

http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-VMWARE
http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-VMWARE
http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-MANAGE
http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-MANAGE


� The Flex System compute nodes with POWER processors and Flex System V7000 
Storage Node cannot be managed by XClarity Administrator. 

These devices appear in the graphical interface for XClarity Administrator and you can 
view device properties and status. You also can power on and off a storage node, virtually 
reseat the canisters, and start the management module. However, you must use other 
management alternatives to take any actions on the devices, such as updating or 
configuring the devices. Consider the following points:

– Use a Hardware Management Console to manage POWER-based compute nodes. 
You can use the Power Systems Hardware Management Console to manage these 
devices even if you also are managing that chassis by using XClarity Administrator.

– Use the web interface or the CLI that is provided with the Flex System V7000 Storage 
Node to manage that device.

� XClarity Administrator does not manage Flex switches that are installed in managed 
chassis. They appear in the graphical interface for XClarity Administrator, but you must 
use the Flex switches interfaces (web or CLI) to manage the Flex switches.

2.3.1  Transitioning from Flex System Manager to XClarity Administrator

If you are planning to manage a chassis with Lenovo XClarity Administrator and that chassis 
is managed by a Flex System Manager, review the considerations that are described in this 
section to successfully transition the chassis to XClarity Administrator management.

Depending on your configuration, transitioning from management by Flex System Manager to 
management by XClarity Administrator might be disruptive to your running workloads. 
Therefore, consider performing the transition during a maintenance window to minimize 
downtime with running workloads.

Complete the following steps to ensure that XClarity Administrator can manage a chassis that 
was managed by Flex System Manager:

1. Prepare the chassis to be removed from management by Flex System Manager.

Optionally, complete the following steps to prepare the chassis to be removed from 
management by the Flex System Manager:

a. If you use IBM Fabric Manager (FM), which is part of the Flex System Manager, to 
virtualize addresses, modify Fabric Manager to use push mode to distribute virtual 
addresses through the CMM. If you are using Fabric Manager in pull mode and Flex 
System Manager is powered off, the virtual addresses are unavailable after the next 
restart of the compute node.

Differences between IBM FM to XClarity Administrator: Fabric Manager 
supports the concept of a standby node. If there is a hardware failure, Fabric 
Manager assigns the virtual address of the failed compute node to the standby node 
so that it can automatically take over the workload from the failed node. 

XClarity Administrator does not support the concept of a standby node. With 
XClarity Administrator, if a server fails after you deploy a server pattern, you can 
recover the server by unassigning the profile from the failed server and then 
reassigning that profile to a standby server. 
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If virtual addresses are changed, you also must adjust infrastructure services, as 
described in the following examples:

• If the worldwide port name (WWPN) is changed for a compute node, you also must 
adjust SAN zoning and LUN mapping.

• If the MAC address for a port is changed, you must adjust the MAC-to-IP address 
binding in the DHCP server or clustering software.

• IBM FM can configure a virtual start target WWN. If you do not migrate properly, 
you can lose the ability to start your operating system.

b. Remove the chassis from management by using the Flex System Manager.

c. Manage the chassis from XClarity Administrator. For more information about managing 
a chassis, see Chapter 6, “Discovery, inventory, and other systems information” on 
page 121

d. Remove any agents that were installed on devices that are managed by the Flex 
System Manager. The XClarity Administrator implements an agentless management 
approach. Therefore, you do not need to install agents on managed compute nodes. 
Although the installed agents have no effect on XClarity Administrator management 
functions, you can choose to remove those agents and reclaim the space on the 
compute node.

2.3.2  Transitioning from IBM FM to XClarity Administrator

As of this writing, the recommended option to assist with the transition from IBM FM to 
XClarity Administrator is to use the assistance of Lenovo Enterprise Solution Services, as 
listed in Table 2-10 on page 21.

Table 2-10   Contact details for Lenovo Enterprise Solution Services

2.3.3  Transitioning from IBM Systems Director to XClarity Administrator

When the transition is made from IBM Systems Director to XClarity Administrator, the 
following tasks must be completed:

� Confirm the systems that are transitioned are supported by XClarity Administrator. For 
more information, see 2.1.2, “Supported hardware” on page 7.

� It is not generally recommended to manage a system using both IBM Systems Director 
and XClarity Administrator, therefore you should remove the system from being managed 
by IBM Systems Director before managing the System from XClarity Administrator. This 
process requires removing the operating system-managed endpoint and the Server 
managed endpoint for the specific server to be transitioned.

Region Contact 

Asia Pacific (GCG, ANZ, ASEAN, Japan, Korea, ISA) x86svcAP@lenovo.com

North America (US, Canada) x86svcs@lenovo.com

Latin America (Brazil, Mexico, SSA) x86svcLA@lenovo.com

Europe, Middle East, Africa x86svcEP@lenovo.com
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� Uninstall any IBM Systems Director Agents that might be installed (that is, IBM Systems 
Director Common Agent or IBM Systems Director Platform Agent), unless you use the 
Lenovo XClarity Integrator for Microsoft System Center and require these agents for 
Hardware Alerts from the IBM Legacy systems. The XClarity Administrator implements an 
agentless management approach. Therefore, you do not need to install agents on 
managed compute nodes. Although the installed agents have no effect on XClarity 
Administrator management functions, you can choose to remove those agents and 
reclaim the space on the compute node.

2.3.4  Using management software other than XClarity Administrator

You can use management software other than Lenovo XClarity Administrator (such as IBM 
Endpoint Manager or Microsoft Systems Center Operations Manager) to monitor endpoints in 
your data center that are managed by XClarity Administrator.

If you intend to use management software other than XClarity Administrator to monitor your 
managed endpoints and if that management software uses SNMPv3 communication, you 
must prepare your environment by completing the following steps before you manage the 
chassis by using the XClarity Administrator. If the chassis are already managed by XClarity 
Administrator, you must first unmanage the chassis (for more information, see 6.5, 
“Unmanaging a system” on page 155):

1. Create a user account on the CMM.

2. Configure the SNMPv3 properties for the user account, including passwords, 
authorization privileges, encryption, and trap address.

3. Configure the user account to provision the SNMP user account to the IMM.

4. Enable node account management on the CMM.

5. Repeat steps 1 - 3 for up to 12 SNMP user accounts that are supported by CMM.

6. For each new SNMP user account, log on and change the first-time password.

To avoid having to change the password for the SNMP user accounts on the first logon and 
again every 90 days, you can set the security policy and the global login setting on the CMM 
to “Legacy” (this practice is not recommended). You can change these settings before or after 
you manage the chassis.

2.4  Network considerations

When the Lenovo XClarity Administrator installation is planned, consider the network 
topology that is implemented in your environment and how the XClarity Administrator fits into 
that topology.

SNMPv3 passwords: The password for the SNMPv3 user accounts expires after 90 days. 
You must change the password before they expire to avoid account disruption. To change 
the password, you must first unmanage the chassis from XClarity Administrator, change 
the passwords, and then manage the chassis again.
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2.4.1  Network types

Most environments implement the following types of networks. Based on your requirements, 
you might implement only one of these networks or you might implement all three:

� Management network

The management network often is reserved for communications between XClarity 
Administrator and the management processors for managed endpoints. For example, the 
management network might be configured to include XClarity Administrator, the CMMs for 
each managed chassis, and the Integrated Management Modules (IMMs) of each server 
that is managed by XClarity Administrator.

� Data network

The data network often is used for communications between the operating systems that 
are installed on the servers and the company intranet, the Internet, or both.

� Operating system deployment network

In some cases, an operating system deployment network is set up to separate out the 
communications that are required to deploy operating systems on servers. If implemented, 
this network often includes XClarity Administrator and all server hosts.

Instead of implementing a separate operating system deployment network, you might 
choose to combine this functionality in the management network or the data network.

2.4.2  XClarity Administrator network interfaces

Lenovo XClarity Administrator has two separate network interfaces (Eth0 and Eth1) that can 
be defined for your environment, depending on the network topology that you implement.

Consider the following points when one network interface (Eth0) is present:

� The interface must be configured to support the discovery and management of hardware. 
It must communicate with the CMM in each managed chassis, with the IMM of each 
managed compute node and rack server, and with the Flex switches in each managed 
chassis.

� If you intend to acquire firmware updates from the Fix Central website (electronic 
fix-distribution website at https://ibm.com/support/fixcentral/), this interface must 
also have connectivity to the Internet (typically through a firewall). Otherwise, you must 
manually import firmware updates into the management-sever updates repository.

� If you intend to deploy operating system images to managed servers, the network 
interface must have IP network connectivity to the server network interface that is used to 
access the host operating system and must be configured with an IPv4 address.

Consider the following points when two network interfaces (Eth0 and Eth1) are present:

� The Eth0 interface often is connected to the management network and is used to discover 
and manage hardware. It must communicate with the CMM of each managed chassis, 

Use of DHCP: Configure the rack servers and chassis components in ways that minimize 
IP address changes. Consider the use of static IP addresses instead of Dynamic Host 
Configuration Protocol (DHCP). If DHCP is used, ensure that IP address changes are 
minimized to avoid any issues, such as an IP address potential changes when the DHCP 
lease expires.
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with the IMM of each managed server, and with the Flex switches that are installed in each 
managed chassis.

� If you intend to acquire firmware updates from the Fix Central website (see 
https://ibm.com/support/fixcentral/), the Eth0 interface must also have connectivity to 
the Internet (often through a firewall). Otherwise, you must import firmware updates into 
the management server updates repository.

� The Eth1 interface often is connected to the data network (an internal data network, a 
public data network, or both) and used to manage host operating systems.

� The network interface that you chose to use to deploy operating system images to the 
managed servers must have IP-network connectivity to the server network interface that is 
used to access the host operating system and must be configured with an IPv4 address.

� If you implemented a separate network for deploying operating systems, you can 
configure Eth1 to connect to that network instead of the data network. However, if the 
operating system deployment network does not have access to the data network, you 
must define another I/O interface on that server so that the server host has access to the 
data network when you install the operating system on a server.

2.4.3  Network configurations

Table 2-11 lists possible configurations for the XClarity Administrator network interfaces that 
are based on the type of network topology that was implemented in your environment. Use 
this table to determine how to define Eth0 and Eth1.

Table 2-11   Role of Eth0 and Eth1 based on network topology

Use of DHCP: If the network interface for the management network is configured to use 
DHCP, the management-interface IP address might change when the DHCP lease expires. 
If the IP address changes, you must unmanage the chassis and rack servers and then 
remanage them.

To avoid this issue, change the management interface to a static IP address or ensure that 
the DHCP server configuration is set so that the DHCP address is based on a MAC 
address or that the DHCP lease does not expire.

Network Topology Eth0 role Eth1 role 

Converged network (single management, data, 
and operating system deployment network)

� Management
� Operating 

system 
deployment

None

Management network and separate 
data/operating system deployment network

Management Operating system deployment

Management network and separate data 
network (operating system deployment not 
supported)

Management None

Separate networks for management, data, and 
operating system deployment

Management Operating system deployment

Note: If the operating system deployment 
network does not have access to the data 
network, configure an extra interface on the 
servers to provide connectivity from the host 
operating system on the servers to the data 
network, if needed.
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Single data and management network
In this network topology, management communications, data communications, and operating 
systems deployment occur over the same network. This topology is referred to as a 
converged network.

When you install XClarity Administrator, define network settings by using the following 
considerations:

� Eth0 must be configured to support the discovery and management of hardware. It must 
communicate with the CMM of each managed chassis, with the IMM of each managed 
server, and with the Flex switches that is installed in each managed chassis.

� Optionally, if you intend to acquire firmware updates from the Fix Central website 
(http://ibm.com/support/fixcentral), Eth0 must also have connectivity to the Internet 
(typically through a firewall). Otherwise, you must import firmware updates into the 
firmware-updates repository.

� Optionally, if you intend to deploy operating system images to managed servers, Eth0 
must have IP network connectivity to the server network interface that is used to access 
the host operating system and it must be configured with an IPv4 address.

� You can set up the XClarity Administrator host on any system that meets the requirements 
for the XClarity Administrator, including a managed server (compute node or rack server) 
only when you implement a single data and management network topology or a virtually 
separate data and management network topology; however, you cannot use the XClarity 
Administrator to apply firmware updates to that managed server. 

Even then, only some of the firmware is applied with immediate activation. The XClarity 
Administrator forces the target server to restart, which also restarts the XClarity 
Administrator. When applied with deferred activation, only some firmware is applied when 
the XClarity Administrator host is restarted.

You can also configure Eth1 to connect to the same network from XClarity Administrator to 
support redundancy.

Management/operating system deployment 
network and separate data network.

� Management
� Operating 

system 
deployment

None 

Note: Configure an extra interface on the 
servers to provide connectivity from the host 
operating system on the server to the data 
network, if needed.

Network Topology Eth0 role Eth1 role 
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Figure 2-6 shows an example implementation for a Single Data and Management network or 
converged network topology.

Figure 2-6   Single data and management network

Physically separate data and management network
In this network topology, the management network and the data network are physically 
separate networks and the operating system deployment network is configured as part of the 
management network or the data network.

When you install XClarity Administrator, define network settings by using the following 
considerations:

� Eth0 is configured to support the discovery and management of hardware. It must 
communicate with the CMM of each managed chassis, with the IMM of each managed 
server, and with the Flex switches that are installed in each managed chassis. If you 
intend to acquire firmware updates from Fix Central website 
(http://ibm.com/support/fixcentral) this interface must also have connectivity to the 
Internet (typically through a firewall). Otherwise, you must import firmware updates into 
the management server updates repository.

� Eth1 often is configured to communicate with an internal data network, a public data 
network, or both.

Data / management /
OS deployment network
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virtual appliance

System x rack servers
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� If you intend to deploy operating system images to managed servers, the Eth0 interface or 
the Eth1 interface must have IP network connectivity to the server network interface that is 
used to access the host operating system and it must be configured with an IPv4 address.

Figure 2-7 shows an example implementation of separate management and data networks in 
which the operating system deployment network is configured as part of the data network.

Figure 2-7   Operating system network as part of the data network

Figure 2-8 shows another example implementation of separate management and data 
networks in which the operating system deployment network is configured as part of the 
management network. In this implementation, XClarity Administrator does not need 
connectivity to the data network.

Note: If you implement a separate operating system deployment network, Eth1 might 
be configured to connect to that network instead of the data network. If the operating 
system deployment network does not have access to the data network, you must define 
an extra I/O interface on that server when you install the operating system so that the 
server host has access to the data network.

Note: If the operating system deployment network does not have access to the data 
network, configure an extra interface on the servers to provide connectivity from the host 
operating system on the server to the data network, if needed.

Eth0 Eth1

Data / management /
OS deployment network

Management
network

Data / OS
deployment network

Lenovo XClarity
Administrator

virtual appliance
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(firmware updates)
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Figure 2-8   Operating system network as part of the management network

Virtually separate data and management network
In this topology, the data network and management network are virtually separate. Packets 
from the data network and from the management network are sent over the same physical 
connection. VLAN tagging is used on all management-network data packets to keep the 
traffic between the two networks separated.

When you install the XClarity Administrator, define network settings by using the following 
considerations:

� Eth0 is configured to support the discovery and management of hardware. It must 
communicate with the CMM of each managed chassis, with the IMM of each managed 
server, and with the Flex switches that are installed in each managed chassis. If you 
intend to acquire firmware updates from Fix Central website, this interface must also have 
connectivity to the Internet (often through a firewall). Otherwise, you must import firmware 
updates into the management server updates repository.

� Eth1 often is configured to communicate with an internal data network, a public data 
network, or both.

Note: If the XClarity Administrator is installed on a host that is running on a managed 
compute node in a chassis, you cannot use the XClarity Administrator to apply firmware 
updates to that entire chassis because it also update the managed compute node. When 
firmware updates are applied, the host system must be restarted.

Eth0 Eth1

Data
network
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Fix Central
(firmware updates)
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� If you intend to deploy operating system images to managed servers, the Eth0 interface or 
the Eth1 interface must have IP network connectivity to the server network interface that is 
used to access the host operating system and it must be configured with an IPv4 address.

You can set up the XClarity Administrator host on any system that meets the requirements for 
the XClarity Administrator, including a managed server (compute node or rack server) only 
when you implement a single data and management network topology or a virtually separate 
data and management network topology.

However, you cannot use the XClarity Administrator to apply firmware updates to that 
managed server. Even then, only some of the firmware is applied with immediate activation. 
The XClarity Administrator forces the target server to restart, which also restarts the XClarity 
Administrator. When applied with deferred activation, only some firmware is applied when the 
XClarity Administrator host is restarted.

Figure 2-9 shows an example implementation of virtually separate management and data 
networks in which the operating system deployment network is configured as part of the data 
network. In this example, the XClarity Administrator is installed on a managed compute node.

Figure 2-9   Operating system network as part of the data network

Note: If you implement a separate operating system deployment network, Eth1 might 
be configured to connect to that network instead of the data network. If the operating 
system deployment network does not have access to the data network, you must define 
an extra I/O interface on that server when you install the operating system so that the 
server host has access to the data network.
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Management-only network
In this topology, XClarity Administrator has access to the management network only. It does 
not have access to the data network. However, XClarity Administrator must have access to 
the operating system deployment network if you intend to deploy operating system images 
from XClarity Administrator to managed servers.

When you install XClarity Administrator and define network settings, Eth0 must be configured 
to support the discovery and management of hardware. It must communicate with the CMM 
of each managed chassis, with the IMM of each managed server, and with the Flex switches 
that are installed in each managed chassis.

If you intend to acquire firmware updates from Fix Central, Eth0 must also have connectivity 
to the Internet (often through a firewall). Otherwise, you must import firmware updates into 
the management server updates repository.

If you intend to deploy operating system images to managed servers, Eth0 must have IP 
network connectivity to the server network interface that is used to access the host operating 
system and it must be configured with an IPv4 address.

You also can configure Eth1 to connect to the same network from XClarity Administrator to 
support redundancy.

Figure 2-10 shows an example implementation for a management-only network in which 
operating system deployment from XClarity Administrator is not supported.

Figure 2-10   Management-only network with no support for operating system deployment
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Figure 2-11 shows an example implementation of a management-only network with support 
for operating system deployment.

Figure 2-11   Management-only network with support for operating system deployment

2.5  Managed server limitations 

At the time of this writing Lenovo XClarity Administrator supports up to 20 chassis with 
compute nodes and a similar number of rack servers.

For more information about minimum requirements of the host system, see 2.1.1, “Virtual 
appliance prerequisites” on page 6.

2.6  High availability considerations

To set up high availability (HA) for XClarity Administrator, you should use the high availability 
features that are part of the host operating system (that is, VMware ESX/ESXi or Microsoft 
Hyper-V).

VMware ESX or ESXi
In a VMware HA environment, multiple hosts are configured as a cluster. Shared storage is 
used to make the disk image of a VM available to the hosts in the cluster. The VM runs on 
only one host at a time. When there is an issue with the VM, another instance of that VM is 
started on a backup host.

VMware HA requires the following components:

� A minimum of two hosts on which ESX or ESXi is installed. These hosts become part of 
the VMware cluster.
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� A third host on which VMware vCenter is installed.

VMware vCenter can be installed on one of the hosts that is used in the cluster. However, 
if that host is powered off or not usable, you also lose access to the VMware vCenter 
interface.

� Shared storage (data stores) that can be accessed by all hosts in the cluster. You can use 
any type of shared storage that is supported by VMware. The data store is used by 
VMware to determine whether a VM should fail over to a different host (heart-beating).

For more information about setting up a VMware HA cluster (VMware 5.0), see the page 
“Create a vSphere HA Cluster” in the vSphere 5 Documentation Center: 

https://pubs.vmware.com/vsphere-50/index.jsp#com.vmware.vsphere.avail.doc_50/GUID-
B53060B9-2704-4EE2-B97A-AE6FEBCE3356.html 

Complete the following steps to set up an HA environment:

1. Set up shared storage that is to be accessible from all hosts in the cluster.

2. Install ESXi on two servers, each with static IP addresses. Ensure that VMware vCenter is 
configured on a separate server

3. Start VMware vCenter.

4. Configure the other two hosts to work with VMware vCenter.

a. Create the cluster.

b. Add the hosts to the cluster.

c. Add both data stores to the hosts in the cluster.

5. Deploy XClarity Administrator to the cluster.

Microsoft Hyper-V
To implement High Availability (HA) for XClarity Administrator in a Microsoft Hyper-V 
environment, use the HA functionality that is provided for the Hyper-V environment.

More information is available from Microsoft to configure HA at the following Technet URL:

https://technet.microsoft.com/en-us/library/cc754482.aspx 

Complete the following steps to set up a high-availability environment:

1. Set up the domain controller:
a. Perform the initial DHCP setup.
b. Set up DNS.
c. Set up Active Directory - Domain Services (AD-DS)
d. Complete the DHCP setup.

2. Set up the first host:

a. Install Microsoft Windows 2012 R2.
b. Join the AD-DS domain.
c. Add the following features:

VMware ESX and vCenter compatibility: Ensure that you install a version of VMware 
vCenter that is compatible with the versions of ESX or ESXi that are installed on the 
hosts to be used in the cluster to avoid any version support issues. 

Note: You need the second data store for the heartbeat.
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• Hyper-V
• Failover clustering

3. Set up the second host:

a. Install Microsoft Windows 2012 R2
b. Join the AD-DS domain.
c. Add the following features:

• Hyper-V
• Failover clustering

4. Configure the shared storage (such as iSCSI) on the domain controller and both hosts.

5. Configure failover clustering.

6. Add the XClarity Administrator image.

2.7  Licensing

Lenovo XClarity Administrator is a licensed product and is available in the following editions:

� XClarity Administrator (Stand-alone option)

� XClarity Pro (bundled with the XClarity Integrators for VMware vCenter and Microsoft 
System Center)

Both editions are available with a 1, 3, or 5-year software subscription and support. The 
editions also are available on a per-server or per-chassis basis. 

If you have a fully populated chassis with 14 nodes, the per-chassis licensing is more 
cost-effective; however, you might want to purchase per-server licensing for Flex System 
compute nodes if, for example, the chassis was not fully populated with nodes.

The one-time charge for the product includes the license, software subscription, and support. 
It is delivered as a software virtual appliance for VMware or Microsoft Hyper-V via the 
Passport Advantage online licensing.

Many clients might have a service and support agreement running with IBM Flex System 
Manager, IBM Systems Director Standard Edition, or IBM Fabric Manager (Stand-alone). If 
you have such an agreement in place, you are entitled to XClarity Pro at no extra cost for the 
remainder of the current service and support agreement. This is all administered via IBM 
Passport Advantage online licensing program.

2.7.1  Licensing example

If you have two years remaining of a 3-year IBM Flex System Manager Service and support 
agreement, you can transition free of cost to XClarity Pro for the remaining two years. 
XClarity Administrator and the XClarity Integrator licenses show up under the Flex System 
Manager entitlement

When it is time to renew this agreement, you renew the service and support agreement for 
XClarity Pro. The entitlement then is under XClarity Pro and not under IBM Flex System 
Manager.
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2.7.2  Part numbers

The part numbers for geographical regions are listed in Table 2-13, Table 2-14 on page 34, 
and Table 2-15 on page 35.

XClarity Pro includes XClarity Integrator for Microsoft System Center and XClarity Integrator 
for VMware vCenter.

Table 2-12   Part numbers: Per managed server (North America, Asia Pacific, and Japan)

Table 2-13   Part numbers: Per Managed Server (EMEA and Latin America)

Table 2-14   Part numbers: Per managed chassis (North America, Asia Pacific, and Japan)

Lenovo XClarity Administrator and XClarity Pro per managed server for 
United States, Asia Pacific, Canada, and Japan

Part number

Lenovo XClarity Administrator per Managed Server w/1 Year SW S&S 00JY340

Lenovo XClarity Administrator per Managed Server w/3 Year SW S&S 00JY341

Lenovo XClarity Administrator per Managed Server w/5 Year SW S&S 00JY342

Lenovo XClarity Pro per Managed Server w/1 Year SW S&S 00MT201

Lenovo XClarity Pro per Managed Server w/3 Year SW S&S 00MT202

Lenovo XClarity Pro per Managed Server w/5 Year SW S&S 00MT203

Lenovo XClarity Administrator and Lenovo XClarity Pro per managed 
server for Europe Middle East, Africa, and Latin America

Part number

Lenovo XClarity Administrator per Managed Server w/1 Year SW S&S 00JY346

Lenovo XClarity Administrator per Managed Server w/3 Year SW S&S 00JY347

Lenovo XClarity Administrator per Managed Server w/5 Year SW S&S 00JY348

Lenovo XClarity Pro per Managed Server w/1 Year SW S&S 00MT207

Lenovo XClarity Pro per Managed Server w/3 Year SW S&S 00MT208

Lenovo XClarity Pro per Managed Server w/5 Year SW S&S 00MT209

Lenovo XClarity Administrator and Lenovo XClarity Pro per managed 
chassis for United States, Asia Pacific, Canada, and Japan

Part number

Lenovo XClarity Administrator, per Managed Chassis w/1 Year SW S&S 00JY337

Lenovo XClarity Administrator, per Managed Chassis w/3 Year SW S&S 00JY338

Lenovo XClarity Administrator, per Managed Chassis w/5 Year SW S&S 00JY339

Lenovo XClarity Pro per Managed Chassis w/1 Year SW S&S 00MT198

Lenovo XClarity Pro per Managed Chassis w/3 Year SW S&S 00MT199

Lenovo XClarity Pro per Managed Chassis w/5 Year SW S&S 00MT200
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Table 2-15   Part numbers: Per managed chassis (EMEA and Latin America)

Lenovo XClarity Administrator and Lenovo XClarity Pro per managed 
chassis for Europe Middle East, Africa, and Latin America

Part number

Lenovo XClarity Administrator, per Managed Chassis w/1 Year SW S&S 00JY343

Lenovo XClarity Administrator, per Managed Chassis w/3 Year SW S&S 00JY344

Lenovo XClarity Administrator, per Managed Chassis w/5 Year SW S&S 00JY345

Lenovo XClarity Pro per Managed Chassis w/1 Year SW S&S 00MT204

Lenovo XClarity Pro per Managed Chassis w/3 Year SW S&S 00MT205

Lenovo XClarity Pro per Managed Chassis w/5 Year SW S&S 00MT206
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Chapter 3. Security

The Lenovo XClarity Administrator User Management interface is used to access security 
settings. From this interface, the following settings can be configured: 

� Users
� Role groups
� Authentication server
� User-account security settings
� Cryptography
� Server certificates

User administration, security options, and authentication servers are described in this 
chapter, which includes the following topics:

� 3.1, “User administration” on page 38
� 3.2, “Connecting an external LDAP server” on page 41
� 3.3, “User account security settings” on page 50
� 3.4, “Cryptography and security certificates” on page 52
� 3.5, “Implementing a secure environment” on page 55

3

© Copyright Lenovo 2016. All rights reserved. 37



3.1  User administration

Lenovo XClarity Administrator uses a single Lightweight Director Access Protocol (LDAP) 
authentication server for central user management. The LDAP server can be local to XClarity 
Administrator or can be an external authentication server. This section describes 
administering the local LDAP server.

3.1.1  Managing user accounts

User accounts are used to log on to the XClarity Administrator. The same users accounts are 
used to log on to all Flex Chassis Management Modules (CMM) and all server Integrated 
Management Modules (IMM) that are managed by the XClarity Administrator.

Creating user accounts
Complete the following steps to add a user to XClarity Administrator:

1. From the XClarity Administrator menu bar, click Administration → Security.

2. Click Users under the Users and Groups section. The Users Management page opens.

3. Click the Create icon to create a user (highlighted in red in Figure 3-1). The Create New 
User dialog opens.

Figure 3-1   Create New User option
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4. Enter the following information in the dialog:

– A user name and description for the user.

– The new password and then confirm the new password.

The rules for the passwords are based the current account security settings. The 
default security setting rules are shown in Figure 3-1 on page 38. For more information 
about changing the default user account security settings, see 3.3, “User account 
security settings” on page 50 

5. Select one or more role groups to authorize the user to perform appropriate tasks. For 
more information about role groups and how to create custom role groups, see 3.1.2, 
“Roles and Role Groups” on page 39.

6. Set the Change password on first access option to Yes if you want to force the user to 
change the password the first time the user logs in to XClarity Administrator.

7. Click Create.

3.1.2  Roles and Role Groups

Security in XClarity Administrator is based in Roles and Role Groups. A role is used to control 
user access to resources and limit the tasks that users can perform on those resources. A 
role group is a collection of one or more roles. 

The roles that are configured in a role group determine the level of access that is granted to 
each role group member. Each XClarity Administrator user must be a member of at least one 
role group.

The following roles are predefined in XClarity Administrator:

� LXC-SUPERVISOR: Users that are assigned this role can access, configure, and perform 
all available operations on the hardware manager and all managed components.

� LXC-OPERATOR: Users that are assigned this role can view all configuration and status 
information about the hardware manager and all managed components. This role prohibits 
users from performing operations or modifying configurations settings on the hardware 
manager and managed components.

� LXC-SECURITY-ADMIN: Users that are assigned this role can modify security settings 
and perform security-related operations on the hardware manager and managed 
components. The user in this role also can view all configuration and status information 
about the hardware manager and managed components.

� LXC-ADMIN: Users that are assigned this role can modify non-security-related settings 
and perform all non-security-related operations on the hardware manager, including 
updating and restarting the hardware manager. The user in this role also can view all 
configuration and status information about the hardware manager and managed 
components.

� LXC-HW-ADMIN: Users that are assigned this role can modify non-security settings and 
perform non-security-related operations on managed hardware, including updating and 
restarting managed hardware. The user in this role also can view all configuration and 
status information about the hardware manager and managed components.

Reserved roles: Two reserved roles are listed with the default roles. LXC-SYSRDR and 
LXC-SYSMGR are reserved roles and cannot be used for administration.
Chapter 3. Security 39



Creating a role group
Complete the following steps to create a role group:

1. From the XClarity Administrator menu bar, click Administration → Security.

2. Click Role Groups under the Users and Groups section. The Group Management page is 
displayed.

3. Click the Create icon to create a role group (highlighted in red in Figure 3-2). The Create 
New Role Group dialog is displayed. 

Figure 3-2   Create New Role Group option

4. Enter a group name and description.

5. Select one or more authorization roles from the Role list to assign to the new group.

6. Click Create.
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3.2  Connecting an external LDAP server

Lenovo XClarity Administrator uses an authentication server to verify user credentials and 
control access to resources and tasks. The authentication server is a Lightweight Directory 
Access Protocol (LDAP) server. XClarity Administrator uses a single authentication server for 
central user management of all managed endpoints, except for Flex System I/O modules. 

When an endpoint is managed by XClarity Administrator, the managed endpoint and its 
installed components (except Flex System I/O modules) are configured to use the XClarity 
Administrator authentication server. User accounts that are defined in the authentication 
server are used to log in to XClarity Administrator, Chassis Management Modules (CMMs), 
and Integrated Management Modules (IMMs).

When a chassis is managed by XClarity Administrator, the local CMM user accounts are 
disabled, and the new user account RECOVERY_ID is created for future authentication to the 
CMMs. If the authentication server fails, the RECOVERY_ID account can be used to log on to 
the CMM and take recovery actions. 

When managing a rack server from XClarity Administrator, the local IMM user accounts are 
not disabled, and a RECOVERY_ID account is not created. Consider manually clearing all 
local IMM user accounts and creating a RECOVERY_ID account to provide a recovery path 
for your rack servers.

The XClarity Administrator supports local and external authentication servers. By default, the 
XClarity Administrator is configured to use the local authentication server that is on the 
XClarity Administrator appliance. 

XClarity Administrator can be configured to use an external LDAP server that is on a 
Microsoft Windows server that is connected to the management network. When an external 
authentication server is used, the local XClarity Administrator authentication server is 
disabled. Both authentication servers cannot be used at the same time

3.2.1  Prerequisites

The following prerequisites must be met before external authentication is configured:

� The initial setup of XClarity Administrator must be completed before setting up the external 
authentication server.

� The external authentication server must use Microsoft Active Directory (AD) services that 
are running on a Microsoft Windows server. At the time of this writing, only Microsoft AD is 
supported as an external authentication server.

� Ensure that the external authentication server is connected to the management network.

� You must set up groups in the external authentication server to match the groups that are 
defined in the local XClarity Administrator authentication server.

3.2.2  Setting up external authentication in a non-secure AD

The Windows AD domain controllers use non-secure LDAP authentication by default. 
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Complete the following steps to set up an external authentication server in an environment 
with a non-secure AD server:

1. Create an Organizational Unit (OU) to contain the groups. From the main menu of the AD 
Server, click Users and Groups. Right-click the Root DN and choose New → 
Organizational Unit, as shown in Figure 3-3.

Figure 3-3   Active Directory users and groups 

2. The new OU is shown in Figure 3-4. Click OK.

Figure 3-4   New organizational unit

3. Create a group within the OU. In our example, the OU name is XClarity_LDAP; however, 
any descriptive name can be used. The name of each group that is created within the OU 
must match the name of a role group within XClarity Administrator. For more information 
about the role groups within XClarity Administrator, see 3.1.2, “Roles and Role Groups” on 
page 39.
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4. Select the new OU. From main menu, choose Action → New → Group, as shown in 
Figure 3-5.

Figure 3-5   Create group window

5. Create the security group within the OU as shown in Figure 3-6. Click OK. 

If required, add other AD security groups that match the role groups within XClarity 
Administrator; for example, LXC-OPERATOR.

Figure 3-6   New Group Object window

6. Select the new LXC-SUPERVISIOR group. From main menu, choose Action → New → 
User.
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7. Create the user, as shown in the example in Figure 3-7. Click Next.

Figure 3-7   New Object - User window

8. Enter and confirm the password.

9. Click Finish.

10.Right-click the new user and choose Add to group, as shown in Figure 3-8.

Figure 3-8   Selecting Add to a group option
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11.Enter LXC-SUPERVISOR in the Select Groups window and click Check Names, as shown in 
Figure 3-9.

Figure 3-9   Select Groups window

12.Click OK.

13.Add other users that require access to the XClarity Administrator to the proper LXC 
groups.

14.From the Active Directory Users and Computers window, select View. Ensure Advanced 
Settings is selected, as shown in Figure 3-10.

Figure 3-10   Active Directory Users and Computers window
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15.Open the OU that contains the user that was created step 7 on page 44. Right-click the 
user and choose Properties, as shown in Figure 3-11.

Figure 3-11   Selecting Properties window

16.Click the Attribute Editor tab and scroll down to distinguishedName, as shown in 
Figure 3-12.

Figure 3-12   User properties
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17.Double-click the value.

18.Select the value in the String Attribute Editor window (as shown in Figure 3-13) and press 
Ctrl+C to copy the string value.

Figure 3-13   Attribute Editor window

19.Save the distinguishedName because it is needed when XClarity Administrator is 
integrated with AD.

20.Close the Active Directory users and the computer’s utility.

3.2.3  Connecting XClarity Administrator to the LDAP server

Complete the following steps to connect XClarity Administrator to the LDAP server:

1. Open a web browser and connect to XClarity Administrator by entering the following URL:

https://<IPv4_address>/ui/login.html

Where IPv4_address is the IP address of the XClarity Administrator appliance.

2. Log in as a user with the LXC-SUPERVISOR role.

3. From the Dashboard window, select Administration → Security, as shown in 
Figure 3-14.

Figure 3-14   XClarity Administrator dashboard
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4. The LDAP Client Settings window is shown in Figure 3-15. Click Security → Users and 
Groups → LDAP Client. 

Figure 3-15   LDAP Client Settings window

5. Complete the following steps in the LDAP Client Settings window:

a. Click Allow logons from LDAP users.

b. Because this example does not use secure LDAP, select Disable Secure LDAP.

c. Choose the Server selection method. Because most environments use static IP 
Addresses for the Domain Controllers, choose the Use Pre-configured servers 
option. The following options are available:

• The Use Pre-configured servers option allows the administrator to specify the IP 
address or host name of your external authentication servers. 

• The Use DNS to find LDAP servers option allows the administrator to specify a 
domain name and optional forest name to dynamically locate domain controller 
(DC) and global catalog (GC) servers. 
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d. Enter the IP Address or host name of the authentication server.

e. Enter the port that is used by the authentication server; the default port is 389.

f. Under Bind parameters, enter the user name that XClarity Administrator uses to 
connect to the authentication server. This name is the distinguished name of the user 
that was used in step 18 on page 47.

g. Enter the Client password.

h. Under Additional Parameters, enter the Root DN, as shown in the example in 
Figure 3-3 on page 42.

i. Click Apply.

XClarity Administrator validates the LDAP server connection. If the validation passes, the 
message in Figure 3-16 is shown.

Figure 3-16   LDAP successful configuration window

6. Click Close.

Note: Local user authentication is now disabled. User authentication occurs on the 
external authentication server when logging on to XClarity Administrator, CMM, and 
IMM. All user management is now controlled from the Microsoft Active Directory.
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3.3  User account security settings

The user-account security settings control the password complexity, account lockout, and 
web session inactivity timeout. 

Complete the following steps to access the user account security settings:

1. From the XClarity Administrator menu bar, click Administration → Security.

2. Click Account Security Settings under the Users and Groups section. The Users 
Management page opens. The default values are shown in Figure 3-17.

Figure 3-17   Account Security Settings window

The following security settings definitions and characteristics are available:

� Password expiration period

This setting is the number of days that a user can use a password before it must be 
changed. The number of days can be 0 - 365. If this setting is 0, passwords never expire.

This setting applies only when the user accounts are managed locally on the management 
server by using the internal authentication server. Passwords are not used when an 
external authentication server is used.

� Password expiration warning period

This setting is the number of days before the password expiration date that users receive 
warnings about the impending expiration of the user password. If this setting is 0, users 
are never warned.
50 Lenovo XClarity Administrator Planning and Implementation Guide



This setting applies only when the user accounts are managed locally on the management 
server by using the internal authentication server. This setting is not used when an 
external authentication server is used.

� Minimum password reuse cycle

The setting is the minimum number of times that a user must enter a unique password 
when the password is changed before the user can start to reuse passwords.

This setting can be 0 - 10. If this setting is 0, users can reuse passwords immediately.

� Minimum password change interval

This setting is the minimum number of hours that must elapse before a user can change a 
password again after it was changed. The value that is specified for this setting cannot 
exceed the value that is specified for the password expiration period.

This setting can be 0 - 1440. If this setting is 0, users can change passwords immediately.

� Maximum number of login failures

This setting is the maximum number of times that a user can attempt to log on with an 
incorrect password before the user account is locked out. 

This setting can be 0 - 100. If this setting is 0, accounts are never locked. 

� Lockout period after maximum login failures

This setting is the minimum number of minutes that must pass before a user that was 
locked out can attempt to log back in again.

This setting can be 0 - 1440. If this setting is 0, the account remains locked until an 
administrator explicitly unlocks it. Any user with the role of Supervisor can unlock a user 
account. 

This setting applies only when the user accounts are managed locally on the management 
server by using the internal authentication server. This setting is not used when an 
external authentication server is used.

� Web inactivity session timeout

This setting is the number of minutes that a user session that is established with XClarity 
Administrator can be inactive before the user is logged off.

This setting can be 0 - 1440. If this setting is 0, the web session never expires.

� Minimum password length

This setting is the minimum number of characters (8 - 20) that can be used to specify a 
valid password.

� Force user to change password on first access

This setting is used to determine whether a user is required to change the password when 
the user logs in to XClarity Administrator for the first time.

This setting can be Yes or No.
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3.4  Cryptography and security certificates

Cryptographic management is composed of communication modes and protocols that control 
the way that secure communications are handled between XClarity Administrator and 
managed systems. The cryptographic mode sets the encryption-key lengths that are used if 
secure communications are implemented.

XClarity Administrator supports the following cryptographic modes for secure 
communications:

� Compatibility

This mode is the default mode. It is compatible with older firmware versions, browsers, and 
other network clients that do not implement the stricter security standards that are 
required for compliance to NIST 800-131A.

� NIST SP 800-131A

This mode complies with the NIST SP 800-131A standard. XClarity Administrator always 
uses strong cryptography internally and, where available, uses strong cryptography 
network connections. However, network connections that use cryptography that is not 
approved by NIST SP 800-131A cannot be used in this mode. If you select this mode, you 
must select (Transport Layer Security) TLS 1.2 Server and Client for the SSL/TLS mode.

XClarity Administrator supports the following SSL/TLS protocols for secure communications:

� Legacy

This option is the default option and it enables older cryptographic protocols. When this 
option is selected, TLS 1.0, TLS 1.1, and TLS 1.2 are supported. If you select this option, 
you must select the Compatibility cryptographic mode.

� TLS 1.2 Server and Client

This option enforces TLS 1.2 cryptography protocols on XClarity Administrator and all 
managed endpoints. It is set automatically if you choose NIST SP 800-131A for the 
cryptographic mode.

When the cryptographic mode in XClarity Administrator is changed, the modes for all 
managed endpoints are switched to the same setting automatically. Care must be taken 
before the cryptographic mode is changed because changes that are to managed endpoints 
might be required. Also, it might be necessary to unmanage the endpoints before the 
cryptographic mode is changed. 

For more information, see Configuring cryptography settings in the XClarity Administrator 
online documentation that is available at this website:

http://pic.dhe.ibm.com/infocenter/flexsys/information/index.jsp?topic=%2Fcom.lenov
o.lxca.doc%2Fcryptography_setmode.html

Tip: Regardless of the cryptography mode that is selected, NIST approved Digital Random 
Bit Generators are always used. Also, only 128-bit or longer keys are used for symmetric 
encryption.
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3.4.1  Security certificates

XClarity Administrator and System x management modules (CMM and IMM2), use SSL 
certificates to establish secure connections between managed resources. By default, XClarity 
Administrator and management modules use XClarity Administrator-generated certificates 
that are self-signed and issued by an internal certificate authority (CA).

The default server certificate provides sufficient security for most environments. If customized 
security certificates are required, XClarity Administrator can generate the following 
components:

� A new server key and certificate that uses values that are specific to your organization

� A certificate signing request (CSR) that can be sent to a CA to create a signed certificate 
that can be uploaded to the XClarity Administrator truststore

For more information about certificate options, see Working with security certificates in the 
XClarity Administrator online documentation that is available at this website:

http://pic.dhe.ibm.com/infocenter/flexsys/information/index.jsp?topic=%2Fcom.lenov
o.lxca.doc%2Fcertificates_workwith.html

Importing a security certificate into a web browser
To avoid security warning messages (as shown in the example in Figure 3-18) from your web 
browser when you access the Lenovo XClarity Manager Administrator, download a copy of 
the current server certificate to your local system and import the server certificate into your 
web browser’s list of trusted certificates.

Figure 3-18   Web browser security warning

Complete the following steps to download the server certificate:

1. From the XClarity Administrator menu bar, click Administration → Security to open the 
Security page.

2. Click Certificate Authority under the Certificate Management section. 

3. Click Download Certificate Authority Root Certificate.

4. Click Save to File to save the server certificate to your local system.
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5. Import the downloaded certificate into the list of trusted certificates for your browser.

– In Firefox, complete the following steps:

i. Open the browser and click Tools → Options → Advanced.

ii. Click the Certificates tab.

iii. Click View certificates.

iv. Click the Authorities tab.

v. Click Import and browse to where the certificate was downloaded.

vi. Select the certificate, click Open, and select the Trust this CA to identify 
websites option. 

vii. Click OK twice.

– In Internet Explorer, complete the following steps:

i. Open the browser and click Tools → Internet Options → Content.

ii. Click Certificates to see a list of all trusted certificates. 

iii. Click Trusted Root Certificate Authorities.

iv. Click Import to open the Certificate Import wizard and click Next.

v. Browse to the file.

vi. Choose All files, select the file, click Open, and click Next.

vii. Ensure that the certificate is placed in Trusted Root Certificate Authorities and click 
Next.

viii.Click Finish.

ix. When you are prompted to install the certificate, choose Yes. 

x. When The import was successful window opens, click OK.

xi. Click Close.

– In Chrome, complete the following steps:

i. Click Options → Settings.

ii. Click Show Advanced Settings.

iii. Under HTTPS/SSL, click Manage Certificates.

iv. Choose Trusted Root Certificate Authorities.

v. Click Import and then, click Next.

vi. Browse to the file.

vii. Choose All files, select the file, and click Open.

viii.Click Next.

ix. Ensure that the certificate is placed in Trusted Root Certificate Authorities and click 
Next.

x. Click Finish.

xi. When you are prompted to install the certificate, choose Yes. 

xii. When The import was successful window opens, click OK.
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3.5  Implementing a secure environment

It is important to evaluate the security requirements in an environment to understand all 
security risks. XClarity Administrator includes several features that can help secure an 
environment. Consider the following points when you are evaluating the security 
requirements for an environment: 

� The physical security of the environment is important; limit access to rooms and racks 
where systems-management hardware is kept.

� Use a software-based firewall to protect your network hardware and data from known and 
emerging security threats, such as viruses and unauthorized access.

� Do not change the default security settings for the network switches and pass-through 
modules. The manufacturing default settings for these components disable the use of 
protocols that are not secure and enable the requirement for signed firmware updates.

� The management applications for the CMMs, IMMs, and switches permit only signed 
code-update packages for these components to ensure that only trusted code is installed.

� Only the users who are authorized to update firmware components should have 
firmware-update privileges.

� At a minimum, ensure that critical firmware updates are installed. Back up the 
configuration before and after any changes are made.

� Ensure that all security-related updates for DNS servers are installed promptly and kept 
up-to-date.

� Where possible and practical, place the systems management hardware in a separate 
subnet. Typically, only administrators should have access to the systems-management 
hardware and no basic users should be granted access.

� When passwords are chosen, do not use expressions that are easy to guess. Keep the 
passwords in a secure place and ensure that access to the passwords is restricted. 
Implement a password policy for the company.

� Always change the default user name and password for all devices. Strong password 
rules should be required for all users.

� Establish power-on passwords for users as a way to control who has access to the data 
and setup program on the servers. For more information about power-on passwords, see 
the documentation that is included with your Flex System products and System x servers.

� Use the various authorization levels that are available for different users in the 
environment. Do not allow all users to work with the same supervisor user ID.

� Consider the use of NIST SP 800-131A cryptographic mode. For more information, see 
Configuring cryptography settings in the XClarity Administrator online documentation that 
is available at this website:

http://pic.dhe.ibm.com/infocenter/flexsys/information/index.jsp?topic=%2Fcom.le
novo.lxca.doc%2Fcryptography_setmode.html 

Not a comprehensive list: The suggestions that are in this section are provided to help 
users implement a secure environment. This document should not be considered a 
comprehensive security guide.
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Chapter 4. Installing and initial setup

In this chapter, we describe the installation and initial configuration of the Lenovo XClarity 
Administrator virtual appliance. We show a step-by-step installation of the product in a sample 
environment and describe the options that depend on environmental variations. We also 
describe several methods that can be used to access the XClarity Administrator virtual 
machine for the first time.

Because the installation can vary based on a hypervisor selection and network configuration, 
we recommend reading the Lenovo XClarity Manager Administrator Planning and Installation 
Guide, which is available at this website: 

http://www-01.ibm.com/support/knowledgecenter/api/redirect/flexsys/information/top
ic/com.lenovo.lxca.doc/lxca_installation_guide.pdf

The focus of this chapter is on installing the XClarity Administrator virtual appliance. For more 
information about upgrading the appliance, see 13.2, “Updating the XClarity Administrator 
virtual appliance” on page 353.

This chapter includes the following topics:

� 4.1, “Installing XClarity Administrator for VMware” on page 58
� 4.2, “Installing XClarity Administrator on Microsoft Hyper-V” on page 72
� 4.3, “XClarity Administrator initial configuration” on page 79
� 4.4, “Initial access to XClarity Administrator” on page 87
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4.1  Installing XClarity Administrator for VMware

Lenovo XClarity Administrator is delivered as a virtual appliance. By default, XClarity 
Administrator has two separate network interfaces (Eth0 and Eth1) that can be defined in your 
environment. In an environment with a single network interface, the Eth1 must be removed 
from the virtual machine. The example that is described in this section shows an XClarity 
Administrator installation with a single network connection in a VMware environment. 

4.1.1  Deploying XClarity Administrator via VMware console

The deployment of the XClarity Administrator appliance by using the VMware console is 
described in this section. The setting changes that are required in the sample environment 
also are described.

Complete the following steps to deploy XClarity Administrator via the VMware console:

1. Open the VMware vSphere client.

2. Click File → Deploy OVF Template, as shown in Figure 4-1.

Figure 4-1   Deploying OVF template

Tip: To reduce deployment time, copy the XClarity Administrator appliance image to a URL 
or a file share with high-speed connection to the ESX host on which it is deployed. In 
addition, run the VMware vSphere Client from a machine on the same network.
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3. Click Browse and select the OVF file from a URL or file share and then, click Next, as 
shown in Figure 4-2.

Figure 4-2   OVF template file location file

4. Figure 4-3 shows the description of the OVF template. Click Next.

Figure 4-3   OVF template details 
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5. If wanted, edit the template name, as shown in Figure 4-4. Click Next.

Figure 4-4   Template name and location

6. Choose the Disk format (Thick Provisioned is preferred if space permits). The choices are 
listed in Figure 4-5. Click Next.

Figure 4-5   Disk format 
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7. Ensure the values, the Ready to Complete Screen are correct, as shown in Figure 4-6.

Figure 4-6   Ready to complete 

8. Ensure that the Power on after deployment option is not selected. Click Finish.

Figure 4-7 shows the virtual machine deployment window.

Figure 4-7   Deploying virtual machine

9. After the deployment competes successfully (see Figure 4-8), click Close.

Figure 4-8   Deployment completed successfully 
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4.1.2  Editing the virtual machine by using the VMware console

Our sample environment features one network adapter. For the XClarity Administrator 
appliance to properly access the network, we must delete the second adapter from the virtual 
machine in our test environment.

Complete the following steps:

1. Right-click the virtual machine and select Edit Settings, as shown in Figure 4-9.

Figure 4-9   Edit the virtual machine 

2. Highlight the network adapter and click Remove.

3. Figure 4-10 shows the window after the adapter is marked for removal. Click OK.

Figure 4-10   Virtual machine properties
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4. Right-click the VM (as shown in Figure 4-11) and choose Power → Power On.

Figure 4-11   Power on the XClarity Administrator virtual machine 

5. Right-click the VM and choose Open Console, as shown in Figure 4-12.

Figure 4-12   Open console 
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If a DHCP server is set up in the same broadcast domain as the XClarity Administrator 
appliance, the console window shows the DHCP-assigned address of XClarity 
Administrator, as shown in the IPv4 address that is highlighted in Figure 4-13. If a DHCP 
server is not set up in the same broadcast domain, see 4.4, “Initial access to XClarity 
Administrator” on page 87.

Figure 4-13   XClarity Administrator console

6. Proceed to 4.3, “XClarity Administrator initial configuration” on page 79.

4.1.3  Deploying XClarity Administrator via VMware web console

In this section, we describe the deployment of the Lenovo XClarity Appliance by using the 
VMware web console and the setting changes that are required in our sample environment.

1. In the web console, select the Virtual Center Machine.

Note: Users cannot log in to the system from the console. Access to XClarity 
Administrator is available through a web browser only.

Tip: To reduce deployment time, copy the XClarity Administrator appliance image to a URL 
or a file share with high-speed connection to the ESX host on which it is deployed. In 
addition, run the VMware vSphere Client from a machine on the same network.
64 Lenovo XClarity Administrator Planning and Implementation Guide



2. Choose Actions → Deploy OVF Template, as shown in Figure 4-14.

Figure 4-14   Deploying OVF Template

3. In this example, the OVF is on a file share; therefore, select Local file and click Browse, 
as shown in Figure 4-15.

Figure 4-15   Selecting OVF file

4. Browse to the proper directory and select the OVF file. Click Open.

5. Click Next.
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6. If required, edit the Name of the virtual machine and then choose the installation Folder, 
as shown in Figure 4-16. Click Next.

Figure 4-16   Selecting name and folder

7. Select the Resource in which the virtual machine is installed, as shown in see Figure 4-17. 
Click Next.

Figure 4-17   Selecting a resource

8. Choose the Disk format (Thick Provisioned is preferred if space permits). The choices are 
shown in Figure 4-18 on page 67.
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Figure 4-18   Select Storage

9. Select the Datastore in which you want to store the virtual machine files. Click Next.

10.Choose the Network. Figure 4-19 shows the sample name that we used in out test 
environment.

11.Click Next.

Figure 4-19   Network Setup

12.Ensure that the values that are shown in the completion window are correct, as shown in 
the example in Figure 4-20 on page 68.
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Figure 4-20   Ready to complete window

13.Confirm that the values are correct then click Finish.
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4.1.4  Editing the virtual machine by using the VMware web console

Our sample environment features one network adapter. For the XClarity Administrator 
appliance to properly access the network, we must delete the second adapter from the virtual 
machine, as described in this section.

Complete the following steps to edit the virtual machine by using the VMware web console:

1. From the Home window, select vCenter, as shown in Figure 4-21.

Figure 4-21   Web console initial window
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2. Select Virtual Machines, as shown in Figure 4-22.

Figure 4-22   vCenter Screen

3. Highlight the Lenovo XClarity Administrator virtual machine.

4. Click Actions → Edit Settings, as shown in Figure 4-23.

Figure 4-23   Edit virtual machine

5. Click the Remove icon of Network Adapter 2, as shown in Figure 4-24 on page 71. Click 
OK.
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Figure 4-24   Edit setting window

6. Ensure that the Lenovo XClarity Administrator virtual machine is selected in the right 
column of the window, as shown in Figure 4-25.

Figure 4-25   Start the XClarity Administrator virtual machine

7. From the Actions menu, choose Power on.

8. Ensure that the Lenovo XClarity Administrator virtual machine is selected in the right 
column of the window, as shown in Figure 4-26.

Figure 4-26   Open console window

9. From the Actions menu, choose Open Console.

If a DHCP server is set up in the same broadcast domain as the XClarity Administrator, 
the console window shows the DHCP assigned address of the XClarity Administrator, as 
shown in the IPv4 address that is highlighted in Figure 4-27 on page 72. If a DHCP server 
is not set up in the same broadcast domain, see 4.4, “Initial access to XClarity 
Administrator” on page 87.
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Figure 4-27   XClarity Administrator console

10.Proceed to 4.3, “XClarity Administrator initial configuration” on page 79.

4.2  Installing XClarity Administrator on Microsoft Hyper-V

XClarity Administrator is delivered as a virtual appliance. The installation process that is 
described in this section shows an XClarity Administrator installation with a single network 
connection in a Microsoft Hyper-V environment. 

4.2.1  Deploying XClarity Administrator

In this section, we describe the deployment of the XClarity Administrator appliance by using 
the Hyper-V Manager and the setting changes that are required in the sample environment.

Complete the following steps to deploy XClarity Administrator:

1. Log on to the server.

2. Copy the virtual disk image to the Hyper-V server.

3. From the Server Manager Dashboard, click Hyper-V.

Note: Users cannot log in to the system from the console. Access to XClarity Administrator 
is available through a web browser only.

Note: Ensure that the client workstation is on the same network as the host and the virtual 
disk image is on the Hyper V host as noted in Step 2 in the process that is described next.
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4. Right-click the server, and click Hyper-V Manager, as shown in Figure 4-28.

Figure 4-28   Server Manager window

5. Under Actions, click New → Virtual Machine to start the New Virtual Machine Wizard, as 
shown in Figure 4-29.

Figure 4-29   Create virtual machine page
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6. The New Virtual Machine wizard opens, as shown in Figure 4-30. Click Next. 

Figure 4-30   Before you begin window

7. In the Specify Name and Location page, enter a name for the new virtual machine, as 
shown in Figure 4-31. Click Next.

Figure 4-31   Virtual machine name and location window
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8. For the Choose generation for the virtual machine option, choose Generation 1, as shown 
in Figure 4-32.

Figure 4-32   Specify generation window

9. In the Assign Memory page, enter a value of at least 6144, as shown in Figure 4-33.

Figure 4-33   Virtual machine memory window
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10.In the Configure Networking page, choose the virtual switch. Figure 4-34 shows the 
network name that is used in our example.

Figure 4-34   Network configuration window

11. In the Connect Virtual Hard Disk window, click Use an existing virtual hard disk. Click 
Browse and then select the location of the XClarity Administrator virtual disk image and 
choose the image, as shown in Figure 4-35. Click Next.

Figure 4-35   Connect Virtual Hard Disk

Tip: If you receive an error, ensure that the virtual disk image is on the local disk of the 
Hyper-V server.
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12.Check the values in the final configuration window to ensure that they are correct, as 
shown in Figure 4-36. Click Finish.

Figure 4-36   Final configuration window

13.Right-click the new virtual machine, as shown in Figure 4-37, and select Connect.

Figure 4-37   Starting virtual machine
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14.Click the icon to start the virtual machine, as shown in Figure 4-38.

Figure 4-38   Virtual machine console window

If a DHCP server is set up in the same broadcast domain as XClarity Administrator, the 
console window shows the DHCP-assigned address of XClarity Administrator, as shown in 
the IPv4 address that is highlighted in Figure 4-39. If a DHCP server is not set up in the 
same broadcast domain, see 4.4, “Initial access to XClarity Administrator” on page 87.

Figure 4-39   XClarity Administrator start window

15.Proceed to 4.3, “XClarity Administrator initial configuration” on page 79.

Note: Users cannot log in to the system from the console. Access to XClarity 
Administrator is available through a web browser only.
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4.3  XClarity Administrator initial configuration

Complete the following steps to initially configure XClarity Administrator:

1. Open a web browser. 

2. Access the web interface is through a secure (https) connection. Enter the following URL 
to access XClarity Administrator:

https://<IPv4_address>/ui/login.html

3. The initial setup window opens, as shown in Figure 4.

Figure 4-40   Initial setup window

4. Click Read and Accept the Lenovo XClarity Administrator Licence Agreement.

Note: The IPv4 address of XClarity Administrator can be found in the console window, 
as shown in Figure 4-13 on page 64. If the console does not show an IPv4 address, 
see 4.4, “Initial access to XClarity Administrator” on page 87.
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5. Review the licence agreement and click Accept.

6. From the Initial Setup window, choose Create User Account, as shown in Figure 4-41.

Figure 4-41   Initial Setup: Create user account

7. As shown in Figure 4-42, enter the credentials that you want to use for a new supervisor 
user account.

Figure 4-42   Create user window that shows security requirements
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8. Enter the password again in the Confirm New Password field.

9. The security check criteria shows green when the password meets the minimum security 
standards. Figure 4-42 on page 80 shows the window if the password does not meet the 
security standards.

10.Click Create.

11.Create a second supervisory ID by clicking the Create New User icon, as highlighted in 
red in Figure 4-43.

Figure 4-43   Create second supervisory user ID

12.Enter the Username and Password that you want to use. Click Create, as shown in 
Figure 4-44.

Figure 4-44   Create second supervisory password window
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13.The user management window should show two new users, as shown in Figure 4-45. 
Click Return to Initial Setup.

Figure 4-45   Final create user window

14.Click Configure Network Access, as shown in Figure 4-46.

Figure 4-46   Initial setup: Configure network access
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15.In a single network environment, select the drop-down menu next to Eth0 Enabled - Used 
to and select discover and manage hardware and manage and deploy operating 
system images, as shown in Figure 4-47.

Figure 4-47   Lenovo XClarityAdminstrator network access

16.If wanted, change the IPv4 and the IPv6 address to static addresses.

17.After all of the changes are complete, click Save.

18.If the IP address was changed, the XClarity Administrator virtual appliance restarts. The 
system displays the warning window that is shown in Figure 4-48.

Figure 4-48   IP address change warning window
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19.The system displays a message that the system will restart and the new IP address of 
XClarity Administrator is shown as a hot link, as shown in Figure 4-49.

Figure 4-49   XClarity Administrator restart warning message

20.After the system restarts, the XClarity Administrator login window opens, as shown in 
Figure 21.

Figure 4-50   XClarity Administrator login window

21.Log in with the user ID that was created in Step 7 on page 80.

22.The initial configuration window opens. Click Configure Date and Time Preferences, as 
shown in Figure 4-51.

Figure 4-51   Initial setup: Configure date and time preferences

XClarity Administrator requires a Network Time Protocol (NTP) Server. The NTP Server is 
used to synchronize time stamps between XClarity Administrator and all managed 
systems. A default NTP Server is provided and can be used if XClarity Administrator is 
connected to the Internet.
84 Lenovo XClarity Administrator Planning and Implementation Guide



23.Select the proper time zone, as shown in Figure 24.

Figure 4-52   Edit date and time window

24.If wanted, change the NTP Server. After the configuration is complete, click Save.

25.As shown in Figure 4-53, click Configure Additional Security Settings.

Figure 4-53   Initial setup: Security settings window
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The User Management window is used to configure all security settings for XClarity 
Administrator. For more about the window that is shown in Figure 4-54, see Chapter 3, 
“Security” on page 37.

Figure 4-54   User management 

26.Click Return to Initial Setup.

27.Click Start Managing Systems, as shown in Figure 4-55.

Figure 4-55   Initial setup: Start managing systems
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28.The following options in the window that is shown in Figure 4-56 are available to include 
Demo Data:

– If the Yes, Include Demo Data option is selected, XClarity Administrator includes a 
demonstration Flex System chassis that can be used for training purposes.

– If the No, Don’t Include Demo Data option is selected, a demonstration Flex chassis 
is not included in XClarity Administrator. In production systems, the demo data is not 
needed.

Figure 4-56   Start managing systems

Figure 4-57 shows the Discover and Manage New Device window. For more information 
about the discovery process, see 6.2, “Discovery process” on page 124.

Figure 4-57   Discover and manage new devices

4.4  Initial access to XClarity Administrator

In this section, we describe three methods that are used for accessing the XClarity 
Administrator virtual appliance for the first time.
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4.4.1  Assigning a IPv4 address via DHCP

The most common method for assigning a IPv4 address to XClarity Administrator is via a 
DHCP Server. If a DHCP server is set up in the same broadcast domain as XClarity 
Administrator, the system receives an IP address from the DHCP server. A web browser can 
be used to access XClarity Administrator via the assigned IPv4 address, which is shown in 
the XClarity Administrator virtual-machine console.

Use the following URL:

https://<IPv4_address>/ui/login.html

For example:

https://172.16.32.217/ui/login.html

The DHCP-assigned IPv4 address is shown in Figure 4-58.

Figure 4-58   XClarity Administrator console window IPv4 address

4.4.2  Accessing XClarity Administrator by using IPv6

If a DHCP server is not set up in the same broadcast domain as the XClarity Administrator 
appliance, the IPv6 Link-Local address (LLA) can be used to access XClarity Administrator. 
The LLA is displayed for eth0 (the management network) in the XClarity Administrator virtual 
machine console. 
88 Lenovo XClarity Administrator Planning and Implementation Guide



The LLA is highlighted in red in Figure 4-59.

Figure 4-59   XClarity Administrator console window IPv6 address

The IPv6 address requires editing before a browser is used to access XClarity Administrator. 
You must add 0:0:0 after the first group in the IPv6 address. For example, the machine that is 
shown in Figure 4-59 shows an LLA of fc88: :20c:29ff:feef:1b54. The following address is 
used to access XClarity Administrator in our example:

fe80:0:0:0:20c:29ff:feef:1b54

Access via IPv6 by using Firefox
Brackets are required when IPv6 addresses are entered in a web browser. To access the 
XClarity Administrator web interface from a Firefox browser, log in by using the following URL: 

https://[<IPv6_LLA>]/ui/login.html

Based on the example for eth0, we enter the following URL in the web browser:

https://[fe80:0:0:0:20c:29ff:feef:1b54]/ui/login.html

Access via IPv6 by using Internet Explorer
To access the XClarity Administrator web interface from an Internet Explorer browser, log in 
by using the following URL:

https://[<IPv6_LLA>%25<zone_index>]/ui/login.html

Where <zone_index> is the identifier for the Ethernet adapter that is connected to the 
management network from the computer on which you started the web browser. Brackets are 
required when entering IPv6 addresses.

Run the Windows ipconfig command to find the zone index, which is displayed after the 
percent sign (%) in the Link-Local IPv6 address field for the adapter; for example, open a 
command prompt and enter the following command:

ipconfig

Local connectivity needed: When the LLA is used to configure XClarity Administrator, 
there must be connectivity to the layer 2 network. XClarity Administrator must be accessed 
from a non-routed address until the initial setup is complete. Consider accessing XClarity 
Administrator from another VM that has local connectivity to XClarity Administrator.
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Figure 4-60 shows an example result of the command.

Figure 4-60   Workstation IP configuration that shows the zone index

In this example, the zone index is 20 (as highlighted in Figure 4-60). To access our LLA, we 
enter the following address:

https://[fe80:0:0:0:20c:29ff:feef:1b54%2520]/ui/login.html

You might receive security or certificate warnings the first time that you access XClarity 
Administrator. You can ignore the warnings.

4.4.3  Manually setting the IPv4 address for XClarity Administrator

If XClarity Administrator is not set up in the same broadcast domain as a DHCP Server, a 
configuration file can be used to specify the IP4 address. Complete the following steps:

1. Create a file that is named eth0_config (with no file extension) that contains the following 
IPv4 parameters:

– IPV4_ADDR
– IPV4_NETMASK
– IPV4_GATEWAY

For example:

– IPV4_ADDR=192.168.101.101
– IPV4_NETMASK=255.255.255.0
– IPV4_GATEWAY=192.168.101.1

2. Create an ISO image that contains the eth0_config file. 

Use ISO creation software to create an ISO image that has the following parameters:

– The label name is IP4ADDR.
– The ISO name is boot.iso.

On Linux, use the mkisofs command, for example:

mkisofs -V IP4ADDR -J -o ./boot.iso ./eth0_config 

Where -V is the volume label, -J is for Joliet format, -o is the output file name, and 
./eth0_config is the file to be included in the ISO image.

3. Follow the appropriate steps for hypervisor:

a. For VMware ESXi:

i. Copy the ISO file to the datastore. 

ii. Mount the .ISO image to the virtual machine and ensure that the connect at power 
on option is selected.

iii. Power on the virtual machine.

Ethernet adapter Local Area Connection 4:

   Connection-specific DNS Suffix  . : lenovo.com
   Link-local IPv6 Address . . . . . : fe80::a143:6b68:7937:d9f9%20
   IPv4 Address. . . . . . . . . . . : 172.16.32.66
   Subnet Mask . . . . . . . . . . . : 255.255.255.0
   Default Gateway . . . . . . . . . : 172.16.32.1
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b. For Microsoft Hyper V:

i. Copy the .ISO file to the Hyper V host.

ii. Connect the ISO to the virtual machine.

iii. Power on the virtual machine.
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Chapter 5. User interface

A clear and easy-to-understand user interface is one of the most important factors for user 
experience. To ensure that it is easy to use for all users, the Lenovo XClarity Administrator 
user interface is based on a normal web application and can be accessed as in accessing a 
normal web page. This ease of use includes the use of the browser Back and Forward 
buttons to navigate between pages. 

Every XClarity Administrator web page uses its own URL with which the user can bookmark 
each page individually. In addition, many objects in the application are hyperlinks and support 
accessing more details from that point.

This chapter includes the following topics:

� 5.1, “Logging in to the user interface” on page 94
� 5.2, “Navigating the user interface” on page 95
� 5.3, “Dashboard” on page 97
� 5.4, “Menu bar” on page 99
� 5.5, “Microsoft PowerShell scripting functions” on page 115

5
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5.1  Logging in to the user interface

To log in to the XClarity Administrator user interface, use one of the supported browser 
versions. For more information about supported web browsers, see Lenovo XClarity 
Administrator User’s Guide. Browse to the IP address of your XClarity Administrator 
appliance.

For more information about how to configure the IP address of your XClarity Administrator 
appliance, see 4.3, “XClarity Administrator initial configuration” on page 79.

For example, if you are using IPv4 address, you use the following URL: 

https://172.16.32.73/ui/login.html

You see the login window for XClarity Administrator that is shown in Figure 5-1.

Figure 5-1   XClarity Administrator log in window

Log in by using a valid user account. If the password for the account that you are using 
expired (for example, when a user is created), you are prompted to provide a new password. 
The password rules that must be followed are displayed.

Note: Ensure that you use https.
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5.2  Navigating the user interface

The user interface provides a quick overview about the discovered systems, the status of the 
systems that are monitored, and the status of the jobs that are run. 

If there is more information available for specific functions in the console, a question mark  
icon is shown that can be selected to show the information. In some cases, this icon also 
leads the user to the appropriate section in the XClarity Administrator online help.

The main functions that are provided by XClarity Administrator are available from every 
window. A title bar and a menu bar are shown in the top of every view, as shown in Figure 5-2 
and Figure 5-3 on page 96.

Figure 5-2   Navigating the user interface: Title bar

The Status drop-down menu provides a quick overview about active hardware alerts and 
management alerts. For more information, you select one of the alerts or click All Hardware 
Alerts to go to the Alerts window. For more information about how to work with alerts, see 
7.1, “Alerts and events” on page 168.

The Jobs drop-down menu lists the most current jobs that are running, which are completed 
or completed with errors. At the lower end of the list, you can click View All Jobs to go to the 
list of all Jobs. For more information about how to work with jobs, see 7.6, “Monitoring jobs” 
on page 190.

Title bar
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Click your user ID on the right side of the window to change your password or to log off. The 
question mark icon  on the right side of the window provides access to the online help and 
more information about the installed version and licensing information.

Figure 5-3   Navigating the user interface: Menu bar

From the Menu bar, you can access all XClarity Administrator functions. The first item in the 
menu bar leads to the Dashboard, which is the central console for XClarity Administrator to 
see status information about the managed endpoints and the provisioning jobs. For more 
information about the Dashboard, see 5.3, “Dashboard” on page 97.

The Menu bar lists the following drop-down menus next to the Dashboard button:

� Hardware
� Provisioning
� Monitoring
� Administration

The items that are grouped in these menus take you to the individual functions and their 
windows.

Menu bar
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5.3  Dashboard

The Dashboard is the first window that you see when you log in to XClarity Administrator for 
the first time after the initial configuration is finished. It provides a quick overview about the 
activity in the managed environment from one central site. If you must return to the 
Dashboard, click Dashboard, as shown in Figure 5-4.

Figure 5-4   XClarity Administrator Dashboard

The Dashboard consists of three different function areas, as described in the following 
subsections:

� 5.3.1, “Hardware Status area” on page 98
� 5.3.2, “Provisioning Status area” on page 98
� 5.3.3, “XClarity Administrator Activity area” on page 99
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5.3.1  Hardware Status area

The Hardware Status area shows the status of all managed endpoints, which are grouped by 
Servers, Flex Storage, Flex Switches, Flex Chassis, and Racks as shown in Figure 5-5.

Figure 5-5   Hardware Status area in the Dashboard

Click the number that is listed under the endpoint type to see more information about all the 
endpoints of that type. For example, click the number under All Servers to see a list of all 
servers.

Below the number of managed endpoints, you see a quick overview about the status of the 
managed endpoint. Listed in this area is the number of endpoints and their status (for 
example normal, warning or critical). 

5.3.2  Provisioning Status area

The Provisioning Status area provides an overview of all tasks that are associated with 
provisioning endpoints. Figure 5-6 shows the portion of the window that provides the 
provisioning status.

Figure 5-6   Provisioning Status area in the Dashboard

The numbers for each item that are listed can be clicked. By clicking the number, you see are 
presented with a window where you can work with these items. Table 5-1 lists what each item 
displays when clicked.

Table 5-1   Information within the Provisioning Status areas

Section What is displayed

Configuration Patterns Displays information about the server profiles that are deployed to 
servers. For more information about working with configuration 
patterns, see Chapter 11, “Configuration patterns” on page 253.
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5.3.3  XClarity Administrator Activity area

To determine how many jobs are in progress and their status, browse to the XClarity 
Administrator Activity area in the Dashboard, as seen in Figure 5-7. Click the number of jobs 
to see the job log.

Figure 5-7   XClarity Administrator Activity area

Next to the job information you see how many sessions are active on the XClarity 
Administrator instance and the active user name.

5.4  Menu bar

The Menu bar provides access to several management functions that are grouped by their 
purpose. The following subsections describe each function:

� 5.4.1, “The Hardware menu” on page 100
� 5.4.2, “Provisioning menu” on page 112
� 5.4.3, “Monitoring menu” on page 114
� 5.4.4, “Administration menu” on page 115

Operating system images Displays information about the current number of operating system 
images that are in the image repository and the number of current 
operating system deployments that are in progress. For more 
information about operating system deployment, see Chapter 10, 
“Bare metal deployment” on page 229.

Firmware updates Displays information about firmware updates, including the number 
of compliant and non-compliant endpoints and the number of 
compliance policies that are set. For more information about 
Firmware updates, see Chapter 9, “Deploying firmware updates” on 
page 205.

Section What is displayed
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5.4.1  The Hardware menu

To access the Hardware menu, click Hardware. You see a drop-down menu that includes the 
available choices, as shown in Figure 5-8.

Figure 5-8   Hardware drop-down menu

Select the item to show the relevant window:

� “Managing Servers”
� “Flex Storage” on page 104
� “Flex Switches” on page 105
� “Flex Chassis” on page 106
� “Racks” on page 110

Managing Servers
Select All Servers to open the window in which all managed servers are listed. As shown in 
Figure 5-9, one rack server and five compute nodes are displayed. 

Figure 5-9   Server List

You can narrow the list of servers that are displayed by using the Show menu that is on the 
right side of the view, as shown in Figure 5-10. Alternatively, you can search for specific 
systems by using the Filter field. 

Figure 5-10   Show menu and filtering

The icons that are at the top of the server view are listed in Table 5-2 on page 101. Some 
icons are active only when one or more servers are selected.
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Table 5-2   Icon toolbar functions

Another item in the icon bar is Unmanage Rack Server, which allows you to unmanage a 
standard server if needed (that is, remove it as a managed endpoint from XClarity 
Administrator). To unmanage a Flex System chassis, you use the Unmanage Chassis 
function from the Chassis view.

You can also use the All Actions menu to perform actions on one or more selected endpoints. 
For example, Figure 5-11 shows how to issue a Virtual Reseat of a Flex System node.

Figure 5-11   All Actions menu

To access the individual information for each server, one or more servers must be selected.

The Server view (as shown in Figure 5-9 on page 100) provides the following columns:

� Selection column

Add a check against the system with which you want to work. This check makes the 
appropriate icons above the table active that are used to interact with the endpoint. 

Icon Function Explanation

 Export as CSV Exports the information about the selected 
endpoints. If no selection is made, the information 
about all systems is exported.

 Customize Columns This option allows you to select the columns that 
you want to display. You can also change the 
order in which the columns are displayed.

 Launch Remote Control Starts the remote control console for the selected 
endpoint. For more information about Remote 
Control, see Chapter 8, “Remote Control utility” 
on page 193

 Power On Power on the selected endpoint.

 Power Off Power off the selected endpoint.

 Shutdown OS and 
Restart

Shut down the operating system and restart the 
selected endpoint.

 Exclude Events Excludes all events from the selected endpoint, 
which creates an exclusion rule. Exclusion rules 
and excluded events can be viewed and deleted 
by using the Excluded Events toolbar button in 
the Alerts or Event Log.
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� Server column 

The server name is taken from the IMM configuration. You change the name of a server by 
selecting one server by and then clicking All Actions → Edit Properties. Another way to 
change the server name is from within the IMM interface. However, it might take some 
time until XClarity Administrator uses the new name.

If you click the name, the details of the individual server are displayed, as shown in 
Figure 5-12.

Figure 5-12   Server details window

This server details window offers more choices to see information that is available for this 
endpoint from the menu on the left side; for example, inventory details, alerts, the event 
log, jobs, light path information, power and thermal information, configuration details, and 
information about Feature on-Demand keys that are in use.
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There also is an Actions drop-down menu that can be used to interact with the system, as 
shown in Figure 5-13.

Figure 5-13   Actions menu in the server details window

� Status column 

This option provides information about active alerts from the managed endpoint.

� Power column

The power status indicates whether the server is On or Off.

� IP Addresses column

This column contains the IPv4 address and the IPv6 address of the endpoints IMM. For 
standard servers (not Flex System compute nodes), the USB Remote NDIS Network 
Address also is shown; for example, 169.254.95.118. 

The IPv4 address can be clicked. By clicking the IMM address, a separate web session to 
the IMM IP address is opened in the web browser.

� Rack Name/Unit column

This column uses information from the Rack configuration to display where in the rack the 
managed server is physically located. For more information about configuring racks, see 
“Racks” on page 110.

� Chassis/Bay column

For Flex nodes, this column provides the information in which Flex System chassis and 
bay the node is installed.

� Product Name column

This information is the full product name of the managed endpoint.

� Type-Model column

This information is the type and model number of the managed endpoint.
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� Firmware (UEFI) column

The Firmware column provides the details about the installed Unified Extensible Firmware 
Interface (UEFI) version. When you hover your mouse pointer over the entry of a particular 
endpoint, more information about the installed system firmware levels (UEFI, IMM2, or 
DSA) is displayed, as shown in Figure 5-14.

Figure 5-14   Installed levels of system firmware

Flex Storage
If you click Flex Storage in the Hardware menu from the menu bar, you see a list of Flex 
storage nodes that are managed by XClarity Administrator, as shown in Figure 5-15.

Figure 5-15   Flex Storage list

This table provides the main information about the Flex storage enclosure. When you click the 
link of the enclosure name, a window opens that lists more information about it; for example, 
inventory (firmware levels for the storage node and information about the network 
configuration and each canister in the storage node), alerts, and event log. By clicking the IP 
address of a storage enclosure, you are directed to the V7000 login window to work with the 
enclosure.
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If you select an enclosure to be managed, you are able to perform some base actions from 
the All Actions menu as shown in Figure 5-16.

Figure 5-16   All Actions menu for the Flex Storage enclosure

The example that is shown in Figure 5-16 shows that you can perform a virtual reseat of a 
canister to simulate a removal.

Flex Switches
When you manage a Flex System chassis, all switches in the chassis are known to XClarity 
Administrator. You can view the status of all Flex System switches that are managed by 
XClarity Administrator.

When you click Flex Switches in the Hardware menu from the menu bar, you see a list of all 
Flex switches that are managed by XClarity Administrator, as shown in Figure 5-17.

Figure 5-17   Flex Switches list

Stacked switches: Switches in a Flex System chassis can be stacked. A stacked switch is 
a group of switches that operate as a single network switch. The stack includes a master 
switch and one or more member switches.

You can view and monitor each switch in the stack. However, you can perform 
management actions (such as generating and collecting service data, updates, and 
configuration patterns) on the master switches only. Actions are disabled for switches that 
are stacked.

Protected mode: Actions are disabled for switches that are in protected mode. This 
configuration is done from the Chassis Management Module (CMM) web interface or via 
the command line on the CMM, depending on your specific requirements. For more 
information about the CMM configuration, see the following Flex System Information 
Center website:

http://www-01.ibm.com/support/knowledgecenter/api/redirect/flexsys/information/
index.jsp
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The list of switches includes the main information about the switches that are installed in the 
managed Flex Chassis. If you click the link with the Switch name, you see more information 
about the switch; for example, inventory details (firmware level, asset information, alerts, and 
event log).

By clicking the IP Address of an individual switch in the list, you start the I/O Module Interface 
for the switch.

You also can use the All Actions menu that is shown in Figure 5-18 to perform management 
tasks.

Figure 5-18   All Actions menu for Flex Switches

Flex Chassis
If you click Flex Chassis in the Hardware menu from the menu bar, you see a summary of all 
Flex chassis that are managed by XClarity Administrator, as shown in Figure 5-19.

Figure 5-19   Flex Chassis list
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This table contains the main properties for the chassis. To change the chassis properties, 
select the chassis and click All Actions → Edit Properties to open the Edit Properties 
window, as shown in Figure 5-20.

Figure 5-20   Edit chassis properties

The IP address that is listed in the table that is shown in Figure 5-19 on page 106 is the IP 
address of the installed CMM. By clicking this IP address, you are directed to the 
management module web interface.

For more information about the chassis, click the link for the chassis name, as shown in 
Figure 5-21 on page 108. 
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Figure 5-21   Chassis map

The graphic view also is called a chassis map. Hover the mouse pointer over the individual 
components that are available in the front view (for example, the chassis or compute nodes) 
or in the rear view (for example switches, fans, and power supplies) to see more information 
about hardware, status, or component. The information is listed below the chassis map. Click 
Details to see the individual component information.
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Within the chassis map, there are several overlays to determine the status of all components 
in the chassis or to visualize more items, such as the component IP addresses, as shown in 
Figure 5-22.

Figure 5-22   Chassis map overlays

As an alternative to the graphical chassis map, you can click Table view to see the view of the 
information, as shown in Figure 5-23.

Figure 5-23   Chassis information Table View
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The chassis components are listed as a table, which includes the main information about the 
components. The IP address and the component name provide links to access the 
component information. By selecting a component, there is a summary that is displayed 
below the table and you can click Details to see more information.

Racks
By selecting Racks from the Hardware drop-down menu, you see the list of Racks. After 
XClarity Administrator is installed, there is no rack configuration by default. You must create a 
configuration according to your needs. To create an empty rack click the Create icon . The 
Create Empty Rack dialog opens, as shown in Figure 5-24.

Figure 5-24   Create Empty Rack

In our example, we defined a sample rack configuration. Click the name of the rack to see and 
edit the rack configuration, as shown in Figure 5-25.

Figure 5-25   Assign hardware to a rack
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In addition to adding a chassis or servers to the rack configuration, fillers can be added; for 
example, storage components to the rack, as shown in Figure 5-26.

Figure 5-26   Adding filler components

If a rack is configured, you see that the user interface was updated with the new chassis and 
its information, as shown in Figure 5-27.

Figure 5-27   All Racks view

From this page, you can edit the rack settings and the rack configuration.
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5.4.2  Provisioning menu

Click Provisioning to access the Provisioning menu shown in Figure 5-28. 

Figure 5-28   Provisioning menu

The content of the Provisioning drop-down menu is divided into three sections. Each section 
is marked with an  icon to get more information about the subject. In the lower left corner 
(as highlighted in Figure 5-28) there is a Remote Control link available to start a Remote 
Control session. For more information about Remote Control, see Chapter 8, “Remote 
Control utility” on page 193.

The three sections in the Provisioning menu are as follows:

� Configuration Patterns

From the Configuration Patterns section, you define and deploy settings for your managed 
endpoints. By clicking the  icon that is next to the Configuration Patterns, you see 
instructions for how to define configuration patterns, as shown in Figure 5-29.

Figure 5-29   Configuration Patterns suggested tasks
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Next to the Suggested Tasks tab is the Concept Overview tab, which provides the base 
concept of how configuration patterns work, as shown in Figure 5-30. The diagram that is 
show has less content, but clicking the expand section icon  displays more information. 
To remove the information from the graphic and return to the diagram, click the collapse 
details icon .

Figure 5-30   Configuration Patterns Concept Overview

If you hover your mouse pointer over one of the icons, more information is shown in a 
pop-up window. For more information about configuration patterns, see Chapter 11, 
“Configuration patterns” on page 253.

� Deploy Operating Systems

This section provides the functions to manage and deploy operating systems to the 
managed endpoints. By clicking the  icon, a concept overview of the operating systems 
deployment process displays, as shown in Figure 5-31.

Figure 5-31   Operating systems deployment process

Hover your mouse pointer over any of these icons and pop-up information about the 
individual task is shown. For more information about deploying operating systems, see 
Chapter 10, “Bare metal deployment” on page 229.

� Firmware Updates

The Firmware Updates section contains all adjacent functions from acquiring to applying 
firmware updates. The process of working with firmware updates is shown in Figure 5-32 
on page 114. To see this process, click the  icon.
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Figure 5-32   Firmware update workflow

Hover the pointer over any of the icons in the process to get more information about each 
step. For more information about firmware updates, see Chapter 9, “Deploying firmware 
updates” on page 205.

5.4.3  Monitoring menu

Click Monitoring to access the Monitoring menu, which features the choices that are shown 
in Figure 5-33.

Figure 5-33   Monitoring menu

The available choices in this menu lead you to the functions that are adjacent to monitoring 
and alerting, which is described in Chapter 7, “Monitoring and alerting” on page 167.
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5.4.4  Administration menu

To access the Administration menu, click Administration in the menu bar. The drop-down 
features the choices that are shown in Figure 5-34.

Figure 5-34   Administration menu

This menu includes all of the following functions that are needed to administer the XClarity 
Administrator appliance:

� Security (for more information, see Chapter 3, “Security” on page 37)

� Date and Time settings

� Network settings 

� Service and Support (for more information, see Chapter 12, “Service and support” on 
page 327)

Click Date and Time to adjust the date and time that was set during the initial configuration 
(see 4.3, “XClarity Administrator initial configuration” on page 79). Click Network Access to 
change the network settings from the initial configuration (see 4.3, “XClarity Administrator 
initial configuration” on page 79).

The lower part of the menu features two links that are needed to start a shutdown or restart or 
update the Management server.

5.5  Microsoft PowerShell scripting functions

XClarity Administrator provides cmdlets that can be run in a Microsoft PowerShell session to 
generate scripts to automate management functions that also are available from the XClarity 
Administrator user interface.

The XClarity Administrator PowerShell cmdlets use REST APIs that are provided for XClarity 
Administrator to enable you to automate the following functions:

� Logging in to XClarity Administrator
� Managing user accounts
� Managing a chassis
� Deploying an operating system image to one or more Flex System compute nodes
� Configuring Flex System compute nodes by using Configuration Patterns
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5.5.1  Prerequisites

Before the XClarity Administrator PowerShell tool is installed, ensure that you meet the 
following prerequisites on your local Microsoft Windows system:

� Microsoft .NET Framework 4.5 is installed

Download Microsoft .NET Framework 4.5 from the following Microsoft website, if needed:

http://www.microsoft.com/en-us/download/details.aspx?id=30653

� PowerShell 3.0 is installed

Download PowerShell 3.0 from the following Microsoft website if needed: 

http://www.microsoft.com/en-pk/download/details.aspx?id=34595

At the time of this writing, the plug-in for the Microsoft PowerShell integration is available via 
Passport Advantage where the XClarity Administrator software also is available.

5.5.2  Installing the XClarity Administrator PowerShell tool

To use the XClarity Administrator PowerShell tool, you must install it first. Complete the 
following steps to install the XClarity Administrator PowerShell tool on your system:

1. Download the PowerShell for XClarity Administrator .zip file. This file is available via 
Passport Advantage, which also is where you first obtained the XClarity Administrator 
software.

2. Extract the .zip into a local directory. The content in the directory is shown in 
Example 5-1.

Example 5-1   Extracted PowerShell tool

PS C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64> dir

    Directory: C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64

Mode                LastWriteTime     Length Name
----                -------------     ------ ----
d----        07.07.2015     11:53            License
d----        07.07.2015     11:53            LXCAPSTool
d----        07.07.2015     11:53            Sample
-a---        21.04.2015     21:15       3020 install.ps1
-a---        21.04.2015     21:15        679 InstallLXCAPSTool.bat
-a---        21.04.2015     21:15        679 RemoveLXCAPSTool.bat

3. Run the installation .BAT file to install the tool by running the following command:

unzip_directory\InstallLXCAPSTool.bat

The output of the command is shown in Example 5-2 on page 117.

Note: The local system must have network connectivity to XClarity Administrator 
management server.
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Example 5-2   Installation of the PowerShell tool

PS C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64> .\InstallLXCAPSTool.bat
install LXCAPSTool

LXCAPSTool module path:
C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64

Current ENV PSModulePath:
C:\Windows\system32\WindowsPowerShell\v1.0\Modules\

New ENV PSModulePath:
C:\Windows\system32\WindowsPowerShell\v1.0\Modules\;C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_
windows_32-64

Deleted file - C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64\PSPolicyTemp.txt
Install LXCA PowerShell Tool complete.
Press any key to continue . . .
PS C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64>

4. Start a PowerShell session.

5. Validate that the module was imported by running the following command:

Get-Help *LXCA*

A list of all of the XClarity Administrator cmdlets should be returned, as shown in 
Example 5-3.

Example 5-3   List of cmdlets for the XClarity PowerShell tool

CommandType  Name                                    ModuleName
-----------  ----                                    ----------
Cmdlet       Add-LXCAEventExclusionFilter            LXCAPSTool
Cmdlet       Add-LXCAManagedDevice                   LXCAPSTool
Cmdlet       Add-LXCAUserAccount                     LXCAPSTool
Cmdlet       Backup-LXCAEventLog                     LXCAPSTool
Cmdlet       Connect-LXCA                            LXCAPSTool
Cmdlet       Disconnect-LXCA                         LXCAPSTool
Cmdlet       Get-LXCAActiveAlert                     LXCAPSTool
Cmdlet       Get-LXCAActiveSession                   LXCAPSTool
Cmdlet       Get-LXCAActiveStatus                    LXCAPSTool
Cmdlet       Get-LXCAAuditLog                        LXCAPSTool
Cmdlet       Get-LXCAAvailableMachineType            LXCAPSTool
Cmdlet       Get-LXCAChassis                         LXCAPSTool
Cmdlet       Get-LXCAChassisInventory                LXCAPSTool
Cmdlet       Get-LXCAChassisMember                   LXCAPSTool
Cmdlet       Get-LXCAComputeNode                     LXCAPSTool
Cmdlet       Get-LXCAConfigPattern                   LXCAPSTool
Cmdlet       Get-LXCAConfigPatternDeployableServer   LXCAPSTool
Cmdlet       Get-LXCAConfigProfile                   LXCAPSTool
Cmdlet       Get-LXCAConnection                      LXCAPSTool
Cmdlet       Get-LXCADeployableServer                LXCAPSTool

Note: For more information about removing the XClarity Administrator PowerShell tool, 
see 5.5.4, “Removing the XClarity Administrator PowerShell tool” on page 120.
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Cmdlet       Get-LXCADeployGlobalSetting             LXCAPSTool
Cmdlet       Get-LXCAEvent                           LXCAPSTool
Cmdlet       Get-LXCAEventExclusionFilter            LXCAPSTool
Cmdlet       Get-LXCAFFDCFile                        LXCAPSTool
Cmdlet       Get-LXCAInformation                     LXCAPSTool
Cmdlet       Get-LXCAIOModule                        LXCAPSTool
Cmdlet       Get-LXCAJob                             LXCAPSTool
Cmdlet       Get-LXCAOSImage                         LXCAPSTool
Cmdlet       Get-LXCARackServer                      LXCAPSTool
Cmdlet       Get-LXCAScalableComplexSystem           LXCAPSTool
Cmdlet       Get-LXCAServiceFile                     LXCAPSTool
Cmdlet       Get-LXCAStorageNode                     LXCAPSTool
Cmdlet       Get-LXCASystemCompliance                LXCAPSTool
Cmdlet       Get-LXCAUpdateCompliancePolicy          LXCAPSTool
Cmdlet       Get-LXCAUpdatePackage                   LXCAPSTool
Cmdlet       Get-LXCAUserAccount                     LXCAPSTool
Cmdlet       Import-LXCAOSImage                      LXCAPSTool
Cmdlet       Import-LXCAUpdatePackage                LXCAPSTool
Cmdlet       Install-LXCAConfigPattern               LXCAPSTool
Cmdlet       Install-LXCAConfigProfile               LXCAPSTool
Cmdlet       Install-LXCAOSImage                     LXCAPSTool
Cmdlet       Install-LXCAUpdatePackage               LXCAPSTool
Cmdlet       Invoke-LXCASystemAction                 LXCAPSTool
Cmdlet       Join-LXCAUpdateCompliancePolicy         LXCAPSTool
Cmdlet       New-LXCADeployTask                      LXCAPSTool
Cmdlet       Remove-LXCAConfigProfileFromSystem      LXCAPSTool
Cmdlet       Remove-LXCAEventExclusionFilter         LXCAPSTool
Cmdlet       Remove-LXCAJob                          LXCAPSTool
Cmdlet       Remove-LXCAManagedDevice                LXCAPSTool
Cmdlet       Remove-LXCAOSImage                      LXCAPSTool
Cmdlet       Remove-LXCAUserAccount                  LXCAPSTool
Cmdlet       Set-LXCADeployGlobalSetting             LXCAPSTool
Cmdlet       Set-LXCAPSLogLevel                      LXCAPSTool
Cmdlet       Set-LXCASystemIPInterface               LXCAPSTool
Cmdlet       Set-LXCASystemProperty                  LXCAPSTool
Cmdlet       Set-LXCAUserAccount                     LXCAPSTool
Cmdlet       Set-LXCAUserAccountPassword             LXCAPSTool
Cmdlet       Start-LXCAEventMonitor                  LXCAPSTool
Cmdlet       Stop-LXCAJob                            LXCAPSTool

The cmdlets that are listed in Example 5-3 on page 117 are now available for use. For more 
information about the cmdlets, run the following command:

Get-Help cmdlet_name

Example 5-4 shows the help for the Get-LXCAChassisInventory cmdlet.

Example 5-4   Detailed help for a specific cmdlet

PS C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64> get-help Get-LXCAChassisInventory

NAME
    Get-LXCAChassisInventory

SYNOPSIS
    Gets inventory data about one or more chassis from the LXCA server.
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SYNTAX
    Get-LXCAChassisInventory [-Connection <LXCAConnection>] -Chassis <Chassis[]> 
[<CommonParameters>]

    Get-LXCAChassisInventory [-Connection <LXCAConnection>] -ChassisUuid <String[]> 
[<CommonParameters>]

DESCRIPTION
    The Get-LXCAChassisInventory cmdlet gets inventory data about one or more compute nodes from 
the LXCA server.

RELATED LINKS

REMARKS
    To see the examples, type: "get-help Get-LXCAChassisInventory -examples".
    For more information, type: "get-help Get-LXCAChassisInventory -detailed".
    For technical information, type: "get-help Get-LXCAChassisInventory -full".
    For online help, type: "get-help Get-LXCAChassisInventory -online"

PS C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64>

5.5.3  Sample PowerShell scripts

Several sample PowerShell scripts are available to enable you to quickly begin using the 
XClarity Administrator PowerShell tool to manage systems.

The sample scripts are in the following directory: 

unzip_directory\Sample

The scripts that are listed in Table 5-3 are included in the Samples directory.

Table 5-3   XClarity sample scripts

Name of the script Purpose

BulkImport_And_Configuration.ps1 Demonstrates how to use the -BulkImportFile parameter of the 
Add-LXCAManagedDevice cmdlet to manage multiple 
systems and the Install-LXCAConfigPattern cmdlet to deploy 
server patterns to managed systems.

Config_Systems.ps1 Demonstrates how to deploy configuration patterns to target 
systems.

End_To_End.ps1 Demonstrates how to use the cmdlets to manage rack servers, 
update firmware and deploy server patterns and operating 
systems to those rack servers.

Firmware_Update.ps1 Demonstrates how to use the Install-LXCAUpdatePackage 
cmdlet to install firmware updates on selected systems based 
on compliance policies.

Manage_Systems.ps1 Demonstrates how to manage systems on XClarity 
Administrator.

Monitor_Events.ps1 Demonstrates how to monitor the events on XClarity 
Administrator.
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5.5.4  Removing the XClarity Administrator PowerShell tool

To remove the XClarity Administrator PowerShell tool, open a PowerShell session and run 
the following RemoveLXCAPSTool.bat batch file to remove the tool, as shown in 
Example 5-5:

Example 5-5   Removal of the XClarity PowerShell tool

PS C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64> .\RemoveLXCAPSTool.bat
remove LXCAPSTool

LXCAPSTool module path:
C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64

Current ENV PSModulePath:
C:\Windows\system32\WindowsPowerShell\v1.0\Modules\;C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_
windows_32-64

New ENV PSModulePath:
C:\Windows\system32\WindowsPowerShell\v1.0\Modules\

Deleted file - C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64\PSPolicyTemp.txt
Remove LXCA PowerShell Tool complete.
Press any key to continue . . .
PS C:\PowerShell\lnvgy_sw_lxcapstool_1.0.00.23_windows_32-64>

OS_Deployment.ps1 Demonstrates how to use the New-LXCADeployTask and 
Install-LXCAOSImage cmdlets to install operating systems on 
managed servers.

View_Events.ps1 Demonstrates how to view events on XClarity Administrator.

View_Systems.ps1 Demonstrates how to view systems on XClarity Administrator.

Name of the script Purpose
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Chapter 6. Discovery, inventory, and other 
systems information

This chapter includes information about the discovery, management, and inventory processes 
for Lenovo XClarity Administrator. XClarity Administrator can discover and manage several 
types of systems, including Flex System chassis and System x rack servers. For more 
information about the supported servers, see 2.1.2, “Supported hardware” on page 7.

XClarity Administrator can discover manageable systems that are in your environment by 
performing an SLP discovery for manageable systems that are on the same IP subnet as 
XClarity Administrator. A specified IP address or range of IP addresses also can be used and 
information can be imported from a spreadsheet, a process that is known as a Bulk Import.

A system can be managed by only one XClarity Administrator installation at a time. 
Management by multiple managers is not supported. If a system is managed by one XClarity 
Administrator instance and you want to discover and manage it with another XClarity 
Administrator instance, you must first unmanage the system from the first instance (which 
means to remove this system from XClarity Administrator). Then, you can manage the 
system with another instance.

This chapter includes the following topics:

� 6.1, “Discovery prerequisites” on page 122
� 6.2, “Discovery process” on page 124
� 6.3, “Post-discovery endpoint setup” on page 135
� 6.4, “Managed system information” on page 143
� 6.5, “Unmanaging a system” on page 155
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6.1  Discovery prerequisites

Before you begin the process to discover manageable devices, the following prerequisites 
must be met:

� Ensure that the systems you want to manage with XClarity Administrator can be 
managed.

For more information about systems that are supported at the time of this writing, see the 
following resources:

– 2.1.2, “Supported hardware” on page 7

– The Information Center that is available at this website:

http://www-01.ibm.com/support/knowledgecenter/api/redirect/flexsys/informati
on/topic/com.lenovo.lxca.doc/plan_supportedhw.html

� Ensure that all required ports are available to enable communication with the Integrated 
Management Module (IMM) and Chassis Management Module (CMM).

For more information about the ports that were required at the time of this writing, see the 
following resources:

– 2.2, “Port requirements” on page 16

– The Information Center that is available this website:

http://www-01.ibm.com/support/knowledgecenter/api/redirect/flexsys/informati
on/topic/com.lenovo.lxca.doc/plan_openports.html 

� Ensure that the Minimum Firmware is applied on the systems to be managed. 

For more information about the minimum firmware for the Managed systems at the time of 
this writing, see these resources:

– 2.1.4, “Supported firmware” on page 14 

– The XClarity Administrator Information Center that is available at this website:

http://www-01.ibm.com/support/knowledgecenter/api/redirect/flexsys/informati
on/topic/com.lenovo.lxca.doc/plan_supportedfw.html 

� Ensure that CIM over HTTPS is enabled on the endpoint that you want to manage, which 
can be done via the CMM and IMM web interface.

Complete the following steps to enable CIM over HTTPS via IMM or CMM web interface:

a. Log in to the IMM web console by using the appropriate credentials. The default 
credentials are USERID and PASSW0RD (with a zero not letter O).

b. Click IMM Management → Security, as shown in Figure 6-1 on page 123.
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Figure 6-1   Selecting Security

c. Click the CIM Over HTTPS tab and ensure that Enable CIM over HTTPS is selected, 
as shown in Figure 6-2.

Figure 6-2   Enabling CIM over HTTPS

d. Click Apply to activate changes, and log out of the IMM web interface.

� Ensure Multicast SLP forwarding is enabled on the top-of-rack (TOR) switches and the 
routers in the environment if you want to manage systems on a different subnet from 
XClarity Administrator.

� Ensure that you have the correct credentials (that is, USERID and PASSWORD) to log in 
to the IMMs and CMMs.
Chapter 6. Discovery, inventory, and other systems information 123



6.2  Discovery process

To manage a system, you first must discover that system. Complete the following steps to 
discover a system:

1. From the main title bar, select Hardware → Discover and Manage New Devices, as 
shown in Figure 6-3.

Figure 6-3   Discover and Manage New Devices view

Here, you can click Manual Input, click Bulk import, or perform a refresh of the local 
subnet via a Service Location Protocol (SLP) discovery. The three options are highlighted 
in Figure 6-4 and are described next.

Figure 6-4   Available options

Managing scalable rack systems: For System x3950 X6 servers (Model Type 6241), 
you must manage each server in the scalable rack environment; that is, both IMMs 
must be configured with IP addresses. In addition, ensure that CIM over HTTPS is 
enabled on both before trying to manage them.
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6.2.1  Manual Input option

Complete the following steps to perform a Manual Input: 

1. Click Manual Input. The Manual Input window opens, as shown in Figure 6-5. 

Figure 6-5   Manual Input window

2. Select Single System or Multiple Systems. For Multiple Systems, skip to step 6 on 
page 126. 

3. If you select Single system (as shown in Figure 6-5), you enter the single IP address of 
the system that you want to discover, as shown in Figure 6-6. Click OK.

Figure 6-6   Entering single IP address 
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4. You are prompted to enter the credentials for the servers management module. In the 
example that is shown in Figure 6-7, we want to discover and manage an x3650 M5 
server; therefore, we enter the credentials for the IMM by using the default values of 
USERID and PASSW0RD (where 0 is the number zero).

Figure 6-7   IMM USERID and PASSWORD

5. Click Manage to begin the Manage process. For more information about this process, see 
6.3, “Post-discovery endpoint setup” on page 135.

6. If you select Multiple Systems, you are prompted to enter a range of IP addresses, as 
shown in Figure 6-8.

Figure 6-8   Selecting Multiple Systems option

7. Enter the Range of IP addresses you want to discover and click OK, as shown in 
Figure 6-9 on page 127.

Tip: The total number of addresses to be discovered is displayed. 
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Figure 6-9   IP address range

You can enter multiple IP address ranges by clicking the green  button that is next to the 
range boxes. You can remove ranges again by clicking the red  icon that is next to the 
range boxes, as shown in Figure 6-10.

Figure 6-10   Option to discover multiple address ranges

If you try to discover more than 50 IP addresses at one time, the following message 
appears below the number of addresses to be discovered (see Figure 6-11 on page 128): 

For better response time, consider limiting the total number of addresses 
under 50. Reduce the range accordingly. 
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Figure 6-11   Discovering more than 50 IP addresses

8. Enter the credentials for the servers management modules that are discovered. Enter the 
appropriate credentials for each of the systems then click Manage, as shown in 
Figure 6-12.

Figure 6-12   Entering Multiple server credentials during manage process

9. The management process begins, which is described in 6.3, “Post-discovery endpoint 
setup” on page 135.

6.2.2  Bulk Import option

If you must discover many systems across multiple address ranges, add many devices to 
racks, or edit many racks, consider the use of the Bulk Import option. Bulk import enables you 
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to create and import a spreadsheet which would include all the systems and devices you 
wanted to manage, the steps below take you through this process. 

Complete the following steps to perform a Bulk Import: 

1. In Figure 6-4 on page 124, click Bulk Import. The Bulk Import window opens, as shown in 
Figure 6-13.

Figure 6-13   Bulk Import window

2. Download the XLS or CSV template file, as shown in Figure 6-14. The blue text in Step 1 
in Figure 6-14 can be clicked, which allows you to download the files.

Figure 6-14   Import Data File window
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3. Edit the file in Excel or another spreadsheet application. The Excel template file includes a 
readme worksheet and a data worksheet. The readme worksheet provides information 
about how to fill in each field on the data worksheet, including which fields are required 
and several examples.The readme worksheet is shown in Figure 6-15.

Figure 6-15   Downloaded spreadsheet in Excel format from XClarity Administrator v1.0.3 - this is the readme worksheet
130 Lenovo XClarity Administrator Planning and Implementation Guide



4. Select the Data worksheet  and add the appropriate details in the 
template file and then save file as a .CSV format.

The columns are as follows:

– Columns A - C: Required fields (type and serial number or current IP address, The type 
must always be entered. If you enter the IP address then XClarity Administrator can 
find that device and manage it. If you don't provide the IP address but you do provide 
the serial number XClarity Administrator can possibly locate that device from the list of 
devices that responded on a multicast SLP request. However multicast does not reach 
across subnet boundaries, so it is recommended you enter the IP address just in case 
the servers are not in the same subnet as XClarity Administrator.)

The following types are supported for column A-C:

• flexchassis: Flex System Chassis, 10U. 

• xserver: System x rack servers that are supported by Lenovo XClarity 
Administrator. For System x tower servers you can leave out the rack details in 
columns U-W as these servers do not get added to any racks.

• rack: As per v1.0.3 37U and 42U racks are supported. Other rack heights are not 
supported (either shorter or taller). 42U is assumed by default. Import will fail if you 
use a non supported rack height.

• filler: Placeholder for unmanaged devices. In the rack view, this device is shown as 
generic filler graphic.

– Columns D - G: You can optionally specify user credentials for each device in the 
bulk-import file. This is useful if the credentials are different for some devices. If you do 
not specify credentials for one or more devices in the bulk-import file, the global 
credentials that you specify in the Bulk Import dialog are used instead.

– Columns H-T: You can optionally provide additional information if you want to apply 
changes to the device upon successful management.

– Columns U - W: You can optionally provide information for rack creation and 
assignment. The following rack heights are supported: 37U and 42U. If the server you 
need to manage is a tower server you should leave these columns blank.

5. After the process is completed, save the edited file as a CSV file and upload this file by 
clicking Browse, finding the modified CSV file, and clicking Open. the filename will then 
display in the Bulk import view as showing in Figure 6-16

Adding a Flex System chassis via Bulk Import: It is not currently possible to 
change the CMM IP address of a managed chassis via configuration patterns within 
XClarity Administrator console; however if you do need to do this it can be achieved 
when discovering the chassis by using the Excel spreadsheet for a Bulk Import, the 
CMM IP address can be changed, as highlighted in Figure 6-15 on page 130, by 
entering the details for the new IP address, subnet, applicable gateway and DNS.
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Figure 6-16   uploaded Bulk import Template file name

6. Optional: Enter global credentials for the chassis, or rack servers, or both as showing in 
Figure 6-17 on page 132.

The global credentials are used to log in to all servers and all chassis that do not have 
credentials specified in the bulk-import file. If you choose to use the global credentials to 
log, the server-management-module credentials must be the same for all rack servers, 
and the chassis-management-module credentials must be the same for all chassis. If the 
credentials are not the same, you must enter credentials in the bulk-import file.

Figure 6-17   Enter Global credentials for Bulk Import

If managing Flex Chassis remember to supply a password for the CMM user 
RECOVERY_ID (as highlighted in Figure 6-17), this user is created on the Flex CMM by 
default when managing a Flex chassis. For information on what you would use the 
RECOVERY_ID for see Shaded Box on page 133.

If Lenovo XClarity Administrator cannot log in to a device using the credentials that are 
specified in the bulk-import file or the global credentials that are specified in the dialog, the 
management of that device fails, and Lenovo XClarity Administrator moves on to the next 
device in the bulk-import file.

Note: Flex compute nodes are considered part of the chassis discovery and are not 
considered servers for discovery purpose, even though they have the same IMM as a rack 
server.
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7. Finally once you have entered the required details Click OK.

8. A job is then created for the management process, and the process runs in the 
background. You can monitor the status of the management process from the jobs log.

6.2.3  Refreshing local SLP discovery

Complete the following steps to perform another general discovery of the local subnet:

1. Click Hardware → Discover and Manage New Devices.

2. Click the refresh button , as shown in Figure 6-18.

Figure 6-18   Perform SLP discovery of local subnet

Any new devices on the local subnet that can be managed are discovered.

3. If there are any systems discovered, they are listed in a table below as shown in 
Figure 6-19 on page 134.

What the RECOVERY_ID account is for: The RECOVERY_ID user account is a local 
account created on the CMM when XClarity Administrator is centrally managing that 
Flex Chassis’ CMM the name of this user cannot be changed hence the requirement to 
only supply a password. The RECOVERY_ID is used if the management node fails or if 
a network problem prevents the CMM from contacting XClarity Administrator to 
authenticate users. The RECOVERY_ID would then still enable you to login to the 
CMM.

Ensure that you record or document the RECOVERY_ID Password (as you should do 
all System passwords), in the event you do in fact require to use it.

The process of managing the systems begins, which is described in 6.3, 
“Post-discovery endpoint setup” on page 135.
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Figure 6-19   List of servers to manage

4. You can then select the specific system that you want to manage (assuming it is in the 
support list) and click Manage Selected. 

5. You are prompted to enter the credentials for the servers Integrated management module 
(IMM) and begin the initial process to manage the server called the management process, 
as described in 6.3, “Post-discovery endpoint setup” on page 135.

Note: XClarity Administrator currently does not support scheduling a discovery.
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6.3  Post-discovery endpoint setup

After XClarity Administrator discovers the systems, a management process is performed. 
During this management process, XClarity Administrator performs the following actions:

1. Logs in to the management module, which can be the CMM on the Flex System chassis or 
the IMM on the server, by using the provided credentials for userid and password as 
shown in shown in Figure 6-20 on page 135

. 

Figure 6-20   Request for Credentials during manage process

2. Collects inventory for all components automatically, as shown in Figure 6-21

Figure 6-21   Management process

3. Configures the settings for the NTP server so that all managed systems use the same 
NTP server from XClarity Administrator, as shown in Figure 6-21.
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4. Configures the security policy on the managed system’s management module so that the 
managed system uses the same security policy that is in place for XClarity Administrator, 
as shown in Figure 6-21 on page 135. 

5. Exchanges security certificates with the system’s management module, copying the 
system’s security certificate into the XClarity Administrator truststore, and sending the 
XClarity Administrator CA security certificate to the system’s management module. The 
system’s management module loads the certificate into the management module’s 
truststore so that the management module and all service processors can trust 
connections to the LDAP and CIM servers on XClarity Administrator.

6. Configures centralized user management, as shown in Figure 6-21 on page 135.

When an endpoint is managed by XClarity Administrator, XClarity Administrator 
configures the managed endpoint and its installed components to use a single 
authentication server for centralized management of all endpoints (except Flex System 
switches). 

User accounts that are defined in the XClarity Administrator authentication server are 
used to log on to XClarity Administrator, the Flex CMMs, and Flex node IMMs within the 
chassis in the XClarity Administrator domain. XClarity Administrator also creates another 
account which is a local account to the CMM with user ID RECOVERY_ID and password 
will be the one which has been supplied as shown in Figure 6-22 on page 136

Figure 6-22   Password for Local CMM user RECOVERY_ID

Cryptographic settings: XClarity Administrator does not modify the cryptographic 
settings (cryptographic mode and the mode used for secure communications) during 
the management process.

New certificates: If the CIM server certificate or LDAP client certificate does not exist, 
it is created during the management process.
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When you manage a rack/tower server, the local IMM user accounts are not disabled, and 
a RECOVERY_ID account is not created. You can however consider manually creating a 
RECOVERY_ID account to provide a recovery user for your rack/tower servers.

If chassis are centrally managed, user accounts can be edited only by XClarity 
Administrator.

If you make changes to the disabled local CMM user accounts (for example, if you change 
a password), the changes have no effect on the CMM RECOVERY_ID account. In 
centralized user-management mode, the RECOVERY_ID account is the only CMM 
account that is activated and operational.

7. Manages the server or chassis, as shown in Figure 6-21 on page 135, meaning you can 
now view the Server properties, and run supported tasks against the server from within 
XClarity Administrator.

In our lab tests, we occasionally saw the situation where the “manage the server” step 
failed, as shown in Figure 6-23.

Figure 6-23   Failure to manage rack server

If you see this issue, review the prerequisites that are described in 6.1, “Discovery 
prerequisites” on page 122, make any changes as required, and try to perform the 
manage task again. For more information, see the troubleshooting guide in the XClarity 
Information Center that is available at this website:

http://www-01.ibm.com/support/knowledgecenter/api/redirect/flexsys/information/
topic/com.lenovo.lxca.doc/troubleshooting.html

What the RECOVERY_ID account is for: The RECOVERY_ID user account is a local 
account created on the CMM when XClarity Administrator is centrally managing that 
Flex Chassis’ CMM the name of this user cannot be changed hence the requirement to 
only supply a password. The RECOVERY_ID is used if the management node fails or if 
a network problem prevents the CMM from contacting XClarity Administrator to 
authenticate users. The RECOVERY_ID would then still enable you to login to the 
CMM

Ensure that you record or document the RECOVERY_ID Password (as you should do 
all System passwords), in the event you do in fact require to use it. 
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In our example that is shown in Figure 6-23, the issue was that the IMM firmware was 
downlevel on our System x server; therefore, we updated the IMM firmware and attempted 
to manage the server again (we did not need to Import to refresh SLP discover as the Flex 
Chassis was still in the list of discovered systems). After this second attempt, we managed 
the server successfully, as shown in Figure 6-24.

Figure 6-24   Rack server managed successfully

8. To review the servers which are managed successfully by XClarity Administrator, click 
View All Servers. You see now see the Flex Servers managed in the view as highlighted 
in Figure 6-25).

Figure 6-25   All servers view

9. If a chassis is managed, you can click Continue to Chassis Configuration or Jump to 
Chassis view after the process is complete, as shown in Figure 6-26.

Figure 6-26   initial discover and manage options
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10.If you choose Continue to Chassis configuration, you see the Initial Chassis 
Configuration window open, as shown in Figure 6-27.

Figure 6-27   Initial Chassis Configuration window

11.Click Validate Chassis and Component IP Settings to reconfigure the Chassis 
components. The Chassis and Component IP Settings view opens, as shown in 
Figure 6-28.

Figure 6-28   Chassis and Component IP Settings view

12.You can then go into each of the sections to change the IP settings for the Chassis CMM 
and components.

The following settings can be changed:

– Global Setting: For the chassis components (except the CMM), as shown in 
Figure 6-29 on page 140 and Figure 6-30 on page 140.
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Figure 6-29   Global Settings view

Figure 6-30   Global Settings view continued

– Chassis Management Module IP Settings, as shown in Figure 6-31.

Figure 6-31   Chassis Management Module IP Settings

– Compute Node IP settings, as shown in Figure 6-32 on page 141.
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Figure 6-32   Compute Node IP Settings

– I/O Module IP Settings, as shown in Figure 6-33.

Figure 6-33   I/O module IP Settings

13.After you enter the required settings, click Save.

A summary is displayed, as shown in Figure 6-34 on page 142.

Storage nodes: Storage Node IP Settings are listed; however, it is also stated on the 
section heading that changing the storage node device name (IPv4 and IPv6) is not 
available from this page.
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Figure 6-34   Summary page for IP Chassis settings 

You must scroll down to see the complete list of IP settings. Settings to be changed are in 
bold text, as shown in Figure 6-35.

Figure 6-35   Items to be changed are shown in bold text

14.After you review the summary view, click Apply. The changes are then applied to the Flex 
Chassis. A summary view will then display showing the results
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6.4  Managed system information 

With XClarity Administrator, system Inventory is automatically discovered as part of the 
management process, as described in 6.3, “Post-discovery endpoint setup” on page 135.

Complete the following steps to view the managed systems information and inventory: 

1. From the main title bar, click Hardware. The inventory list of the types of managed 
systems is displayed, as shown in Figure 6-36. Click any of the categories from this list. In 
our example, we select All Severs.

Figure 6-36   Hardware Inventory showing types of hardware

2. In the Servers view, the servers that are managed by XClarity Administrator are listed, as 
shown in Figure 6-37.

Figure 6-37   Managed Servers view
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3. Click the link for one of the servers in the Server column (as shown in Figure 6-37 on 
page 143) or select the check box next to one of the servers and click All Actions. A 
drop-down menu is available that includes actions that can be performed on the selected 
servers, as shown in Figure 6-38.

Figure 6-38   All Actions that can be performed on selected servers 
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4. From the All Actions menu, click Details. The system Summary view opens, as shown in 
Figure 6-39.

Figure 6-39   Summary details view 

Tip: The breadcrumb trail in the main view as highlighted in Figure 6-39 is available if 
you must return to a previous view.
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5. Under the same general heading, you see the managed systems inventory option. Click 
Inventory Details and the Inventory Details view opens, as shown in Figure 6-40.

Figure 6-40   Inventory Details view

6. You can expand each section or click the plus or minus ( ) icons to expand or 
collapse all sections at the same time.

7. As shown in Figure 6-40, if you hover over the question symbol , you see more 
information, as shown in Figure 6-41. In the view on section for Drives, you see the 
message: 

Only drives that are managed by the IMM and in a RAID configuration can be 
displayed.

Figure 6-41   More information view on Drives.
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8. If all sections are expanded by using the plus and minus buttons, the result is shown in 
Figure 6-42. There is too much information to fit on the one view; therefore, only a small 
section of the information that can be seen is shown. However, the scroll bar on the right 
side of the window can be used to view the information in the other sections. 

Figure 6-42   Example of a systems inventory
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9. You also can edit the properties of a system by clicking Edit Properties, as shown in 
Figure 6-43. 

Figure 6-43   Edit properties button

10.The Edit Properties options window opens, in which you can enter the required 
information, as shown in example in Figure 6-44. Click Save.

Figure 6-44   Properties information
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After the changes are applied, the changes are shown in the inventory details view under 
the Asset Information section, as shown in Figure 6-45. 

Figure 6-45   Asset Information view
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Other options are available from the Details view. Under the Status and Health heading, you 
can view information about the following items: 

� Alerts: Shows all the alerts for the managed endpoint, as shown in Figure 6-46.

Figure 6-46   Managed System Alerts view

� Event log (which includes the Audit Event log): Shows all the managed systems events, 
as shown in Figure 6-47 on page 150, and Audit events for the managed endpoint, as 
shown in Figure 6-48 on page 151.

Figure 6-47   Managed Server Event Log view
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Figure 6-48   Managed system Audit Log view

� Jobs: Shows all of the jobs that are applied and activated on the managed endpoint, as 
shown in Figure 6-49.

Figure 6-49   Jobs view
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� Light Path: Shows all of the light path diagnostic information for the managed server, as 
shown in Figure 6-50. The list is extensive; therefore, you can use the scroll bars on the 
right to view all the various components that are supported for Light Path.

Figure 6-50   Light Path view
152 Lenovo XClarity Administrator Planning and Implementation Guide



� Power and Thermal: Shows tabular and graphical views for the System-Level Power 
allocation, System-Level Power Consumption History, CPU Subsystem-Level Power 
Consumption and Utilization History, Memory Subsystem-Level Power Consumption and 
Utilization history, and System-Level Air Temperature History, as shown in Figure 6-51.

Figure 6-51   Power and Thermal view
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Under the Configuration heading, you can view information about the following items: 

� Configuration: Show any configuration patterns that were applied to the managed server 
and information about current settings, as shown in Figure 6-52. 

Figure 6-52   Server Configuration view
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� Feature on-Demand Keys: Shows the list of Features on Demand keys that are applied to 
the server. In our example, shown in Figure 6-53, the IMM Advanced Upgrade FoD key is 
applied.

Figure 6-53   Feature on-Demand Keys

6.5  Unmanaging a system 

You can remove a chassis or a Rack Server from management by XClarity Administrator. 
This process is called unmanaging. 

Before you unmanage a chassis or Rack Server, ensure that the following prerequisites are 
met: 

� There are no active jobs running against the Rack server, chassis, or any endpoints that 
are installed in the chassis.

� If you want to remove the server pattern and any virtual addresses on the rack server, 
deactivate the server profile before unmanaging the rack server. For more information, 
see 11.7.1, “Deactivating a server profile” on page 321.

� When Call Home is enabled in XClarity Administrator, Call Home is disabled on all 
managed chassis and rack servers to avoid duplicate problem records from being created. 
If you intend to discontinue the use of XClarity Administrator to manage your endpoints, 
you can re-enable Call Home on all managed endpoints from the XClarity Administrator 
web interface in lieu of re-enabling Call Home for each individual endpoint later (see 6.5.3, 
“Re-enabling Call Home on all managed endpoints” on page 164. 
Chapter 6. Discovery, inventory, and other systems information 155



6.5.1  Unmanaging a Flex System chassis 

When you unmanage a chassis, XClarity Administrator performs the following actions:

1. Clears the configuration that is used for centralized management.

2. Removes the CMM security certificate from the XClarity Administrator truststore.

3. Removes access to the NTP server from the CMM.

4. Removes the CIM subscriptions to the CMM from the XClarity Administrator configuration 
so that XClarity Administrator no longer receives events from that chassis.

When you unmanaged a chassis, XClarity Administrator retains certain information about the 
chassis. That information is reapplied when you manage the same chassis again.

When you unmanage a chassis, events that were sent from the chassis components are 
discarded. You can retain these events by forwarding the events to an external repository, 
such as a syslog. For more information about event forwarding, see Chapter 7.5, “Forwarding 
events” on page 181.

Complete the following steps to unmanage a Flex Chassis: 

1. From the XClarity Administrator menu bar, click Hardware → Chassis or locate the Flex 
Chassis information on the Dashboard and click the number that is next to the chassis, as 
shown in Figure 6-54. In our lab example, Flex Chassis shows the number 2; therefore, 
click the number 2 to display the Chassis page, as shown in Figure 6-54.

Figure 6-54   Browse to Flex chassis view
156 Lenovo XClarity Administrator Planning and Implementation Guide



The chassis that are managed are listed, as shown in Figure 6-55.

Figure 6-55   List of managed chassis

2. Select one or more chassis from the list and click Unmanage Chassis, as shown in 
Figure 6-56.

Figure 6-56   

The Unmanage warning message is displayed, as shown in Figure 6-57.

Figure 6-57   Warning message that you are going to unmanage chassis 

You can select Force unmanage even if the endpoint is not reachable, if wanted. For 
our example, we left this option clear.

Unmanaging demo Flex Chassis: When you are unmanaging the demo Flex Chassis 
hardware, ensure that you select the Force unmanage even if the endpoint is not 
reachable option.
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3. Click Unmanage and the unmanaged process begins. You see that there is now a time 
spinner on the unmanage button .

4. As shown in shown in Figure 6-58, the Unmanage Chassis window opens and the 
progress of each step in the unmanagement process is displayed.

Figure 6-58   Unmanaging Chassis progress

5. When the unmanagement process is complete (as shown in Figure 6-59), click OK and 
you return to the chassis view.

Figure 6-59   Unmanage Chassis complete

Using local CMM accounts after an unmanage from XClarity Administrator: After 
the unmanage process is completed, you can log on to the CMM by using the local 
CMM user accounts. If you do not remember the user IDs or passwords for any local 
CMM user accounts, reset the CMM to factory defaults to log on to the CMM. For more 
information about resetting the CMM to factory defaults, see CMM Reset in the 
following CMM and CMM2 product documentation:

� CMM:

http://ibm.com/support/knowledgecenter/api/redirect/flexsys/information/t
opic/com.ibm.acc.cmm.doc/service_reset_cmm.html 

� CMM2:

http://ibm.com/support/knowledgecenter/api/redirect/flexsys/information/t
opic/com.lenovo.acc.cmm.doc/service_reset_cmm.html 
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Recovering a Flex Chassis that was not unmanaged correctly
If the Chassis cannot be unmanaged successfully, complete the following steps to restore 
account management on a CMM until XClarity Administrator is restored or replaced. In our 
lab example, we used a free SSH client PuTTY that we downloaded from this website:

http://www.putty.org/

1. Through an SSH session, open a CMM command-line interface and log on to the CMM by 
using the RECOVERY_ID account.

2. If you are prompted, enter a new password for the RECOVERY_ID account.

3. After you are logged in to the CMM via the RECOVERY_ID account, you can restore the 
CMM security and configuration by performing one of the following procedures: 

a. If you are running CMM firmware release June 2015 or later, run the following 
command:

read -f unmanage

b. If however you are running CMM firmware release earlier than June 2015, run the 
following commands in the order shown:

env -T mm[p]
sslcfg -client disabled -tc1 remove
accseccfg -am local
ldapcfg -i1 -p1 -rd "" -usa "" -gsa "" -lpa ""
ntp -en disabled -i 0.0.0.0 -v3en disabled
cimsub -clear all
fsmcm -off

The fsmcm command disables Lenovo XClarity Administrator user-account 
management and allows you to use local CMM user accounts to authenticate to the 
CMM and any management processor that is installed in the chassis.

4. After you run the fsmcm -off command, the RECOVERY_ID account is removed from the 
CMM user registry and the CMM CLI SSH session ends. 

5. You can now authenticate to the CMM and other chassis components with local CMM 
credentials and use local CMM credentials to access the CMM web interface or CLI until 
user management by XClarity Administrator is restored.

6.5.2  Unmanaging a rack or tower server 

When you unmanage a rack or tower server, XClarity Administrator performs the following 
actions:

1. Clears the configuration that is used for centralized management.

Using the RECOVERY_ID: Consider the following points:

� The password for the RECOVERY_ID account was set when you selected the 
chassis for management on the Management Domain page.

� If this is the first time that you used the RECOVERY_ID account to log on to the 
CMM, you must change the password.

Entering the commands into SSH session: It can be easier to paste these 
commands into the SSH session to avoid making mistakes with spacing.
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2. Removes the IMM security certificate from the XClarity Administrator truststore.

3. Removes access to the NTP server from the IMM.

4. Removes the CIM subscriptions to the XClarity Administrator configuration so that XClarity 
Administrator no longer receives events from the rack server.

5. Disables Call Home on the rack server if Call Home is enabled on XClarity Administrator.

6. Discards events that were sent from the rack server. You can retain these events by 
forwarding the events to an external repository, such as a syslog. For more information 
about setting up event forwarding, see Chapter 7.5, “Forwarding events” on page 181.

Complete the following steps to unmanage a rack or tower server: 

1. From the XClarity Administrator menu bar, click Hardware → Server to display the Server 
page, as shown Figure 6-60.

Figure 6-60   Server view
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2. Select one or more servers from the lists of managed servers and click Unmanage Rack 
Server, as shown in Figure 6-61.

Figure 6-61   Unmanage Rack Server 

3. The Unmanage dialog is displayed, as shown in Figure 6-62. Optionally, you can select 
Force unmanage even if the endpoint is not reachable (for our example, we do not 
select this option).

Figure 6-62   Unmanaged
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4. Click Unmanage. The Unmanage dialog shows the progress of each step in the 
unmanagement process, as shown in Figure 6-63.

Figure 6-63   Stages to unmanage rack server

5. When the unmanagement process is complete (as shown in Figure 6-64), click OK.

Figure 6-64   Unmanage server complete
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6. You return to the server view in which you see the server is removed, as shown in 
Figure 6-65.

Figure 6-65   Server view with x3550 M5 rack server removed

Recovering a rack server that was not unmanaged correctly
If a rack server was not unmanaged correctly, you must recover the rack server before you 
can manage it again. You can recover the rack server by resetting the IMM to factory defaults.

Complete the following steps to recover the rack-server management.

1. Reset the IMM to the factory defaults.

2. Log in to the IMM web interface using the appropriate credentials for that server.

3. Click the IMM Management tab and click Reset IMM to factory defaults as shown in 
Figure 6-66

Figure 6-66   Selecting Reset IMM to factory defaults

4. Click OK when prompted as shown in Figure 6-67 on page 164 to confirm the reset action.
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Figure 6-67   Confirm IMM reset to factory defaults

If the above method is not applicable for the environment you are running there is a couple of 
alternative options: 

1. You can recover rack-server by using the cimcli to clear the CIM subscriptions, described 
at the following URL: 
http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.lenovo.lxca.doc
/server_recoverfailedunmanage_usecimcli.html

2. Contact Lenovo Technical Support team via the following URL: 
http://www.ibm.com/planetwide/

6.5.3  Re-enabling Call Home on all managed endpoints

When the Call Home is enabled in XClarity Administrator, Call Home is disabled on each 
managed endpoint to avoid duplicate service tickets from being created. 

If you intend to discontinue the use of XClarity Administrator to manage your endpoints or if 
you intend to disable call-home in XClarity Administrator, you can re-enable Call Home on all 
managed endpoints from XClarity Administrator in lieu of re-enabling Call Home for each 
individual endpoint later.

Re-enabling Call Home on all endpoints might not cause Call Home to become operational 
for those endpoints. Configuration might be required on each individual endpoint if it was 
configured.

Important factors when resetting IMM to factory defaults: After the IMM configuration 
is complete, the IMM is restarted. If this is a local server, your TCP/IP connection is broken 
and you must reconfigure the network interface to restore connectivity.

After the reset the IMM is configured to attempt to obtain an IP address from a DHCP 
server. If it cannot, it uses the static IPv4 address 192.168.70.125 (this can take a few 
minutes before this IP address can be pinged.

The IMM default user name will be reset to USERID and password will be reset to 
PASSW0RD (with a zero). This default user account has Supervisor access.

Reconfigure the network interface to restore connectivity. For more information, see the 
Integrated Management Module II online documentation.
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Complete the following steps to re-enable Call Home on all managed endpoints:

1. From the XClarity Administrator menu bar, click Administration → Service and Support, 
as shown in Figure 6-68.

Figure 6-68   Service and Support start point

2. The Service and Support page opens, as shown in Figure 6-69.

Figure 6-69   Service and Support page
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3. Click the Call Home Configuration tab to display the Call home configuration, as shown 
in Figure 6-70.

Figure 6-70   Call home configuration page

4. Clear Enable Call Home to disable Call Home for XClarity Administrator, as shown in 
Figure 6-70.

5. Click Enable Call Home on all endpoints to enable Call Home on each managed 
endpoint, as shown in Figure 6-70.
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Chapter 7. Monitoring and alerting 

One of the most important functions of Lenovo XClarity Administrator is the monitoring and 
alerting features. As a centralized system management solution, XClarity Administrator 
provides hardware monitoring capabilities that help system administrators to ensure that the 
server workloads are remaining available. The system administrators must be informed about 
the status of their installed servers. If there is a failure, more information is required to 
investigate and troubleshoot. 

To improve business agility, an alert or the information about a failed component can be 
forwarded to a higher-level management tool to allow further action. How to work with the 
monitoring and alerting capabilities in XClarity is described in this chapter.

This chapter includes the following topics:

� 7.1, “Alerts and events” on page 168
� 7.2, “Viewing alerts” on page 168
� 7.3, “Resolving an alert” on page 174
� 7.4, “Viewing events” on page 175
� 7.5, “Forwarding events” on page 181
� 7.6, “Monitoring jobs” on page 190
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7.1  Alerts and events

Alerts are hardware or management conditions that need investigation and user action. 
XClarity Administrator receives and displays events asynchronously from the managed 
endpoints. In addition, each managed endpoint is checked once every 30 minutes to ensure 
that XClarity Administrator has the latest events available.

Typically, when an alert is received, a corresponding event is stored in the event log. There 
can be an alert without a corresponding event in the event log. For example, events that 
occur before you manage a chassis are not displayed in the event log. However, the alerts for 
the chassis are displayed in the alert log because XClarity Administrator polls the CMM after 
the chassis is managed. Another reason why an alert may not have an event associated with 
it is that the event log filled up and has wrapped.

Alerts provide the information about existing problems. The alerts disappear from the list after 
the problem is resolved. However, the alerts continue to show in the event log. The event log 
contains a history of events that occurred.

7.2  Viewing alerts

Alerts are made visible for active problems on a managed endpoint, which applies to 
warnings and critical events. Informational events are not mapped to alerts. Such events are 
available in the event log. There are several ways within XClarity Administrator to view active 
alerts as described in this section.

7.2.1  Viewing alerts from the Status drop-down menu 

The active hardware alerts can be displayed by using the Status drop-down menu. In this 
drop-down menu, choose the With Hardware Alerts tab to see a list of endpoints that sent 
hardware alerts. If you hover the pointer over the endpoint, the information for the alert is 
displayed, as shown in Figure 7-1.

Figure 7-1   View alerts from the Status drop-down menu

From the Status drop-down menu, you can also click All Hardware Alerts to see the Alerts 
log.

In the Status drop-down menu, the With Management Alerts tab is available. If you select 
this tab, alerts from the CMM and XClarity Administrator are displayed.
168 Lenovo XClarity Administrator Planning and Implementation Guide



7.2.2  Viewing alerts for a single endpoint

To view the active alert for one endpoint, select the endpoint and browse to the details 
window, as shown in Figure 7-2.

Figure 7-2   Alerts for a single endpoint

In this window, click Alerts to show the active alerts for the selected endpoint to see the 
active alerts. From here, you can see more information about the alert by clicking the Alert 
text and then hovering the pointer over the alert. This information includes the properties and 
details of the individual alert, as shown in Figure 7-3 and Figure 7-4 on page 170.

Figure 7-3   Alert properties
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Figure 7-4   Alert details

7.2.3  Viewing alerts for multiple endpoints

To view alerts for multiple endpoints, click Monitoring → Alerts, as shown in Figure 7-5.

Figure 7-5   Monitoring drop-down menu

The Alerts window opens in which the alerts of multiple endpoints are listed, as shown in 
Figure 7-6.

Figure 7-6   Alert log

You can refresh the list of alerts as needed by clicking the Refresh icon . However, the 
alert log refreshes automatically every 30 seconds if new alerts are detected. From here, you 
can also access the actual alert details. In addition, the alerts can be sorted by clicking a 
column heading.
170 Lenovo XClarity Administrator Planning and Implementation Guide



7.2.4  Alert filtering

When you are viewing the events for an individual system and events for multiple systems, 
the Alerts window also allows you to filter the events. Figure 7-7 shows the options that you 
can use for filtering the alerts in the log.

Figure 7-7   Alert filtering options

Click the icons to show or hide alerts with a certain severity.

To filter by alert source, select one of the options in the menu. Table 7-1 lists the available 
options.

Table 7-1   Alert source options

You can filter the events by date and time or enter a string into the Filter field to display only 
alerts that contain specified text.

The default selection is that all alerts are shown. Choose any of the options or a combination 
(for example, filtering by severity and by date to show the critical events of the last 24 hours). 
Depending on your selection, the Alerts log displays the corresponding alerts only.

Alert Source What is being displayed

All Alert Sources All alerts from any source

Hardware Events All hardware-related events; for example: failed components, 
power on/power off

Management Events All events made visible by XClarity Administrator; for example: 
event log wrapped, service data collected

Service Center Events All events brought up by the Call Home functionality of XClarity 
Administrator; for example: Call Home event successful / Call 
Home event failed

Customer Serviceable Events All events that require a user intervention; for example: events 
that are marked Serviceability = User

Non-serviceable Events All events that do not require a personal intervention; for 
example: events that are marked Serviceability = Not Required

Click the icons to show 
or hide alerts:
� Critical alerts
� Warning alerts
� Informational alerts
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7.2.5  Exporting alerts

You can export the log by clicking the Export to CSV icon . This option is available when 
you are viewing the alerts for an individual system and when viewing events for multiple 
systems.

7.2.6  Excluding alerts

From the alerts list for multiple systems, you also can exclude alerts from being displayed. 
This option is needed if there are specific alerts that are of no interest to you. Excluded alerts 
are still in the log but are hidden from the pages on which alerts are displayed, including log 
view and system status.

Complete the following steps to exclude audit events from the audit log:

1. From the XClarity Administrator menu bar, click Monitoring → Alerts. The Alerts page 
opens.

2. Select the alerts to be excluded and click the Exclude alerts icon . The Exclude Alerts 
dialog opens, as shown in Figure 7-8.

Figure 7-8   Excluding alerts

Note: If an explanation and user action for an alert are not displayed, see the following 
Flex System Information Center website and search for the alert ID (for example, 
FQXHMSE0004G):

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.common.
nav.doc/ic-homepage.html 

Note: The time stamp in the exported log use the local time that is specified by the web 
browser.

Restriction: Only users with administrative authority can exclude or restore alerts.

Note: Excluded alerts are hidden for all users, not only the user that set the configuration.
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3. Select one of the following options:

– Exclude selected alerts from all systems

Exclude the selected alerts from all managed endpoints.

– Exclude alerts only from systems in the scope of the instance selected

Excludes the selected alerts from managed systems to which the selected alerts apply.

4. Click Save.

After the exclusion is saved, you must refresh the Alerts window if it is still open to view only 
the remaining alerts. The Status view is updated when the exclusion is defined.

When you exclude alerts, XClarity Administrator creates exclusion rules that are based on 
information that you provide. You can view a list of exclusion rules and excluded alerts from 
the Alerts page by clicking Excluded Alerts. In the Excluded Alerts dialog, click the 
Exclusion Rules tab to view the exclusion rules or click the Excluded Alerts tab to view 
excluded alerts. This dialog also allows to export the list of excluded alerts as CSV file.

To remove an exclusion rule, click Excluded Alerts to display the Excluded Alerts dialog, 
and then select the Exclusion Rules. Mark one or multiple rules to remove, and click 
Remove, as shown in Figure 7-9.

Figure 7-9   Remove an exclusion rule
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7.3  Resolving an alert

Complete the following steps to resolve an alert:

1. From the XClarity Administrator menu bar, click Monitoring → Alerts to display the Alerts 
page.

Alerts that contain the entry User in the Serviceability column (as shown in Figure 7-10) 
require a manual change.

Figure 7-10   Check the Serviceability

2. Locate the alert in the alerts log.

3. Click the link in the Alert column to view information about the alert. The information about 
the alert includes the alert properties and the alert details (including an explanation and 
user action), as shown in Figure 7-11.

Figure 7-11   Alert details and recovery

4. Complete the steps listed in the Details tab to resolve the alert. For example, the alert 
Details in our example state that the specified power supply does not have input power. 
The Recovery action restores input to the power supply.

Alerts that are removed from any Alerts view are stored in the Event Log.

Note: If an explanation and user action for an alert are not displayed, see the following 
Flex System Information Center website and search for the alert ID (for example, 
FQXHMSE0004G):

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.common.
nav.doc/ic-homepage.html 

If you follow all steps that are described in this section and the problem persists, contact 
Lenovo Support.
174 Lenovo XClarity Administrator Planning and Implementation Guide

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.common.nav.doc/ic-homepage.html
http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.common.nav.doc/ic-homepage.html


7.4  Viewing events

From XClarity Administrator, you have access to an event log and an audit log.

7.4.1  Event Log

The event log provides a list of all hardware and management events. These events are 
available in the event log if the condition that lead to the event log entry was solved. The 
event log contains informational and non-informational events. The number of each of these 
events can vary until the maximum of 2,000 events is reached in the event log. 

At that point, there is a maximum of 1,000 informational and 1,000 non-information events. 

For example, there are 0 events in the event log initially. Assume that events are received so 
that 1,500 informational events and 500 non-informational events are received. When the 
next event is received, the oldest informational event is discarded even if a non-informational 
event is older.

Eventually, the log balances out so that there are 1,000 of each type of event. 

XClarity Administrator sends an event when the event log reaches 80% of minimum size and 
another event when the sum of the event and audit logs reaches 100% of maximum size.

7.4.2  Audit log

The audit log provides a record of user actions, such as logging on to XClarity Administrator, 
creating a user, and changing a user password. You can use the audit log to track and 
document authentication and controls in IT systems.

The audit log can contain a maximum of 2,000 events. XClarity Administrator sends an event 
when the audit log reaches 80% of maximum size and another event when the sum of the 
event and audit logs reaches 100% of maximum size.

You can use the audit log to track and document authentication and controls of the managed 
endpoints.

Tip: You can export the event log to ensure that you have a complete record of all 
hardware and management events. To export the event log, click All Actions → Export 
as CSV or click the Export as CSV icon .

Tip: You can export the audit log to ensure that you have a complete record of all audit 
events. To export the audit log, click All Actions → Export as CSV or click the Export as 
CSV icon .
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7.4.3  Viewing events from a single endpoint

To view the active alert for one endpoint, select the endpoint and go to the details window, as 
shown in Figure 7-12.

Figure 7-12   Event log example for a single endpoint

In this window, click Events to show the events for the selected endpoint. From here, you can 
access more information about the individual event by clicking the Event text and then 
hovering the pointer over the event information. The properties and details of the individual 
event are displayed, as shown in Figure 7-13 and Figure 7-14 on page 177.

Figure 7-13   Event properties
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Figure 7-14   Event details

If you want to access the audit log for a single managed endpoint, go to the Details window 
for the individual system and click Event Log and select the Audit Log tab. The Audit Log 
events are displayed, as shown in Figure 7-15.

Figure 7-15   Audit log example for a single endpoint

7.4.4  Viewing events for all endpoints

To view the event log, click Monitoring → Event Logs from the XClarity Administrator menu 
bar, as shown in Figure 7-16.

Figure 7-16   Open event log for all endpoints
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Then, click the Event Log tab, as shown in Figure 7-17.

Figure 7-17   Event Log example

The entries in the event log contain information about the severity, serviceability, date and 
time, system name, the event message, and the system type. The Severity column shows if 
the event is informational, a warning, or a critical event.

The Serviceability column identifies whether the endpoint requires service. This column 
contains one of the following values:

� Not required: The event is informational and does not require service.

� User: Take appropriate action to resolve the issue.

� Support: If call home is enabled on XClarity Administrator, the event is typically submitted 
to the Lenovo Support Center (unless there is an open service ticket for the endpoint for 
the same event ID). If call home is not enabled, it is recommended that you manually open 
a service ticket to resolve the issue (for more information, see chapter 12.3, “Opening a 
service ticket” on page 332).

The Server column specifies from which source the event was provided.

To view the Audit Log, click the Audit Log tab. Although the audit log does not provide any 
Serviceability information, it does provide information that a user did start the action that was 
logged.

The entries in the Event column of the event log and the audit log are shown as links and can 
be clicked to view details about specific events. A dialog is displayed that provides the event 
properties (including more information, such as the event number or the FRU number for 
failed hardware components) and the event details (including information about recovery 
actions).

The following action icons are available at the Event Log and the Audit Log page:

� Export as CSV : Export the event log and audit log entries that are shown to a CSV 
file.

This option is available when you are viewing the events for an individual system and 
multiple systems. 

� The Exclude events icon : Exclude specific events from all pages on which events are 
displayed.

Tip: The time stamps in the exported log use the local time that is specified by the web 
browser.
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� The Refresh icon : Refresh the list of events.

� Click the Delete icon  to remove entries from the log. To do remove an entry, select the 
specific entry and click Delete.

7.4.5  Event filtering

For filtering the list of events in the event log or the audit log, the same procedure is used that 
is described for Alert filtering in 7.2.4, “Alert filtering” on page 171. Use the available choices 
in the event log view for an individual system or for all systems to narrow the list of events you 
see.

To sort the events by column, click a column heading.

7.4.6  Excluding events

From the event log or the audit log, you can exclude specific events that are of no interest to 
you to narrow the list of events. The excluded events are not displayed, but are still in the log. 
They are hidden from all pages on which events are displayed. The procedure is similar to the 
process that is described for excluding alerts in 7.2.6, “Excluding alerts” on page 172.

Excluded Events from the event log and the audit log are visible in the same view. To see 
which events are excluded, go to the Alert Log and click Show Excluded Events. The 
Excluded Events dialog opens. To remove any of the defined exclusion rules, select the even 
and click Remove as shown in Figure 7-18 on page 180.

Tip: The event log refreshes automatically every 30 seconds if new events are 
detected.

Restriction: Only users with administrative authority can exclude or restore events.

Note: Excluded events are hidden for all users, not only the user that set the configuration.
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Figure 7-18   Exclude events dialog

The events of this specific type are then returned back into the regular event list.

7.4.7  Resolving events

Complete the following steps to resolve an event:

1. From the XClarity Administrator menu bar, click Monitoring → Event Logs to display the 
Logs page.

2. Click the Event Log tab.

3. Locate the event in the events log.

4. Click the link in the Event column to view information about that event (including an 
explanation and recovery actions) and about the endpoint that is the source of the event.
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5. Click the Details tab. You see the information about how to resolve this specific event, as 
shown in Figure 7-19.

Figure 7-19   How to resolve a specific event

6. Complete the steps that are described in the Recovery section to resolve the event.

7.5  Forwarding events

You can configure XClarity Administrator to forward events to connected applications that you 
have in your environment for aggregating and monitoring hardware status and runtime issues 
for your hardware environment. You can define the scope of events to be forwarded based on 
endpoint, event class, event severity, and component.

The event forwarding feature is available in Monitoring drop-down menu by choosing Event 
forwarding, as shown in Figure 7-20.

Figure 7-20   Event forwarding

Note: If an explanation and user action for an alert are not displayed, go to Flex System 
Information Center website and search for the event title:

http://pic.dhe.ibm.com/infocenter/flexsys/information/index.jsp

If you follow the steps and the problem persists, contact Lenovo Support.
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The Event Forwarding window opens, as shown in Figure 7-21.

Figure 7-21   Event Forwarding window before configuration

XClarity Administrator can forward audit, hardware, and management events for one or more 
endpoints. By default, there is no event forwarding that is configured after the initial 
installation.

XClarity Administrator uses remote event recipients to forward events. A remote event 
recipient contains the event forwarding definition. It includes information about the protocol to 
use, recipient, endpoints to monitor, and events to forward. After you create and enable a 
remote event recipient, XClarity Administrator starts monitoring for incoming events based on 
the filter criteria. When a match is found, the associated protocol is used to forward the event.

XClarity Administrator supports the following protocols for event forwarding:

� Syslog

XClarity Administrator forwards the monitored events over the network to a central log 
server where native tools can be used to monitor the syslog.

� SNMP

XClarity Administrator forwards the monitored events over the network to a remote SNMP 
manager. At the time of this writing, only SNMPv3 traps are supported.

� Email

XClarity Administrator forwards the monitored events to one or more email addresses by 
using SMTP. The email includes the event properties and the host name of the endpoint.

You can create and enable up to 12 remote event recipients to receive events. A maximum of 
two of those recipients can use the syslog protocol.

Note: Events are not delivered if, for example, connectivity between XClarity Administrator 
and the remote event recipient is down or if the port is blocked.
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7.5.1  Event forwarding to a Syslog server

To start configuring a remote recipient, click the New icon  in the event forwarding window. 
The New Event Recipient window opens, as shown in Figure 7-22.

Figure 7-22   Configuring syslog event forwarding

In this example, we configured event forwarding to a syslog server in the environment. When 
you configure a new event recipient, Syslog is selected by default. You must enter the 
information that is specific to your environment. The Name should be a descriptive name that 
makes it easy to identify the configuration.

In the Host field, enter the qualified DNS or the IP address of your Syslog server. The port 
information that is provided by default is port 514, which is used for Syslog. If required, you 
can enter your individual port information.

The new event recipient is enabled by default. If you are preparing the configuration for a 
remote event recipient to be activated later, you must set the status to Disabled after the 
configuration is saved.

Click Next.
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In the Systems tab of the dialog, you choose the endpoints to be monitored, as shown in 
Figure 7-23.

Figure 7-23   Selection of the monitored endpoints

In our example, we monitor the x3550 M5 and the Flex System Enterprise Chassis with all 
components included. The individual Flex System chassis components to be monitored are 
shown if you expand the entry for the chassis.

Select the endpoints that you want to monitor and click Next.
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The Events tab opens, as shown in Figure 7-24.

Figure 7-24   Selection of the events to be forwarded

By using this window, you can configure the event filter to define which events are being 
forwarded.

Select Include all Audit events if you want to forward Audit events.

For hardware events, you can choose to forward events for one or more severities (critical, 
warning, and informational) and for one or more components (such as disks, processors, and 
adapters).

Click Create. The configured event recipient is listed in the Event Forwarding window.

Note: For audit events, you can choose to forward all audit events or none. You cannot 
forward specific audit events.
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There is a maximum of two event recipients that are supported by using Syslog. If you try to 
create more recipients, a message is displayed that indicates that the maximum number was 
reached, as shown in Figure 7-25

Figure 7-25   Syslog forwarding message

7.5.2  Event forwarding via SNMP

XClarity Administrator can forward events via SNMP. At the time of this writing, only SNMPv3 
events are supported.

For more information about the management information base (MIB) file that describes the 
SNMP traps that are generated by XClarity Administrator, see Appendix A, “MIB Appendix” 
on page 361.

Complete the following steps to configure a remote recipient for SNMP event forwarding:

1. In the Event Forwarding window, click the New icon .

2. In the General tab of the New Event Recipient dialog, select SNMPv3. You see the New 
Event Recipient dialog, as shown in Figure 7-26 on page 187.
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Figure 7-26   Configuring SNMPv3 event forwarding

3. Enter the information into the fields according to the setup of your environment. Enter a 
descriptive name to identify the purpose of this configuration and the qualified DNS or IP 
address of the trap destination. The default port to be used is port 162.

As an option, you can enter more information, including the contact name, location, user 
ID, authentication type and password, privacy type, and password.

The new event recipient is enabled by default. If you are preparing the configuration for a 
remote event recipient to be activated later, you must set the status to Disabled after the 
configuration is saved.

4. Click Next to get to the Systems tab. Select the systems to be monitored.

5. Click Next to get to the Events tab. Select the events to forward.

This dialog allows you to configure the event filter to define which events are forwarded.

6. Select the Include all Audit events option if you want to forward Audit events.

For hardware events, you can choose to forward events for one or more severities 
(critical, warning, and informational) and for one or more components (such as disks, 
processors, and adapters).

7. Click Create. The configured event recipient is listed in the Event Forwarding window.

Note: For audit events, you can choose to forward all audit events or none. You cannot 
forward specific audit events.
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On the trap destination you must compile the lenovoMgrAlert.mib file for XClarity 
Administrator. This file can be found for download by using the documentation that is 
available in the Flex System Information Center:

http://pic.dhe.ibm.com/infocenter/flexsys/information/index.jsp

For more information about the MIB file, see Appendix A, “MIB Appendix” on page 361.

7.5.3  Event forwarding via email

From XClarity Administrator, you can forward events via email. Complete the following steps 
to configure a remote recipient for email event forwarding:

1. Click the New icon  in the Event Forwarding window.

2. In the General tab of the New Event Recipient dialog, select Email. The New Event 
Recipient dialog opens, as shown in Figure 7-27.

Figure 7-27   Configuring email event forwarding

3. Enter the information into the fields according to the setup of your environment.

4. Enter a descriptive name to identify the purpose of this configuration and the qualified 
DNS or IP address of the SMTP server. The default port to be used is port 25. 

5. In the Recipients field, enter the email address for each recipient as user@domain.

You can enter multiple email addresses; however, these addresses must be separated by 
a comma.
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The new event recipient is enabled by default. If you are preparing the configuration for a 
remote event recipient to be activated later, you must set the status to Disabled after the 
configuration is saved.

6. Click Next to get to the Systems tab. Select the systems that are to be monitored.

7. Click Next to get to the Events tab. Select the events that are forwarded.

This dialog allows to configure the event filter to define which events are being forwarded.

8. Select the Include all Audit events option if you want to forward Audit events.

For hardware events, you can choose to forward events for one or more severities 
(critical, warning, and informational) and for one or more components (such as disks, 
processors, and adapters).

9. Click Create.

The configured event recipient is listed in the Event Forwarding window.

7.5.4  Working with event recipients

After the remote event recipients are configured in XClarity Administrator, the list of event 
recipients is displayed, as shown in Figure 7-28.

Figure 7-28   Remote event recipients list

The Status column in this list shows if the event forwarding for the listed remote event 
recipients is Enabled or Disabled. If you configured a new remote event recipient, it is 
Enabled by default. If you want to suspend the recipient, set the status to Disabled.

Note: If you set up your SMTP server to require a host name to forward emails and you 
do not set up a host name for XClarity Administrator, the SMTP server might reject 
forwarded events. If XClarity Administrator does not have a host name, the event is 
forwarded with the IP address. If the IP address cannot be obtained, “localhost” is sent 
instead, which causes the SMTP server to reject the event.

Note: For audit events, you can choose to forward all audit events or none. You cannot 
forward specific audit events.
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You can change the settings within each configuration by clicking the name of the event 
recipient or select the event recipient and clicking the edit icon . The dialog for the event 
recipient configuration opens in which the configuration can be changed.

To remove remote event recipients, click one or more event recipients and click the Delete 
icon .

7.6  Monitoring jobs

Jobs are longer running tasks that are performed against one or more endpoints. For 
example, if you deploy an operating system to multiple servers, each server deployment is 
listed as a separate job. Jobs run in the background, but you can see the status of all jobs 
from the XClarity Administrator job log. To access the Job log, go to the Monitoring menu and 
select Jobs, as shown in Figure 7-29.

Figure 7-29   Accessing the Job log

The Jobs window opens in which all of the jobs are listed with their name, status, a time 
stamp for start and completion, the Targets (if available), job type, and who created the job, 
as shown in Figure 7-30.

Figure 7-30   Job log example
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Icons are available with which you can choose to export to CSV , cancel jobs , delete 
jobs , and refresh  jobs from the log. You must select one or more jobs before clicking 
one of these icons.

You can click the title of a column to sort the entries in the table or use the filtering options that 
are shown in Figure 7-31 to narrow the list of jobs.

Figure 7-31   Filtering the job log

The Job log includes jobs that are running, completed, or have errors. Some jobs in the Job 
log are listed with subtasks and you can see the status of each individual task.

Note: The time stamps in the exported log use the local time that is specified by the web 
browser.

Note: It might take several minutes to cancel a running job.

Show / hide jobs that are
� In a warning / error state
� Running
� Complete
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To see more information about each job, click the job name and a window opens that includes 
information about the job (including a log for this individual job), as shown in Figure 7-32.

Figure 7-32   Job details

Another way to see a short list of the latest job is to access the Jobs drop-down menu from 
the XClarity Administrator title bar, as shown in Figure 7-33.

Figure 7-33   Jobs drop-down menu

Click Jobs to see a short list of jobs that are running, completed, and have errors.

Click the following tabs to display the corresponding job list:

� With Errors: Displays all jobs that have errors associated with them.
� Running: Displays all jobs that are in progress.
� Completed: Displays a historical record of all completed jobs.

Hover the pointer over the entry and you see more information; for example, about the 
progress of a job.

When you click the View all jobs link in the drop-down menu, the job log page that contains 
all of the jobs opens.
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Chapter 8. Remote Control utility

A powerful feature of Lenovo XClarity Administrator is the ability to control managed servers 
from a remote location. This chapter describes the capabilities of the Remote Control utility.

This chapter includes the following topics:

� 8.1, “Starting Remote Control” on page 194
� 8.2, “Remote Control window” on page 196
� 8.3, “Remote control functions” on page 198
� 8.4, “Remote Control performance considerations” on page 203
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8.1  Starting Remote Control

The XClarity Administrator web interface allows Remote Control sessions for Flex System 
and System x servers. 

The following prerequisites must be met to use Remote Control:

� Remote Control requires the Oracle Java Runtime Environment (JRE) plug-in, version 7.0 
or later. The JRE plug-in is required on the local system before a remote control session 
can be started. If the utility is not available on the local system, the Java Web Start and the 
latest JRE can be downloaded from the following Java download website:

http://www.java.com/en/download

� Remote Control requires that a Feature on Demand (FoD) key for remote presence is 
installed on System x servers. If an FoD key is not detected on a server, the remote control 
session displays a “missing activation key” message. An FOD is not required for the 
remote control of Flex Nodes.

� The user ID that is used to start the remote control session must be a valid user ID that is 
defined in the XClarity Administrator authentication server. The user ID must have 
sufficient user authority to access and manage a server.

Opening a Remote Control session
Remote Control can be used in targeted or untargeted mode. In untargeted mode, the remote 
control session opens and the user connects to the wanted server. In targeted mode, a 
specific server is chosen. When the Remote Control session opens, the program is 
connected to the server.

Opening a Remote Control session in untargeted mode
To open an untargeted Remote Control session, click Provisioning → Remote Control from 
the XClarity Administrator menu bar. Accept any security warnings from your web browser. 

Opening a Remote Control session in targeted mode
Complete the following steps to open a Remote Control session in targeted mode: 

1. From the XClarity Administrator menu bar, click Hardware → Servers.

2. Select the server.

Note: For Flex System x280, x480, and x880 compute nodes, connect to the primary 
node. When a remote control session is opened on a non-primary node in a multi-node 
system the remote control dialog starts, but no video is displayed.
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3. Click the Remote Control icon or choose All Actions → Launch Remote Control, as 
shown in Figure 8-1. Accept any security warnings from your web browser. 

Figure 8-1   Launch targeted Remote Control

4. When prompted, select one of the following connection modes:

– Single-user mode

This mode establishes an exclusive Remote Control session with the server. All other 
Remote Control sessions to that server are blocked until the session is disconnected 
from the server. This option is available only if no other Remote Control sessions are 
established to the server.

– Multi-user mode

This mode allows multiple Remote Control sessions to be established with the same 
server. XClarity Administrator supports up to six concurrent Remote Control sessions 
to a single server.

When prompted, choose whether to save a shortcut to the Remote Control session on the 
local system. If the shortcut is saved, it can be used to open a Remote Control session 
without starting it from the XClarity Administrator web interface. The local system must 
have access to XClarity Administrator to validate the user ID with the XClarity 
Administrator authentication server.

The Remote Control window opens.
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8.2  Remote Control window

Figure 8-2 shows the Remote Control window when Remote Control is started in untargeted 
mode.

Figure 8-2   Untargeted Remote Control window

To add servers to the session, click the Add icon and select the servers, as shown in 
Figure 8-3.

Figure 8-3   Adding servers to the Remote Control session
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Multiple server sessions are displayed, as shown in Figure 8-4. Each thumbnail shows a live 
view of each server console. Clicking a thumbnail displays the server console in the video 
session area.

Figure 8-4   Remote control view

Remote Control windows capabilities
All functions of the Remote Control utility can be accessed by clicking the following Remote 
Control icons:

� Hide or show the thumbnail area by clicking the Toggle Thumbnails icon ( ).

� Clicking the Video icon allows users to toggle the current window to full screen and to take 
a capture of the active window.( ).

� Users can perform power functions on the server in the active window by clicking the 
Power icon ( ).

� The Softkey icon ( ) allows uses to define custom key sequence. New key sequences 
can be defined; by default, the following sequences are included:

– Ctrl+Alt+Del
– Alt+Tab
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� The Remote Media icon ( ) allows users to upload and mount remote media (such as 
CD, DVD, or USB device, and disk and ISO images) to the selected server. 

� Click the Preferences icon  to change the remote control preferences. 

8.3  Remote control functions

This section outlines the features available in the Remote Control utility.

8.3.1  Powering on and off a server from a Remote Control session

Complete the following steps to power on and off a server from a Remote Control session:

1. From the Remote Control window, click the thumbnail for the proper server. 

2. Click the Power icon and then click one of the following power actions:

– Power on
– Power down OS and power off
– Power off
– Shut down OS and restart
– Restart
– Restart with non-maskable interrupt (NMI)

8.3.2  Defining softkeys

Custom key sequences or softkeys can be defined for the current Remote Control session. To 
display the current list of softkey definitions, click the Keyboard icon. 

Softkey definitions are stored on the system where the remote control session is started. User 
settings can be exported from the User Settings tab on the Preferences dialog. Softkeys are 
exported with the other user settings.

Complete the following steps to add a softkey:

1. From the Remote Control window, click the Keyboard icon and then, click Add softkey. 
The Softkey Programmer tab on the Preference dialog is displayed.

2. Click New.

3. Enter the key sequence to be defined.

Note: The available options in the drop-down menu depend on the state of the system. 
For example, if the server is on, the Power on option is unavailable.

Note: If an international keyboard is used and softkeys that require the Alternate Graphics 
key (AltGr) are set up, ensure that the operating system on the workstation that is used to 
start the Remote Control application is the same type of operating system as the one on 
the server that is remotely accessed. For example, if the server is running Linux, ensure 
that the Remote Control session is started from a workstation that is running Linux.
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8.3.3  Use of Ctrl, Alt, and Shift keys

Some operating systems intercept certain keys instead of passing them to the remote 
system. The sticky key buttons are used to send keystrokes directly to the server.

To send a Ctrl or Alt key combination, click Ctrl or Alt in the toolbar, as shown in Figure 8-5.

Figure 8-5   Remote Control icon bar

Place the cursor in the video session area and press a key on the keyboard.

For example, to send a Ctrl+Alt+Del key combination, complete the following steps:

a. Click Ctrl in the toolbar.

b. Click Alt in the toolbar.

c. Left-click anywhere inside the video session area.

d. Press the Delete key on the keyboard.

When Ctrl, Alt, or Shift is selected in the toolbar, the key remains active until a keyboard key 
is pressed or the button is cleared by clicking the button a second time.

8.3.4  Remote media

The Remote Control utility allows the user to mount remote media on a system via the 
Integrated Management Module. The section below outlines the process to mount physical 
media or an image file to a remote system.

Mounting or moving remote media
The Remote Media icon allows users to upload and mount remote media to the selected 
server. The following media can be uploaded to a server:

� CD
� DVD
� USB device
� Disk image 
� ISO image

Consider the following points:

� Only one user at a time can mount and upload data to the storage on an Integrated 
Management Module (IMM). Other users are prevented from accessing the local storage 
on the IMM while it is mounted or if data is uploaded to the local IMM storage.

� Mounting more than one ISO image on a server that is running Linux is not supported.

Note: If the mouse-capture mode is enabled, press the left Alt key to move the cursor 
outside of the video session area. Mouse-capture mode is disabled by default.
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Complete the following steps to mount remote media:

1. From the Remote Control window, click the Remote Media icon.

2. Click Mount remote media. The following options are available:

– Select an image to be mounted 

The image is available for the selected server until the device is unmounted or the 
Remote Control session is closed. Multiple images can be mounted to a single server, 
and each image can be mounted to multiple servers.

– Select a drive, such as a CD, DVD, or USB device, that is to be mounted 

The device is available to the selected server until the drive is unmounted or the 
Remote Control session is closed. Multiple devices can be mounted to a single server, 
but each device can be mounted to only one server at a time.

– Upload the image to the IMM 

Use this option to store an image in local storage on the IMM for the selected server. 
The image remains on the IMM, even if the Remote Control session is closed or if the 
server is restarted.

Complete the following steps to move previously mounted remote media resource between 
servers:

1. Select one or more resources.

2. Click Add to Move the resources to the Selected Resources list.

3. Click Mount to mount the resources for use by the server.

Uploading an image to a server
An image can be sent and stored on the IMM of a server. Consider the following points:

� After the image is uploaded to the IMM, it remains on the IMM after the end of the Remote 
Control session if the server is restarted. 

� The image size is limited to approximately 50 MB of data. 

� Multiple images can be uploaded to the IMM if the total space that is used for all images is 
less than 50 MB.

� Each image that is uploaded to the IMM is automatically mounted to the server.

Complete the following steps to upload an image to the server IMM:

1. From the Remote Control window, click the Remote Media icon.

2. Click Mount remote media.

3. Click Upload the image to the IMM.

8.3.5  Importing and exporting user settings

User settings for the current Remote Control session can be exported from a session and 
then imported into another session. Complete the following steps to import or export user 
settings for the current Remote Control session:

1. From the Remote Control window, click the Preference icon.

2. Click the User Settings tab.

3. Click Import to import settings from an exported file.

4. Click Browse, then select the proper file.
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5. Click Export to save the all current user settings in a properties file on the local system.

8.3.6  Setting Remote Control preferences

To modify the Remote Control preferences, click the Preferences icon. The options in the 
preferences window are shown in Figure 8-6. 

Figure 8-6   Preferences window

The following sections explain the tabs in the preferences window.

KVM tab
The following options are available in the KVM tab:

� Percentage of Video Bandwidth

Increasing the bandwidth improves the quality in the appearance of the Remote Control 
session, but can potentially affect the performance of the Remote Control session.

� Percentage of Frames Refreshed

Increasing the frame-refresh percentage increases how often the Remote Control session 
is updated but can potentially affect the performance of the Remote Control session.

� Keyboard type

Select the type of keyboard that you are using for the Remote Control session. The 
keyboard type that you select must match the keyboard settings in the local system and 
match the keyboard settings on the remote host.

� Scale image to window

Select this option to scale the video image that is received from the server to the size of 
the video session area.

Note: All changes that are made in the preferences window take effect immediately.
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Security tab
The following options are available in the Security tab:

� Prefer single-user mode connections

Specify whether single-user mode connections is the default choice when connecting to a 
server. When a connection is made in single-user mode, only one user can be connected 
to a server at a time. If this box is not selected, the default function is to connect to the 
server in multi-user mode.

� Require (secure) tunneling connections

Select this option to access a server through the management server. You can use this 
option to access a server from a client that is not on the same network as the server.

Toolbar tab
The following options are available in the Toolbar tab:

� Pin the toolbar to the window

By default, the toolbar is hidden above the Remote Control session window and displays 
only when you move your mouse pointer over it. If this option is selected, the toolbar is 
pinned to the window and is always displayed between the thumbnail panel and the 
Remote Control session window.

� Show keyboard buttons

Specify whether to show the keyboard button icons (Caps Lock, Num Lock, and Scroll 
Lock) on the toolbar. 

� Show power control

Specify whether to show the power control options on the toolbar.

� Show sticky key buttons

Specify whether to show the sticky key button icons (Ctrl, Alt, and Delete) on the toolbar.

� Hide local mouse pointer

Specify whether to show the local mouse pointer when you position the cursor in the 
server session that is displayed in the video session area.

� Enable mouse-capture mode

By default, mouse-capture mode is disabled. Therefore, you can freely move the cursor in 
and out of the video session area. If you enable mouse-capture mode, you must press the 
left Alt key before you can move the cursor out of the video session area. If mouse-capture 
mode is enabled, you can specify whether to use the Ctrl+Alt keys to exit mouse-capture 
mode. The default is to use the left Alt key.

� Specify toolbar background opacity

Lowering the opacity percentage displays more of the video session area through the 
toolbar background.

Thumbnails
The following options are available in the Thumbnails tab:

� Show thumbnails

Select this option to show the thumbnail area in the Remote Control session.

� Specify thumbnail refresh interval

Decreasing the interval for refreshing thumbnails increases how often the server 
thumbnails are updated.
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General
The following options are available in the General tab:

� Debug mode

Specify whether to set debug mode for the Remote Control application. The settings 
determine the granularity of events that are logged in the log files. By default, only severe 
events are logged. 

� Inherit system appearance settings

This setting changes the appearance to match color schemes that are configured for the 
client system (running Windows). You must restart the Remote Control application for 
these settings to take effect.

� Create desktop icon

This setting creates a desktop icon on your local system so that you can start the Remote 
Control application directly from your system. You still must have access to XClarity 
Administrator from your system.

� Synchronize with management server

This setting ensures that the server data that is displayed in the Remote Control 
application matches server data that is displayed in the management software.

8.4  Remote Control performance considerations

If a Remote Control session becomes slow or unresponsive, consider the following 
suggestions:

� The size of the Remote Control session window and the number of active sessions can 
affect workstation resources, such as memory and network bandwidth. Close some of the 
remote control sessions.

� The Remote Control session uses a soft limit of 32 open sessions. If more than 32 
sessions are open, performance can degrade and the Remote Control sessions might 
become unresponsive.

If a Remote Control session becomes slow or unresponsive, consider the following points: 

� Performance can be increased by changing the following preferences:

– KVM tab:

• Decrease the percentage of video bandwidth that is used by the application. The 
image quality of the Remote Control session is reduced.

• Decrease the percentage of frames that are refreshed by the application. The 
refresh rate of the Remote Control session is reduced.

– Thumbnails tab:

• Increase the thumbnail refresh interval rate. The application refreshes thumbnails at 
a slower rate.

• Turn off the display of thumbnails completely.
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Chapter 9. Deploying firmware updates

To maintain the managed endpoints, firmware updates might be required on installed 
components. Updating firmware on the managed endpoints is one of the major capabilities of 
Lenovo XClarity Administrator. It provides an easier way to roll out firmware updates 
compared to other non-centralized solutions.

XClarity Administrator polls the inventory data from the managed endpoints to determine 
which firmware levels are installed and compares them with update levels that are available 
based on the rules that are defined in the update policies.

XClarity Administrator also provides the infrastructure to deploy the updates to the endpoints 
from a centralized management console. 

This chapter describes how to roll out firmware updates by using XClarity Administrator.

This chapter includes the following topics:

� 9.1, “Firmware update considerations” on page 206
� 9.2, “Updating firmware on managed endpoints” on page 209
� 9.3, “Managing the firmware-updates repository” on page 210
� 9.4, “Compliance policies” on page 216
� 9.5, “Updating managed endpoints” on page 220
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9.1  Firmware update considerations

Before you begin updating firmware for managed endpoints through XClarity Administrator, 
review the following important considerations:

� Updates that applied to the primary Integrated Management Module (IMM) and Unified 
Extensible Firmware Interface (UEFI) firmware partitions.

IMM and UEFI updates can be applied independently to the primary and backup firmware 
partitions for the IMM and UEFI.

You can also apply IMM and UEFI updates to only the primary firmware partitions on the 
server. By default, the IMM is configured to synchronize the backup IMM partition with the 
primary IMM partition after the primary IMM is running satisfactorily and the new level is 
ready to promote to back up. However, the IMM is not configured to synchronize the UEFI 
backup partition by default. Therefore, consider one of the following options on the IMM:

– Enable the automatic synchronization of the UEFI backup partition.

This option ensures that the primary and backup partitions are running the same level 
of firmware (and that the backup UEFI firmware is compatible with the IMM firmware).

– Disable the automatic synchronization of the IMM backup partition.

Although not recommended, this option gives you complete control over the firmware 
levels for the IMM and the UEFI. However, you must manually update the IMM and 
UEFI firmware for both partitions.

Use compliance policies to determine which updates are applied to each device. For more 
information about compliance policies, see 9.4.1, “Creating compliance policies” on 
page 217.

� Possibility of VMware vSphere ESXi system failure (host purple diagnostic screen) when 
an IMM is reset.

If you are running VMware vSphere ESXi on any server, ensure that the following 
minimum VMware ESXi levels are installed before updating the firmware on the server:

– If you are running VMware vSphere ESXi 5.0, install minimum level of 5.0u2 (update 2)
– If you are running VMware vSphere ESXi 5.1, install minimum level of 5.1u1 (update 1)

If you do not install these minimum levels, a VMware vSphere ESXi system failure (host 
purple diagnostic screen) might occur whenever the IMM is reset, including when IMM 
firmware is applied and activated.

Note: If IMM and UEFI are configured to automatically synchronize the backup 
firmware from the primary, it is not necessary for XClarity Administrator to update the 
backup banks. In that case, you can clear the backup bank updates when applying 
updates to a server or remove the backup banks from the compliance policy.

Note: ESXi 5.5 is not affected by this issue.
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� Minimum required levels of firmware.

Ensure that the firmware that is installed on each managed endpoint is at the minimum 
required level before XClarity Administrator is used to update firmware on those 
endpoints. For more information about firmware requirements, see Supported firmware in 
the XClarity Administrator online documentation, which is available at this website:

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.lenovo.lxca.doc
/aug_product_page.html 

For more information about the supported firmware levels that are available at the time of 
this writing, see 2.1.4, “Supported firmware” on page 14.

� Firmware updates are disruptive and require that workloads be temporarily inactive on 
endpoints.

Performing firmware updates on managed endpoints is disruptive if you choose to 
immediately activate the update. Consider this issue before firmware is updated on the 
endpoints by using immediate activation.

When updating firmware on servers, the servers are shut down and placed in a 
maintenance operating system to update firmware for adapters, hard disk drives (HDDs), 
and solid-state drives (SDDs).

Flex System switches in a specific chassis are updated sequentially and restarted during 
the firmware update process. Implementing redundant data paths lessens the disruption, 
but there might still be a brief interruption in network connectivity during the firmware 
update.

� Update all components to the software level that are included in the firmware-updates 
repository.

Because firmware updates for Flex System components are tested and released together, 
it is recommended that you maintain the same firmware level on all components in a Flex 
System chassis. Therefore, it is important to update firmware on all components in the 
chassis in the same maintenance window. XClarity Administrator automatically applies the 
selected updates in the correct sequence.

� Some firmware updates are co-dependent on a minimum level of device driver.

Before applying adapter and I/O firmware updates on a server, you might be required to 
update the device driver to a minimum level. In general, firmware updates are not 
dependent on specific levels of device drivers. For more information about such 
co-dependencies, see the firmware update readme file. Update the device drivers in your 
operating system before updating the firmware. XClarity Administrator does not update 
device drivers in your operating system.

� Do not use XClarity Administrator to update the firmware on the server on which XClarity 
Administrator is running.

If XClarity Administrator is running on a server that it is managing, you must not update 
firmware on that server by using XClarity Administrator. The firmware-update process 
shuts down the target server; therefore, selecting XClarity Administrator as a target node 
also shuts down XClarity Administrator.

� Select Immediate Activation when compute nodes that are at IMM firmware levels earlier 
than Flex System 1.3.2 are updated.

When you apply the Flex System 1.3.2 lifecycle release to a compute node, you must 
choose immediate activation to update the compute node. Immediate activate forces the 
compute node to restart during the update process.
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� Flex System switches must be configured with an IP address that is reachable from 
XClarity Administrator.

The target Flex System switch must be assigned an IP address that can communicate 
with XClarity Administrator so that XClarity Administrator can download and apply the 
firmware update.

� Update support on scalable nodes, such as x480 X6 and x880 X6 nodes.

Update support on scalable nodes, such as the Flex System x480 X6 and x880 X6 
Compute Nodes, is limited to configurations where the complex is configured as a single 
partition that includes all compute nodes that are part of the multi-node complex. You 
cannot use XClarity Administrator management system to update a complex that consists 
of multiple partitions.

� Applying the ServeRAID™ M5115 PSoC3 (Programmable System-on-Chip) update 
package from XClarity Administrator requires a minimum installed level of 68.

The ServeRAID M5115 PSoC3 update from earlier than version 68 must be done in a 
controlled manner.

For installed versions earlier than 68, you cannot update by using XClarity Administrator. 
Instead, you must use the CMM web interface or the command-line interface (CLI).

9.1.1  Using the CMM web interface

Complete the following steps by using the CMM web interface:

1. Log in to the CMM web interface.

2. From the main menu, click Service and Support → Advanced.

3. Click the Service Reset tab.

4. Select the appropriate compute node.

5. From the Reset drop-down menu, click Virtual Reseat.

6. Click OK to confirm.

9.1.2  Using the CMM CLI

Complete the following steps by using the CMM CLI:

1. Log in to the CMM Secure Shell (SSH) interface.

2. Enter the following command to perform a virtual reseat:

service -vr -T blade[x]

Where x is the bay number of the compute node to be reseated.

After the system is powered back on, start the operating system and update the 
ServeRAID M5115 PSoC3 by using the extracted embedded update package. The 
extraction process is described next.

Tip: You can view the ServeRAID M5115 PSoC3 code version by logging in to the 
Chassis Management Module (CMM) web interface and selecting the Firmware tab for 
the target compute node. Then, select the Expansion Card for the ServeRAID M5115. 
The PSoc3 code version is the GENERIC firmware type.
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Complete the following steps to extract the embedded package by using Microsoft Windows:

1. Open the update package (lnvgy_fw_psoc3_m5115-70_windows_32-64.exe) and select 
Extract to Hard Drive.

2. Select the path to where the embedded package is extracted.

If Linux is used, run the following command:

lnvgy_fw_psoc3_m5115-70_linux_32-64.bin -x

Where x is to where the embedded package is extracted.

9.2  Updating firmware on managed endpoints

From the XClarity Administrator web interface, you can download, install, and manage 
firmware updates for managed endpoints, including chassis, servers, and Flex System 
switches. You also can assign compliance policies to the managed endpoints to ensure that 
firmware on those endpoints remains compliant. You can also create and edit compliance 
policies if your validated firmware levels do not match the suggested predefined policies.

Firmware updates can be applied to the hardware only. You cannot update devices drivers by 
using XClarity Administrator.

You can manage and apply firmware for the following endpoints:

� Chassis

XClarity Administrator can manage and apply CMM updates on Flex System chassis.

� Servers

XClarity Administrator can manage and apply IMM, UEFI, dynamic storage area (DSA), 
and adapter updates on Flex System compute nodes and rack/tower servers.

� Flex System switches

Firmware for the following endpoints cannot be updated through XClarity Administrator:

� Power Systems compute nodes

Several methods are available to update the firmware for Power Systems compute nodes. 
For more information about updating firmware for a Power Systems compute node, see 
the following web page: 

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.7895.do
c/updating_firmware.html 

� Flex System V7000 Storage Node

Use the Flex System V7000 Storage Node user interface to update the firmware. For 
more information about updating software and firmware for the Flex System V7000 
Storage Node, see the following web page:

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.4939.do
c/svc_upgradingintro.html 

� Flex System switches that are in stacked mode or protected mode

You can update firmware on only the master switch in the stack. Updating firmware is 
disabled for all other switches that are stacked.

Note: An operating system is not required to update firmware.
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� Cisco Nexus B22 Fabric Extender

XClarity Administrator does not support the Cisco Nexus B22 Fabric Extender module to 
update the firmware. If this module is used, see the documentation that is provided with 
the switch to update the firmware.

� Top-of-rack switches

At the time of this writing, XClarity Administrator does not support updating firmware for 
RackSwitch™ top-of-rack switches. If top-of-rack switches are used, see the 
documentation that is provided with the switch to update the firmware for that switch.

Figure 9-1 shows the workflow for updating firmware on managed endpoints.

Figure 9-1   Firmware update workflow

The individual steps that are shown in Figure 9-1 are described next.

9.3  Managing the firmware-updates repository

To see which update packages are available to XClarity Administrator, you must browse to 
the firmware-updates repository. The repository is available from the Provisioning menu in 
every console window, as shown in Figure 9-2.

Figure 9-2   Firmware-updates repository in the Provisioning menu

The firmware-updates repository includes a product catalog. This product catalog contains 
information about firmware updates that are available for all endpoints that are supported by 
XClarity Administrator. The product catalog organizes the firmware updates in update 
packages by endpoint type, as shown in Figure 9-3 on page 211. The items in the table can 
be sorted, expanded, or collapsed.
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Figure 9-3   Example of available firmware updates within the repository

The product catalog also contains more information about each package; for example, 
version information, release date, size of the package, and download status.

The  icon in the Release Notes column can be selected to show the content of the readme 
file and the change log for the individual package to see what changed with the actual 
package version, as shown in Figure 9-4.

Figure 9-4   Release Notes for an individual package

In the Policy Usage column, the package is marked if it is used in one of the compliance 
policies (as denoted by the  icon) that are described in 9.4, “Compliance policies” on 
page 216.

In addition, the Severity column provides the information if a package is critical, non-critical, 
or suggested to install the update.

The content of the firmware updates repository must be refreshed to ensure that the latest 
updates are available from XClarity Administrator. By clicking the Refresh Repository icon 

, XClarity Administrator retrieves information about the latest available firmware updates 
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from the Fix Central website (http://www.ibm.com/support/fixcentral/) and stores the 
information to the firmware-updates repository. 

For more flexibility, you can also use the options that are available from the Refresh Catalog 
menu to check for available updates, as shown in Figure 9-5. This functionality requires that 
XClarity Administrator is connected to the Internet.

Figure 9-5   Refresh Catalog menu

Although the catalog is refreshed, the updates are not yet downloaded into the repository. For 
more information about downloading updates, see 9.3.1, “Downloading firmware updates” on 
page 213.

If there is no Internet connection available to XClarity Administrator, you must import the 
updates into XClarity Administrator manually, as described in 9.3.2, “Manually importing 
updates into the repository” on page 213.

Both methods to acquire the updates are shown in Figure 9-6.

Figure 9-6   Acquiring firmware updates

Note: If there is a certain endpoint type not listed in the product catalog, you must first 
manage an endpoint of that type before you can download or import firmware updates for 
that endpoint type.

Note: For firmware updates on rack servers (that is, x3550 M5, x3650 M5, and x3850 X6/ 
x3950 X6, you must install fix pack 1.
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9.3.1  Downloading firmware updates

If there are new updates available that must be applied to an installed system, the update 
appears in the product catalog as Not Downloaded. Before these updates can be applied to a 
system, they must be downloaded into the repository first. This process is done by selecting a 
package or a system and clicking the Download Selected icon , as shown in Figure 9-7. 
This process can also be done for multiple packages or multiple systems at once.

Figure 9-7   Download firmware updates

The updates are loaded from the following FixCentral website:

http://www.ibm.com/support/fixcentral/

For this procedure, XClarity Administrator must have an Internet connection. We describe the 
process when there is no connection available in the next section.

9.3.2  Manually importing updates into the repository

When XClarity Administrator is installed, it includes an initial set of firmware packages. If 
there is no Internet connection available, manually download updates from the following 
website to a separate directory:

http://www.ibm.com/support/fixcentral/

In the next step, the updates must be manually imported into the firmware-updates repository. 
To import firmware updates, click the Import icon  or select Import from the All actions 
menu, as shown in Figure 9-8.

Figure 9-8   Important updates from the All actions menu
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If you chose to import updates, you are prompted to select the required files, as shown in 
Figure 9-9.

Figure 9-9   Select files to import

The firmware updates that you import into XClarity Administrator must include all required 
files (for example, for System x rack server, the updates include the update file, XML, change 
history, and readme file).

After clicking Import, you can see the progress of the import of the individual update, as 
shown in Figure 9-10.

Figure 9-10   Importing an individual file

Some update packages might be applicable to multiple systems. In such a case, the status 
bar also appears for systems that were not selected for importing updates.

If you import more than one update at a time, you can follow the progress of all imports that 
are running in the general section of the window, as shown in Figure 9-11.

Figure 9-11   Overall progress of the import

As with all jobs, the status of the Import Updates job is available from the Jobs menu. Click 
Jobs and hover the pointer over the job where you want to see the status from any XClarity 
Administrator window, as shown in Figure 9-12.

Figure 9-12   Job status
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9.3.3  Deleting updates from the repository

Although there are up to 20 GB of space available for the firmware updates repository, you 
should perform housekeeping in the repository periodically to delete older firmware packages 
that are no longer needed from the usability perspective and for your own convenience.

Ensure that all running or scheduled update jobs that use a compliance policy with the 
firmware updates that are assigned that are deleted are completed or canceled.

To delete an update package from the repository, mark the package and click the Delete icon 
, as shown in Figure 9-13. This process also can be done for multiple packages once.

Figure 9-13   Deleting packages from the repository

In the next step, you are prompted to confirm if you want to delete the package.

If the package you want to delete is still in use in one of the compliance policies, the package 
is not deleted and a message indicating as such is displayed, as shown in Figure 9-14.

Figure 9-14   Unable to delete packages

In this case, the compliance policy that involves this update package must be edited or 
removed. For more information about working with compliance policies, see 9.4, “Compliance 
policies” on page 216.
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9.4  Compliance policies

By using compliance policies, you can check whether the firmware on specified endpoints is 
at the current or specified levels by flagging the endpoints that need attention. Each 
compliance policy identifies which endpoints are monitored and which firmware update level 
must be installed to keep the endpoints in compliance. XClarity Administrator then uses these 
policies to check the status of managed endpoints and identify endpoints that are out of 
compliance.

Select Provisioning → Compliance Policies to open the compliance policy window, as 
shown in Figure 9-15.

Figure 9-15   Compliance Policy window

The initial XClarity Administrator features a predefined compliance policy. In our example, we 
updated the appliance by installing a repository pack. Through this installation, another 
predefined compliance policy became available. The predefined compliance policies are 
called DEFAULT-<date>, as shown in Figure 9-16.

Figure 9-16   Predefined compliance policy example

The predefined compliance policies flag any server as not compliant when the firmware on 
that server is down level.

Note: Before you start working with compliance policies, ensure that the product catalog is 
refreshed and contains the latest levels of firmware. The firmware levels that are used in 
the compliance policies must be downloaded into the repository.
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9.4.1  Creating compliance policies

When you create a compliance policy, you can choose to have XClarity Administrator identify 
when a more up-to-date level of firmware is added to the firmware-updates repository or a 
change is made to an endpoint for which a compliance policy is in effect.

To create a compliance policy, select the Create icon  in the Compliance Policies window. 
The window that is shown in Figure 9-17 opens.

Figure 9-17   Create a New Policy window

Complete the required fields for the following criteria:

� System Type: Choose a type of endpoint for which this policy is to apply.

� Compliance Target: Specify the firmware level that is considered to be the baseline for the 
specified system type. The following compliance targets for the system are available:

– Default: For all components in the systems category, the newest versions that are 
contained in the product catalog are selected.

– Custom: If you choose Do Not Update to prevent firmware from being updated on a 
specific device or you choose not to use the latest version. 

Tip: If you choose a server, the compliance level is done at the UXSP level. However, 
you can also expand the server to specify specific firmware levels for each component, 
such as the IMM or UEFI.

Note: When the content of the product catalog changes and new updates become 
available, the compliance policies are not automatically updated. You must edit the 
existing compliance policies or create compliance policies to include newer levels.
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� Compliance Rule: Specify when a device is flagged as not compliant in the Installed 
Version column on the Firmware Updates: Apply/Activate:

– Flag if not exact match: If the firmware level that is installed on a device is not an exact 
match with the compliance policy, the endpoint is flagged as not compliant. For 
example, if you replace a device, such as a network adapter in a compute node, and 
the firmware on that device is different than the level identified in the compliance policy, 
the compute node is flagged as not compliance.

– Flag if down level: If the firmware level that is installed on a device is earlier than the 
level that is specified in the compliance policy, the endpoint is flagged as not compliant. 
For example, if you replace a device, such as a network adapter in a compute node, 
and the firmware on that device is earlier than the level identified in the compliance 
policy, the compute node is flagged as not compliance.

– No flagging: Devices that are out of compliance are not flagged.

You can add updates for more than one System Type into one Compliance Policy by clicking 
the Add new system button .

Figure 9-18 shows an example of creating a policy.

Figure 9-18   Create a New Policy window

Click Create.

The list of compliance policies is extended when compliance policies are created, as shown 
in Figure 9-19.

Figure 9-19   List of compliance policies
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The compliance policy is added to the table in the compliance policy page. The table shows 
the usage status, origin of the policy (whether user-defined or predefined), and by whom and 
when it was last modified.

9.4.2  Assigning compliance policies

After a compliance policy is created, XClarity Administrator monitors changes to the hardware 
inventory. When the firmware on an endpoint is not compliant with the assigned policy, 
XClarity Administrator identifies that endpoint as not compliant on the Firmware Updates: 
Apply/Activate page, which is based on the rule that you specified in the compliance policy.

You must assign a compliance policy to an endpoint before you can apply and activate 
firmware updates on the endpoint.

Complete the following steps to assign a compliance policy to an endpoint:

1. From the XClarity Administrator menu bar, click Provisioning → Apply/Activate. The 
Firmware Updates: Apply/Activate page is displayed with a list of managed endpoints.

2. To assign a compliance policy to a single endpoint, select a policy from the drop-down 
menu in the Assigned Policy column.

You can select only from a list of compliance policies that are applicable to each endpoint. 
If a policy is not assigned to the endpoint, the assigned policy is set to “No assignment.” If 
no policies are applicable to the endpoint, the assigned policy is set to “No applicable 
policies.”

3. Complete the following steps to assign a compliance policy to multiple endpoints:

a. Select one or more systems to which you want to assign a compliance policy.

b. Click the Assign policy icon  to display the Assign Policy dialog, as shown in 
Figure 9-20.

Figure 9-20   Assign policy dialog

c. Select a compliance policy from the Policy to assign drop-down menu.

d. Select one of the following scopes for the policy assignment:

• All applicable systems
• Applicable systems with no current policy assignment
• Only selected applicable systems

e. Click OK. The policy that is listed in the Assigned Policy column on the Firmware 
Updates: Repository page changes to the name of the selected compliance policy.
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For example, you can create a compliance policy that defines the baseline level for firmware 
that is installed in all Flex System x440 compute nodes and then assign that compliance 
policy to all managed x440 compute nodes. When the firmware-updates repository is 
refreshed and a new firmware update is added to the catalog, those compute nodes might 
become out of compliance. When this situation occurs, XClarity Administrator updates the 
Firmware Updates: Apply/Activate page to show that the endpoint is not compliant.

9.4.3  Editing compliance policies

By clicking the name of the compliance policy in the compliance policy list, the policy is 
opened for viewing. To edit a compliance policy, select the individual compliance policy and 
then click the Edit icon .To change a compliance policy, the policy must not be assigned to 
an endpoint. If you attempt to edit a compliance policy that is still assigned, a message is 
displayed, as shown in Figure 9-21.

Figure 9-21   Notice of a failed compliance policy editing process

In this case, you must unassign the compliance policy first. If the compliance policy is still 
needed, it also can be copied to create a compliance policy with similar content. Change the 
policy as required and assign it to the appropriate endpoints.

Another alternative is to create a compliance policy from scratch, as described in 9.4.1, 
“Creating compliance policies” on page 217.

9.4.4  Deleting compliance policies

You can delete compliance policies that are no longer needed. In such case, you must 
unassign the policy from the endpoints before you can delete the policy.

9.5  Updating managed endpoints

XClarity Administrator does not automatically apply firmware updates to managed endpoints. 
After XClarity Administrator identifies an endpoint as not compliant, you can manually apply 
and activate the firmware updates on managed endpoints by using the XClarity Administrator 
web interface. 

9.5.1  Identifying endpoints to be updated

If a compliance policy is assigned to a managed endpoint, you can determine whether the 
firmware on that endpoint is compliant with that policy.

Note: Predefined compliance policies cannot be edited.
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To determine this compliance, click Provisioning → Apply/Activate from the XClarity 
Administrator menu bar to display the Firmware Update: Compliance Policy page, and review 
the Installed Version column for that endpoint.

The Installed Version column includes one of the following values:

� Firmware version: The firmware version that is installed on the endpoint is compliant with 
the assigned policy.

� Not Compliant: The firmware that is installed on the endpoint is not compliant with the 
assigned policy.

� No Compliance Policy Set: A compliance policy is not assigned to the endpoint.

You can click the Refresh icon  to refresh the content in the Installed Version column.

9.5.2  Considerations for applying updates

Consider the following points before updates are applied to the endpoints:

� Review the firmware update considerations that are described in 9.1, “Firmware update 
considerations” on page 206.

� Ensure that the firmware updates repository includes the firmware packages that you 
intend to deploy. If the not repository does not include the updates, refresh the product 
catalog and download the appropriate firmware updates, as described in 9.3, “Managing 
the firmware-updates repository” on page 210.

� Ensure that compliance policies are created and assigned to the endpoints on which you 
intend to apply firmware updates, as described in 9.4.1, “Creating compliance policies” on 
page 217 and 9.4.2, “Assigning compliance policies” on page 219.

� Endpoints typically require a restart to activate the firmware update. If you choose to 
restart the endpoint during the update process (immediate activation), ensure that any 
running jobs are stopped or, if you are working in a virtualized environment, moved to a 
different server.

� If XClarity Administrator runs on a managed server, do not use XClarity Administrator to 
update firmware on that server. When firmware updates are applied with immediate 
activation, XClarity Administrator forces the target server to restart, which also restarts 
XClarity Administrator. When applied with deferred activation, only some firmware is 
applied until the target system is restarted.

� If you are updating CMMs that are running firmware level GA5 2PET12K - 2PET12Q, are 
running more than three weeks, and are in a dual-CMM configuration, you must virtually 
reseat the primary and standby CMMs before updating.

9.5.3  Applying and activating firmware updates

You can apply updates to multiple endpoints at the same time. XClarity Administrator 
automatically updates endpoints in the same chassis in the correct sequence so that the 
CMM is updated first, followed by Flex System switches, and then compute nodes.

You can choose to apply and activate all firmware updates that apply to a compliance policy 
or only specific firmware updates in a policy. Only downloaded firmware updates are applied.

Firmware updates on compute nodes and rack servers are performed out-of-band. Therefore, 
the servers are shut down when firmware updates are applied from XClarity Administrator. 
Ensure that any running workloads are stopped or, if you are working in a virtualized 
environment, moved to a different server.
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When you perform a firmware update, XClarity Administrator starts one or more jobs to 
perform the update.

After a firmware update is applied to an endpoint, one or more restarts might be required to 
fully activate the firmware update. You can choose whether to restart the endpoint 
immediately or to delay the activation. If you choose to restart immediately, XClarity 
Administrator minimizes the number of restarts that are required. If you choose to delay 
activation, the updates are activated the next time the endpoint is restarted.

Complete the following steps to apply and activate updates managed endpoints.:

1. From the XClarity Administrator menu bar, click Provisioning → Apply/Activate, as 
shown in Figure 9-22.

Figure 9-22   Provisioning menu Apply/Activate

The Firmware Updates: Apply/Activate page is displayed, as shown in Figure 9-23.

Figure 9-23   Firmware Updates: Apply/Activate list of endpoints

2. Select one or more endpoints and components to which firmware updates are to be 
applied.

You can choose to apply all updates for a specific endpoint. However, you can also 
choose to expand an endpoint to specify updates for specific components, such as the 
IMM or UEFI.

Note: XClarity Administrator automatically enables LAN-over-USB interface through port 
6990.
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If you choose to install an update package that contains updates for multiple components, 
all components and devices to which the update package applies are updated.

By default, all detected devices are listed as available for applying updates; however, 
down level firmware might prevent a device from appearing in inventory or reporting full 
version information. To see a list of all policy-based packages that are available for 
updating, click the Global Settings icon , and select Enhanced Support for 
Down-Level Devices. When this option is selected, “Other Available Software” is listed in 
the Installed Version column for undetected devices.

3. Click the Perform Updates icon . The Update Summary dialog is displayed, as shown 
in Figure 9-24.

Figure 9-24   Update Summary dialog

4. Select one of the following update rules:

– Stop all updates on error

If an error occurs while any of the devices in the endpoint (such as an adapter or IMM) 
are updated, the firmware-update process stops for all selected endpoints in the 
current firmware update job. In this case, none of the updates in the update package 
for the endpoint are applied. The current firmware that is installed on all selected 
systems remains in effect.

– Continue on error

If an error occurs while any of the devices in the endpoint are updated, the firmware 
update process does not update the firmware for that specific device; however, the 
firmware update process continues to update the other devices in the endpoint and 
continues updates for all other endpoints in the current firmware update job.
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– Continue to next system on error

If an error occurs while any of the devices in the endpoint are updated, the firmware 
update process stops all attempts to update the firmware for that specific endpoint; 
therefore, the current firmware that is installed on that endpoint remains in effect. The 
firmware update process continues updates for all other endpoints in the current 
firmware update job.

5. Select one of the following activation rules:

– Immediate activation

During the update process, the endpoint might be restarted automatically several times 
until the entire update process is complete. Ensure that you acquiesce all applications 
on the endpoint before you proceed.

Firmware updates can be immediately activated on a maximum of 20 endpoints at 
once. If you choose Immediate Activation on more than 20 endpoints, the remaining 
endpoints are queued for activation as activation on other endpoints complete.

– Delayed activation

Some update operations are performed. Endpoints must be restarted manually to 
continue the update process. More restarts are then performed until the update 
operation completes.

If an endpoint restarts, the delayed update process completes.

Delayed Activation applies to servers only. CMMs and Flex switches are immediately 
activated, regardless of this setting.

6. (Optional) Select Attempt to update components already in compliance to update 
firmware on the selected components, even if the firmware level is up to date.

7. Click Perform Update.

To activate the firmware updates, the endpoints must be restarted. (Restarting an endpoint is 
disruptive.) You can choose to restart the endpoints as part of the update process (called 
immediate activation), or wait until a maintenance window is available to restart the endpoints 
(called delayed activation). In this case, you must manually restart the endpoint for the 
update to take effect.

Important: Do not choose Delayed Activation for more that 20 endpoints at one 
time. XClarity Administrator actively monitors endpoints with delayed activation so 
that the delayed activation is serviced when endpoint is restarted. When more than 
20 endpoints are selected, this process is not monitored by XClarity Administrator 
and might timeout. If you want to apply updates with delayed activation for more 
than 20 endpoints, divide the update selection into batches of 20 endpoints at one 
time.

Note: If you choose to install an update package that contains updates for multiple 
components, all components and devices to which the update package applies are 
updated.

Note: Updates to CMMs and Flex System switches are always activated immediately, 
even if you select delayed activation. 
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When you choose to update the firmware for a managed endpoint, the following process 
occurs:

1. XClarity Administrator sends the firmware updates (for example, for the IMM, UEFI, and 
DSA) to the endpoint.

2. When the endpoint is restarted, the firmware updates are activated on the endpoint.

3. For servers, XClarity Administrator sends updates for optional devices, such as network 
adapter and hard disk drive updates. XClarity Administrator applies these updates and the 
server is restarted.

4. When you restart the endpoint or choose immediate activation, the updates for the 
optional devices are activated.

9.5.4  Monitoring update process status

You can view the status of the update process from the following sources:

� From the Apply/Activate page

In the server list on the Apply/Activate page, expand the details for the updated system 
and scroll to the right until you see the columns Compliance Target and Update Status, as 
shown in Figure 9-25.

Figure 9-25   Compliance Target and Update Status

The Compliance Target shows the actual package that is deployed. The Update Status 
lists the overall progress and the status of the individual update package.

� View the status from the Job log

You can monitor the status of the update process from the Jobs log. From the XClarity 
Administrator menu, click Monitoring → Jobs.

From any XClarity Administrator window, you can also go to the Jobs menu and hover 
over the job to see its status, as shown in Figure 9-26 on page 226.
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Figure 9-26   Job status from the Jobs menu

If you click the individual job, you see the details for this job and each step that is 
performed, as shown in Figure 9-27.

Figure 9-27   Individual job log

For more information about monitoring jobs, see 7.6, “Monitoring jobs” on page 190.

When monitoring the process of the firmware update on a server, you notice that at first the 
updates for the IMMv2, UEFI, and DSA are applied. This update is being done through the 
IMMv2. Then, the server is put into maintenance mode where the remaining updates follow 
as bare-metal updates. These updates are done via Preboot DSA (pDSA), which is controlled 
by the IMMv2.

When a Remote Control session is opened via the IMMv2, you see that an embedded Linux 
was started during that process, as shown in Figure 9-28 on page 227. However, you do not 
see the actual update process there.
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Figure 9-28   Embedded Linux for applying firmware updates

Instead, you can view the status of the firmware update directly from the Apply/Activate page 
in the Status column, as shown in Figure 9-29.

Figure 9-29   Update Status from the Apply/Activate page

When the firmware-update jobs are complete, you can verify that the endpoints are compliant 
by clicking Provisioning → Apply/Activate to return to the Firmware Updates: 
Apply/Activate page. Then, click the Refresh icon . The current firmware version that is 
active on each endpoint is listed in the Installed Version column.

If updates were not completed successfully, see the “Firmware Update and Repository 
Issues” section of the XClarity Administrator online documentation for troubleshooting and 
corrective actions:

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.lenovo.lxca.doc/sy
m_firmware_update_and_repository_issues.html 
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Chapter 10. Bare metal deployment

Lenovo XClarity Administrator include a function for bare metal operating system (OS) 
deployment -- the capability to deploy a supported operating system (remote unattended) to a 
server (bare metal). The server could be a pristine machine (one that do not have any 
operating system on it) or an existing machine with OS (it will be overwritten). In another 
word: a bare metal OS provisioning tool for mass deploying to Flex System nodes and 
rack/tower servers. 

It has the following features:

� No PXE server or DHCP server needed
� Secure deployment (uses TLS 1.2)
� Can deploy up to 28 endpoints concurrently
� Support for VMware ESXi, Red Hat Enterprise Linux and Windows Server 2012

Topics in this chapter are:

� 10.1, “Considerations” on page 230
� 10.2, “Supported operating systems” on page 230
� 10.3, “Importing operating system images” on page 232
� 10.4, “Configuration before deployment” on page 238
� 10.5, “Deploying an OS image” on page 243
� 10.6, “Common issues” on page 251
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10.1  Considerations

Several factors determine the amount of time that is required to actually deploy an operating 
system to a server:

� The amount of RAM that is installed in the server, which affects how long the server takes 
to start up.

� The number and types of I/O adapters that are installed on the server, which affects the 
amount of time that it takes XClarity Administrator to perform an inventory of the server. It 
also affects the amount of time that it takes for the UEFI firmware to start when the server 
is started up. During an OS deployment, the server is restarted multiple times.

� Network traffic. XClarity Administrator downloads the OS image over the data network or 
the OS deployment network.

� The hardware configuration on the host on which XClarity Administrator virtual appliance 
is installed. The amount of RAM, processors, and hard drive storage can affect download 
times.

To deploy an OS image from XClarity Administrator, at least one of the XClarity Administrator 
interfaces (Eth0 or Eth1) must have IP network connectivity to the server network interface 
that is used to access the host operating system, and must be configured with an IPv4 
address. OS deployment uses the interface that is defined on the Network Access page. 

Before performing any OS deployment on a server, it is always a good practice to ensure that 
the server firmware has been updated to the latest that is available. For more information, see 
Updating firmware on managed endpoints 9.2, “Updating firmware on managed endpoints” 
on page 209 

The following figure illustrates the workflow for deploying an OS image to a server.

Figure 10-1   OS deployment workflow

10.2  Supported operating systems

XClarity Administrator supports the deployment of several operating systems. Only supported 
versions of the operating systems can be loaded into the XClarity Administrator OS images 
repository.
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Some OS installers do not meet NIST 800-131A requirements. If XClarity Administrator is 
configured for NIST 800-131A mode and if the option to allow an exception for OS 
deployment is not selected, some operating systems will not be available for deployment in 
the XClarity Administrator web interface. See Figure 10-2.

Figure 10-2   OS deployment exception in NIST SP 800 131A mode

The ability to load an OS image into the OS images repository does not mean that the OS 
image is supported on all servers. Before attempting to deploy an OS image to a server, verify 
that the operating system is compatible with a specific server by checking ServerProven:

� For Flex System

http://www.lenovo.com/us/en/serverproven/nos/flexmatrix.shtml 

� For System x Server

http://www.lenovo.com/us/en/serverproven/nos/matrix.shtml 

The following is a lists the 64-bit operating systems that can be deployed by XClarity 
Administrator:

� Red Hat Enterprise Linux (RHEL) Server (includes KVM)

– Versions 6.2, 6.3, 6.4, 6.5, 6.6, 7.0, 7.1

� VMware vSphere Hypervisor (ESXi) with Lenovo Customization

– Versions 5.1, 5.1 u1-u3, 5.5, 5.5 u1-u2, 6.0

� Microsoft Windows (retail and volume license)

– 2012, 2012 R2

As the support for each operating system changes with time, please refer to the XClarity 
Administrator information center for the latest supported OS at:

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.lenovo.lxca.doc/su
pported_operating_system_images.html 
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10.3  Importing operating system images

Before you can deploy operating system to managed servers, you must import the image into 
the XClarity Administrator OS image repository. XClarity Administrator is preloaded with 
VMware vSphere Hypervisor (ESXi) with Lenovo customization, version 5.5.

The OS images repository can store up to the maximum of five images (including the 
preloaded ESXi v5.5). You may need to delete some OS image before importing another if 
you reach the limit of five images in XClarity Administrator.

You can import only one image at a time. Wait until the image is displayed in the image 
repository before attempting to import another image. Importing the operating system might 
take a while. XClarity Administrator only checks the OS image after it has been imported. If 
the imported image is not of a supported OS image, you will get an error message, as shown 
in Figure 10-3.

Figure 10-3   Error message for importing a non supported OS

Some of the operating system image will take some time to be imported, so it is wise to check 
the supported list before attempting the import.

Complete the following steps to import an operating system image into the OS image 
repository.

1. Obtain a licensed ISO image of the operating system. You are responsible for obtaining 
the applicable licenses for the operating system.

2. From the XClarity Administrator menu bar, click Provisioning → Manage OS images to 
display the Deploy Operating Systems: Manage OS images page.

3. Click the Import image icon  to display the Import OS Image dialog. As shown in 
Figure 10-4.

Figure 10-4   Import OS image
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4. Click Browse to find the ISO image that you want to import. 

5. Optional: Select a checksum type to verify that the ISO image being imported into XClarity 
Administrator is not corrupt, and copy and paste the checksum file contents in the 
provided text field.

Figure 10-5   Select your OS image file

If you select a checksum type, a checksum value is needed to check the integrity and 
security of the uploaded OS image. The value must come from a secure source of an 
organization that you trust. If the uploaded image matches with the checksum value, it is 
safe to proceed with deployment. Otherwise, you must upload the image again or double 
check the checksum value.

6. Click Import. Figure 10-6

Note: If you close the web browser tab or window in which the OS image is being 
uploaded before the upload completes, the import will fail.

Figure 10-6   Importing OS Image

The window is using a Javascript widget to transfer the bytes from the local PC to the 
server. If you close the window, it can't finish it's execution since it is running in the context 
of the browser session.

ISO image is uploaded over a secure network connection. Therefore, network reliability and 
performance affects how long it takes to import the image. After the image has been 
imported, you can revisit Provisioning → Manage OS images to display the Deploy 
Operating Systems: Manage OS images page. An example is shown in Figure 10-7 on 
page 234
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Figure 10-7   Imported OS image

10.3.1  Operating system image profiles

When you import an operating system image (Linux and Windows), XClarity Administrator 
creates multiple profiles of that image and store the profiles in the image repository. The 
profiles include both the operating system image and the installation options for that image.

For example, when you import a version of Red Hat Enterprise Linux, XClarity Administrator 
creates three different operating system profiles in the image repository: Basic, Minimal, and 
Virtualization, as shown in Figure 10-8.

Figure 10-8   RHEL OS image profiles

Table 10-1 on page 235 shows the packages that are included for each profile that is created 
when an operating system image is imported.
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Table 10-1   OS images profiles

Operating System Profile Included in the profile

Red Hat Enterprise 
Linux (RHEL)

Note: Includes KVM

Basic @X Window System
@Desktop
@Fonts
compat-libstdc++-33
compat-libstdc++-33.i686
compat-libstdc++-296
libstdc++.i686
pam.i686

Minimal compat-libstdc++-33
compat-libstdc++-33.i686
compat-libstdc++-296
libstdc++.i686
pam.i686

Virtualization %packages
@virtualization
@virtualization-client
@virtualization-platform
@virtualization-tools
# begin additional packages
@basic-desktop
@desktop-debugging
@desktop-platform
@fonts
@general-desktop
@graphical-admin-tools
@kde-desktop
@remote-desktop-clients
@x11
# end additional packages

libconfig
libsysfs
libicu
lm_sensors-libs
net-snmp
net-snmp-libs
redhat-lsb
compat-libstdc++-33
compat-libstdc++-296
# begin additional rpms
xterm
xorg-x11-xdm
rdesktop
tigervnc-server
device-mapper-multipath
# end additional rpms

VMware vSphere 
Hypervisor (ESXi) 
with Lenovo 
customization

Virtualization Lenovo offers versions of VMware vSphere Hypervisor (ESXi) that are 
customized for select hardware to give you online platform 
management, including updating and configuring firmware, platform 
diagnostics, and enhanced hardware alerts. Lenovo management tools 
also support simplified management of ESXi. For more information 
about the customized image, see the x86 solutions for VMware website 
http://shop.lenovo.com/us/en/systems/software/

XClarity Administrator pre-loads the image provided by Lenovo.
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10.3.2  Port availability for deployed operating systems

Some ports are blocked by certain operating system profiles. The following tables list the 
ports that are open (not blocked).

RHEL Virtualization profile
By default, the Red Hat Enterprise Linux (RHEL) Virtualization profile blocks all ports except 
for those that are listed in Table 10-2.

Table 10-2   Ports availability for RHEL Virtualization profile.

Microsoft Windows 
2012

Note: Includes 
Hyper-V through the 
Virtualization Profile

Datacenter GUI

Datacenter 
virtualization

GUI
Hyper-V role

Datacenter 
virtualization core

Hyper-V role

Datacenter core

Standard GUI

Standard 
virtualization

GUI
Hyper-V role

Standard 
virtualization core

Hyper-V role

Standard core

Operating System Profile Included in the profile

Port TCP or UDP Direction Communication description

22 TCP Inbound SSH communication

53 TCP, UDP Outbound/Inbound Communication with RHEL KVM networking devices

67 TCP, UDP Outbound/Inbound Communication with RHEL KVM networking devices

161 UDP Outbound Communication with SNMP agents

162 UDP Inbound Communication with SNMP agents

427 TCP, UDP Outbound/Inbound Communication with SLP service agent, SLP directory agent

3001 TCP Outbound/Inbound Communication with management software 
image-deployment service

15988 TCP Outbound CIM-XML over HTTP communication

15989 TCP Outbound CIM-XML over HTTP communication

49152 - 49215 TCP Outbound/Inbound KVM Virtual Server communication
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RHEL Basic and Minimal profiles
By default, the RHEL Basic and Minimal profiles block all ports except for those that are listed 
in Table 10-3.

Table 10-3   RHEL Basic and Minimal profiles.

VMware ESXi Virtualization profile
For a complete list of open ports for VMware vSphere Hypervisor (ESXi) with Lenovo 
customization, see the VMware Knowledge Base article 1012382:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC
&externalId=1012382 

Windows profiles
The ports listed in Table 10-4 must be available for Windows profiles.

Table 10-4   Port availability for the Windows profiles

Port TCP or UDP Direction Communication description

22 TCP Inbound SSH communication

3001 TCP Outbound and Inbound Management software image-deployment 
service communication

Port TCP or UDP Communication description

137 UDP NetBIOS Name Service

138 UDP NetBIOS Datagram

139 TCP NetBIOS Session

445 TCP SMB over TCP
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10.4  Configuration before deployment

You will need to perform some basic configuration steps before you can begin to deploy the 
OS that you have imported. XClarity Administrator will display the server as in Not Ready 
state. You cannot perform OS deployment when the server are in “Not ready” state, as shown 
in Figure 10-9.

Figure 10-9   Server shown as Not Ready state

You can select the required server and configure it individually or you can use the global 
configuration setting. Global settings serve as defaults settings when operating systems are 
deployed.

From the Global Settings page, you can configure the following settings:

� The password for the administrator user account to be use for deploying the operating 
systems

� The method to use to assign IP addresses to servers

� License keys to use when activating the installed operating systems

� Optionally join an Active Directory domain as part of the Windows OS deployment

Complete the following steps to configure global settings to be used for all servers.

1. From the XClarity Administrator menu bar, click Provisioning → Deploy OS images to 
display the Deploy OS Images page.
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2. Click the Global Settings icon  to display the Global Settings: Deploy Operating 
Systems dialog. As shown in Figure 10-10

Figure 10-10   Global setting - Credentials page

3. On the Credentials tab, enter the password for the administrator account to log in to the 
operating system.

4. On the IP Assignment tab, determine how the IP address for the operating system is to 
be assigned to the server.

Figure 10-11   Global setting - IP Assignment
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– Assign a static IP address (IPv4). If you choose to assign static IP addresses, ensure 
that you configure the static IPv4 address, gateway address, and subnet mask for the 
server before deploying the operating system (see Configuring network settings for 
managed servers at Figure 4-47 on page 83).

– Use Dynamic Host Configuration Protocol (DHCP) for IP address assignments. If 
you already have an existing DHCPv4 infrastructure in your network, you can use that 
infrastructure to assign IP addresses to compute nodes.

5. Optional: On the License Keys tab, specify the global volume-license keys to use when 
activating the installed Windows operating systems.

Figure 10-12   Global setting - License key

XClarity Administrator supports global volume-license keys for Windows installations and 
individual retail-license keys for both Windows and VMware ESXi. You can specify 
individual retail-license keys as part of the deployment procedure (see Deploying an OS 
image at Figure 10-17 on page 245).

6. Optional: On the Active Directory tab, configure the Active Directory settings for Windows 
operating system deployments. For information about integrating with Active Directory, 
see Integrating with Windows Active Directory at “Integrating with Windows Active 
Directory” on page 249.

7. Click OK to close the dialog.

10.4.1  Configuring network settings for managed servers

Network settings are configuration options that are specific to each server. If you select to 
assign a static IP address in the IP Assignment tab, you must configure the network settings 
to be used for a server before you can deploy an operating system to that server.

Complete the following steps to configure network settings for one or more compute nodes:

1. From the XClarity Administrator menu bar, click Provisioning → Deploy OS images to 
display the Deploy Operating System: Deploy OS images page.
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2. Select one or more servers to configure. You can select up to 28 servers to be configured 
at one time.

3. Click Changed Selected → Network Settings to display the Edit Network Settings page.

4. Complete the fields in the table for each server.

As an alternative to filling in each row, you can update all rows in the table for some of the 
fields:

– Click Change All Rows → Host name to set the host names for all compute nodes, 
using either a predefined or a custom naming scheme.

– Click Change All Rows → IP address to assign a range of IP addresses, subnet 
mask and gateway. The IP address is assigned for each server, starting with the first IP 
address and ending with the last IP address that is displayed. The subnet mask and 
gateway IP address are applied to each server.

– Click Change All Rows → Domain Name System (DNS) to set the DNS servers to be 
used by the operating system for DNS lookup. If the DNS servers are defined by the 
network automatically, or if you do not want to define DNS servers, select None.

– Click Change All Rows → Maximum Transmission Unit (MTU) to set the MTU to be 
used on the configured Ethernet adapter on the deployed operating system.

5. Click OK to save the settings.

After the configuration, each of the configured server will have its Deploy Status shown as 
Ready.

10.4.2  Configuring storage settings for managed servers

Configure the preferred storage location where you want to deploy the operating system 
image for one or more server. This configuration setting is just to let XClarity Administrator 
know the preferred storage to use and if the storage is not available or compatible, it will 
attend to use the next storage option. 

The three storage option are: 

� Local hard disk storage
� Embedded Hypervisor (USB/SD) (when ESXi is selected)
� SAN storage

XClarity Administrator will automatically select the storage that are applicable to the OS 
deployment profile.

Complete the following steps to configure the priority order for the storage location for one or 
more managed servers:

1. From the XClarity Administrator menu bar, click Provisioning → Deploy OS images to 
display the Deploy OS Images page.

2. Select the servers for which you want to change the storage settings.
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3. Click XClarity Administrator menu bar, click Change Selected → Storage Location to 
change the priority order of storage locations for all selected servers.

Figure 10-13   Edit Storage Location

4. Change the priority order by clicking on the Up or Down green arrow.

5. Click OK when done.

You can set the priority for the following storage locations:

Use local hard disk storage
XClarity Administrator installs the operating system image on the first enumerated local disk 
in the managed server.

If the RAID configuration on the server is not configured correctly, or if it is inactive, the local 
disk might not be visible to XClarity Administrator. To resolve the issue, enable the RAID 
configuration through configuration patterns or through the RAID management software on 
the server.

Use Embedded Hypervisor (USB/SD) when ESXi is selected
This location is applicable only when a VMware ESXi image is being deployed to managed 
servers.

If two hypervisor keys are installed on the managed server, the VMware installer selects the 
first enumerated key for deployment.

Attempting to deploy Microsoft Windows to a managed server that has a hypervisor key 
installed might causes issues even if you do not select the embedded hypervisor key. If 
Windows deployment errors occur, remove the embedded hypervisor key from the managed 
server, and attempt to deploy Microsoft Windows to that server again.

Use SAN storage
When deploying to SAN storage:

� Ensure that the SAN boot target is configured on the managed servers. You can configure 
the SAN boot target using a server pattern (see Defining boot options). “Defining boot 
options” on page 279. Below is an example of a server that has been applied with a 
configuration pattern as shown in Figure 10-14 on page 243
242 Lenovo XClarity Administrator Planning and Implementation Guide



Figure 10-14   Example of Server with SAN Storage

� Ensure that the OS volume to which you are installing is the only volume that is visible to 
the operating system.

If you are deploying VMware ESXi:

� Local hard disks must be disabled or removed from the server. You can disable the local 
hard disks using server patterns (see Defining local storage) “Defining local storage” on 
page 271

� If multiple SAN volumes are available, only the first volume is used for deployment.

10.5  Deploying an OS image

You can use XClarity Administrator to deploy an OS image to up to 28 servers concurrently. 
Before any deployment, do the following check:

� Ensure that no jobs are currently running on the managed server. To see a list of active 
jobs, click Monitoring → Jobs.

� Ensure that the managed server does not have a deferred or partially-activated server 
pattern. If a server pattern has been deferred or partially activated on the managed server, 
you must restart the server to apply all configuration settings. Do not attempt to deploy an 
operating system to a server with a partially-activated server pattern.

� Ensure that XClarity Administrator is able to communicate with the managed server over 
the network interface that was selected when you configured the network settings, 
otherwise you will see an error similar to the one in Figure 10-15 on page 244. 

To specify an interface to be used for deploying operating settings, see Configuring 
network settings for managed servers, Figure 4-47 on page 83.
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Figure 10-15   Error if no network configuration

Most of the common issues associated with the OS deployment is with network 
connectivity. XClarity Administrator packaged the ISO based on the OS image profile you 
selected and mount it to the managed server via IMM remote media using eth0. It then 
changes the managed server’s UEFI boot order and reboot the server. Once the server is 
booted, it then uses the data network (eth1 or eth0 if you selected combine network 
setting) to go through the OS installation process.

� If the OS deployment endpoint is a rack or tower System x server, its IMM will need to 
have the IMM Advanced Upgrade FoD key installed. XClarity Administrator will need to 
mount the packaged ISO onto the server via the IMM remote presence capability.

� Ensure that a password for the administrator user ID that is to be used to install the 
operating system is specified on the Global Settings: Deploy Operating Systems dialog. 
For more information about setting the password, see Configuring global deployment 
settings.

� Ensure that the UEFI boot option on the server is set to “UEFI boot only” or to “UEFI first, 
then legacy” before you deploy an operating system. The legacy-only boot option is not 
supported.

Complete the following steps to deploy an OS image to one or more managed servers.

1. From the XClarity Administrator menu bar, click Provisioning → Deploy OS images to 
display the Deploy Operating System: Deploy OS images page.
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2. For each server on which you intended to deploy the operating system, select the 
operating system to be deployed, in the Image to Deploy column.

Figure 10-16   Select Image to Deploy

3. For each server on which you intend to deploy the operating system, you can install with a 
different license. Click the License Key icon to specify a different license key than those 
specified in the Global deployment setting.

XClarity Administrator supports a global volume license key for Windows installations and 
individual retail keys for both Windows and VMware ESXi. 

To use an individual retail license key, select Use the following retail license key, and 
enter the key in the following field.

Figure 10-17   Enter retail license key

4. Optional: If you selected a Windows operating system for any server, you can join the 
Windows operating system to an Active Directory domain as part of the operating system 
deployment by click the Folder icon that appears next to the OS image, and then selecting 
the Active Directory name.

For more information about joining an Active Directory domain, see “Integrating with 
Windows Active Directory” on page 249.
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5. Select one or more servers to which the operating system is to be deployed. You can 
deploy an operating system on up to 28 servers at one time.

You can choose multiple compute nodes from multiple chassis if you intend to deploy the 
same operating system to all compute nodes.

Configuration for the server will only be enabled once they are selected. Changes can be 
made are: Image to deploy, license key (Windows & ESXi) AD Domain (Windows only), 
Storage and Network settings.

6. Click Changed Selected → Network Settings to configure network settings. 

Figure 10-18   Edit network settings

The field are as follows:

– The Host name defaults to the word “node” + the first 11 digits of the system UUID. 

– The MAC address of the port on the host where the operating system is to be installed

Note: Most servers have multiple Ethernet adapters/ports, so make sure you select the 
MAC address of the Ethernet port that is connected to the data network. XClarity 
Administrator will need to be able to communicate with the deployed system via this 
network interface. For more information network setup, please refer to 2.4, “Network 
considerations” on page 22.

– The IP address, subnet mask and gateway

Note: Only if you select Assignment Static IP address (IPv4) in global setting page. 
See Figure 10-11 on page 239

– Up to two Domain Name Services (DNS) servers

– The Maximum Transmission Unit (MTU) speed

7. For each server, select the preferred storage location where you want to deploy the 
operating system image from the Storage column. The selection are Local Disk, 
Embedded Hypervisor and SAN Storage.

Not all storage option are available. It will depend the OS image profile you selected and 
the actual storage that is available to the server. For example, if you do not have any SAN 
storage configured, then SAN storage will not be in the selection list. See “Deploying ESXi 
to SAN storage” on page 249 for information.

Tip: Ensure that the deployment status for the server is shown as Ready. You cannot 
deploy an operating system to a server that is in the Not Ready state.
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8. Verify that the deployment status for all selected server is Ready.

If the status of a server is Not Ready, you cannot deploy an OS image to that server. Click 
on the Not Ready link to get information to help resolve the problem. As shown in 
Figure 10-19 If the network settings are not valid, click Edit under Network settings to 
configure the network settings.

Figure 10-19   Net settings not valid

9. Click the Deploy Images icon  to initiate the OS deployment.

If the server currently has an operating system installed, you are warned that deploying 
the image will overwrite the current operating system.

The deploy Status column will show the status of the OS deployment as shown in 
Figure 10-20.

Figure 10-20   Status change

You can monitor the status of the deployment process from the jobs log. From the XClarity 
Administrator menu, click Monitoring → Jobs. Example of the deployment job log view, 
Figure 10-21.

Figure 10-21   View Log

Note: You can also set up a remote-control session through the IMM interface for the 
server to watch the installation as it progresses. As shown in Figure 10-22 on page 248 
and Figure 10-23 on page 248. For more information about starting remote control, see 
Chapter 8, “Remote Control utility” on page 193.
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Figure 10-22   Remote Session of the deployment progress

Figure 10-23   Windows OS deployment

Once the OS is deployed, login using the credential you have specified in the global setting 
Credentials page.
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10.5.1  Deploying ESXi to SAN storage

When you deploy an operating system to a SAN, the operating system is deployed to the first 
SAN boot target that is configured through a server pattern. In addition, a local hard drive 
cannot be enabled in the server that will be booting from SAN. It must be disabled or removed 
if a hard drive is present.

We can create the SAN storage via a Configuration Pattern. The end result is to have a LUN 
mapped to the server.

Please refer to the XClarity Administrator information center page for example of setting up 
OS deployment to SAN Storage.

http://pic.dhe.ibm.com/infocenter/flexsys/information/index.jsp?topic=%2Fcom.lenov
o.lxca.doc%2Fscenarios.html 

10.5.2  Integrating with Windows Active Directory

When you deploy a Windows image using XClarity Administrator, you have the ability to join 
an Active Directory domain as part of the OS deployment.

To join an Active Directory domain as part of a Windows image deployment you must 
configure both the management server and the Windows Server that is running the affected 
Active Directory domain controller. To perform this configuration, you need the following 
access:

� An administrative user account with the authority to authenticate and join the Active 
Directory server’s domain. This account must have privileges similar to those of the 
default Domain Administrators group, and you can use an account in this group for this 
configuration.

� Access to a Domain Name Server (DNS) that resolves to the Active Directory server that 
is running the domain controller. This DNS must be specified in the Network Settings → 
DNS option for the server to which you are deploying the operating system.

� The Active Directory server administrator must create the required computer name on the 
domain server before you deploy the operating system. The join attempt does not create a 
new computer name. If no name is specified the join will fail.

� The Active Directory server administrator should specify the host name of the server to 
which the image is being deployed as a computer name under the target organizational 
unit by clicking the Network Settings → Host name field.

� The specified computer name must be unique. Specifying a name that is already in use by 
another Windows installation will cause the join the fail

OS deployment supports joining a domain and creating nested organizational units within a 
domain. If you are specifying organizational units, it is not necessary to explicitly specify the 
OU as part of the join. Active Directory is able to derive the correct OU using the domain 
name and computer name.

Complete the following steps to create the Active Director domain in XClarity Administrator:

1. From the XClarity Administrator menu bar, click Provisioning → Deploy OS images to 
display the Deploy OS Images page.

2. Click the Global Settings icon  to display the Global Settings: Deploy Operating 
Systems dialog
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3. From the Global Settings: Deploy Operating Systems dialog, click the Active Directory 
tab.

Figure 10-24   Global setting - Active Director Tab

4. Click the Create icon  and enter a domain name and, optionally, an organizational unit, 
and then click Add to create a library of available domain names, as shown in 
Figure 10-25.

If you intend to use multiple domains, you can specify them all now by repeating the step 
for each domain name. You will specify which domain to use for a deployment in a later 
step.

Figure 10-25   Create AD domain
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From the Apply this domain as default selection drop-down menu, select the domain to 
be used by default for every Windows deployment. If you do not choose this option, you 
can choose domains individually for each deployment.

Figure 10-26   Change AD default

When the operating system deployment is complete, open a web browser to the IP 
address that you specified on the Edit Network Settings page, and log on continue with the 
configuration process.

10.6  Common issues

For the list of common issues regarding OS deployment, please refer to XClarity 
Administrator Information Center at:

http://pic.dhe.ibm.com/infocenter/flexsys/information/index.jsp?topic=%2Fcom.lenov
o.lxca.doc%2Fos_deployment_issues.html 
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Chapter 11. Configuration patterns

In this chapter, we describe Lenovo XClarity Administrator server configuration patterns, 
which are used to quickly provision or pre-provision multiple servers from a single pattern. 

This chapter includes the following topics:

� 11.1, “Overview” on page 254
� 11.2, “Configuration considerations” on page 254
� 11.3, “Pre-defined category patterns” on page 255
� 11.4, “Address pools” on page 255
� 11.5, “Server configuration patterns” on page 270
� 11.6, “Creating a Server Pattern” on page 303
� 11.7, “Server profiles” on page 320
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11.1  Overview

Lenovo XClarity Administrator server configuration patterns are used to quickly provision or 
pre-provision multiple servers (rack/tower servers and compute nodes) from a single set of 
defined configuration settings. You can use server patterns in XClarity Administrator to 
configure the following components:

� Local storage

� I/O adapters

� Boot order and other Integrated Management Module (IMM) and Unified Extensible 
Firmware Interface (UEFI) settings on managed servers. 

� Server patterns also integrate support for virtualizing I/O addresses, so you can virtualize 
server fabric connections or repurpose servers without disruption to the fabric. 

� You can also start SAN-zoning change requests in advance of receiving new hardware by 
virtualizing Fibre Channel addresses.

Figure 11-1 shows the workflow for configuring managed servers and the high-level objects 
and workflow for the use of Configuration Patterns. The solid arrows indicate actions that are 
taken by you. The dashed arrows indicate actions that are performed automatically by 
XClarity Administrator. 

Figure 11-1   High-level objects and workflow for configuration patterns

11.2  Configuration considerations

Before you begin configuring servers through XClarity Administrator, review the following 
important considerations:

� If transitioning from IBM Fabric Manager to XClarity Administrator: At the time of this 
writing, the recommended option to assist with the transition from IBM Fabric Manager to 
XClarity Administrator is to use the assistance of Lenovo Enterprise Solution Services. 
Contact email addresses are listed in Table 11-1.

Table 11-1   Contact details for Lenovo Enterprise Solution Services

Region Contact email address

Asia Pacific (GCG, ANZ, ASEAN, Japan, Korea, ISA) x86svcAP@lenovo.com

North America (US, Canada) x86svcs@lenovo.com

Latin America (Brazil, Mexico, SSA) x86svcLA@lenovo.com

Europe, Middle East, Africa x86svcEP@lenovo.com
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� For scalable systems (Flex System x480 X6 and x880 Compute Nodes and System x3950 
X6 servers), you must set up automatic or custom partitioning by using the IMM before a 
server pattern is deployed to the partition.

� For Flex System x222 Compute Nodes, configuration patterns do not support the software 
RAID controller feature; therefore, you cannot define RAID volumes for these servers.

At the time of this writing, the following capabilities are not available: 

� Chassis patterns are not possible with XClarity Administrator.

� Compute node failover is not available; there is a manual failover capability available via 
activate and deactivate.

� Address virtualization is not supported on Lenovo Racks Servers. This limitation is an 
architectural limitation because the firmware enablement is not yet propagated to the rack 
option cards.

11.3  Pre-defined category patterns

XClarity Administrator includes the following predefined configuration patterns to assist the 
user:

� Virtual Fabric Balanced Ethernet: Lenovo supplied Port pattern for Virtual Fabric mode 
vNIC™ mode; Ethernet only

� M5 High Performance: High-performance UEFI pattern for M5 Systems (x240 M5, 
x3550/x3650 M5)

� M5 Low Latency: Low-latency UEFI pattern for M5 system (x240 M5, x3550/x3650 M5)

� M5 Virtualization: Virtualization UEFI pattern for M5 systems (x240 M5, x3550/x3650 M5)

� x240 High Performance: High-performance UEFI pattern for x240 compute nodes

� x240 Low Latency: Low-latency UEFI pattern for x240 compute nodes 

� x240 Standard Workload: Standard workload UEFI pattern for x240 compute nodes 

� x240 Transactional Workload: Transactional workload UEFI pattern for x240 compute 
nodes

� x240 Virtualization: Virtualization UEFI pattern for x240 compute nodes

� X6 High Performance: High-performance UEFI pattern for X6 architecture-based system 
(x280, x480, x880, and x3850 X6/x3950 X6)

� X6 Low Latency: Low-latency UEFI pattern for X6 architecture-based system (x280, x480, 
x880, and x3850 X6/x3950 X6)

� X6 Virtualization: Virtualization UEFI pattern for X6 architecture-based system (x280, 
x480, x880, and x3850 X6/x3950 X6)

11.4  Address pools

XClarity Administrator uses address pools to assign IP and I/O addresses to individual 
servers when the server patterns are deployed to those servers. An address pool is a defined 
set of address ranges. XClarity Administrator supports IP and I/O address pools.

This section includes the following topics:

� 11.4.1, “IP address pools”
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� 11.4.2, “Ethernet address pools” on page 261
� 11.4.3, “Fibre Channel address pools” on page 264

11.4.1  IP address pools

IP address pools define ranges of IP addresses for use when the IMM network interface of 
your servers is configured.

You can use or customize predefined address pools or you can create pools as needed. 
When server patterns are created, you can choose which IP address pool to use during 
deployment. When the server pattern is deployed, IP addresses are allocated from the 
selected pool and assigned to individual servers IMMs. However, if you are satisfied with your 
IMM network configuration, do not use this option.

The overall address pool range is derived from the specified routing prefix length and the 
gateway or initial range; that is, the pool and ranges feature XClarity Administrator scope.

Although you can create pools of different sizes that are based on the specific routing prefix 
length, overall pool ranges must be unique within the XClarity Administrator domain; that is, in 
multiple XClarity Administrator environments, create unique pools and ranges for each 
XClarity Administrator to avoid address conflicts and to avoid address conflicts with IP 
management tools. Ranges are then created from the overall pool range.

Address ranges can be used to separate hosts; for example, by operating system type, 
workload types, and business type. Address ranges can also be tied to organizational 
network rules.

Defining an IP address pool: Consider the following points when an IP address pool is 
defined:

� Ensure that you select an IP address subrange that does not conflict with any I/O 
addresses in your data center.

� Ensure that the IP addresses in the specified ranges are part of the same subnetwork 
and are reachable by XClarity Administrator.

� Ensure that the IP addresses in the specified ranges are unique for each XClarity 
Administrator domain and IP management tools to prevent address conflicts.
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Creating an IP address pool
Complete the following steps to create an IP address pool:

1. From the XClarity Administrator menu bar, click Provisioning → Address Pools as 
shown in Figure 11-2.

Figure 11-2   Locate Address Pools

The Configuration Patterns: Address Pools page opens, as shown in Figure 11-3.

Figure 11-3   Configuration Patterns: Address Pools window
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2. Click the IP Address Pools tab. If it is not selected, click the Create icon . The New IP 
Address Pools Wizard view is displayed, as shown in Figure 11-4.

Figure 11-4   New IP Address Pool window

3. Enter the following required information:

– Name and description for the address pool
– Choose to use IPv4 or IPv6 addresses
– Select a subnet mask (for IPv4) or a routing prefix length (for IPv6)
– Specify the gateway address

The network information values are derived from the specified subnet mask and 
gateway or initial range and are completed the table and appear automatically when 
you select Subnet Mask and enter the Gateway address, as shown in Figure 11-5.

Figure 11-5   Network information values

4. Add one or more ranges of addresses. Click Add Range  to add a range of 
addresses. The Add IP Address Range dialog is displayed, as shown in Figure 11-6.
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Enter a range name, first address, and range size, as shown in Figure 11-6. The last 
address is calculated automatically when you enter the Range Size.

Figure 11-6   Add IP Address Range

5. Click OK, which saves and closes the Add IP Address Range view. You are returned to the 
New IP Address Pool view, as shown in Figure 11-7 on page 259. The IP Address range is 
now shown.

Figure 11-7   IP address pool information

You can edit the range by clicking the Edit icon  or remove the range by clicking the 
Remove icon .
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6. Click Create to save and create the IP Address Pool. The new IP address pool now is 
listed in the table on the IP Address Pools page, as shown in Figure 11-8.

Figure 11-8   IP Address Pools view

From this page, you can perform the following actions on a selected address pool:

– Modify the address pool by selecting a pool and then clicking the Edit icon  
– Rename the address pool by selecting a pool and clicking the Rename icon  
– Delete the address pool by selecting a pool and clicking the Delete icon  

Alternatively, you can select a pool and then click All Actions to view all the actions that 
can be performed on the IP Address Pools, as shown in Figure 11-9.

Figure 11-9   All Actions available for IP Address Pools

You can view details about the address pool by clicking the pool name in the Pool Name 
column and the details view opens, as shown in Figure 11-10. 
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Figure 11-10   IP Address Pool details

11.4.2  Ethernet address pools

Ethernet address pools are collections of unique Media Access Control (MAC) addresses that 
can be assigned to network adapters when the servers are configured. You can use or 
customize the XClarity Administrator predefined address pools as needed, or you can create 
pools. When creating server patterns, you can choose which Ethernet address pool is to be 
used during deployment. When the serve pattern is deployed, addresses are allocated from 
the selected pool and assigned to individual adapter ports.

The predefined Lenovo MAC address pool is available.

Ethernet address pools
Ethernet address pools are collections of unique media access control (MAC) addresses that 
can be assigned to network adapters. You can use these predefined address pools that are 
listed in Table 11-2 in your server patterns. You can use or customize predefined address 
pools as needed, or you can create address pools. For more information, see “Creating an 
Ethernet address pool” on page 262.

Table 11-2   Lenovo MAC Address pool

Predefined range Starting address Ending address

Range 1 00:1A:64:76:00:00 00:1A:64:76:1C:70

Range 2 00:1A:64:76:1C:71 00:1A:64:76:38:E1

Range 3 00:1A:64:76:38:E2 00:1A:64:76:55:52

Range 4 00:1A:64:76:55:53 00:1A:64:76:71:C3

Range 5 00:1A:64:76:71:C4 00:1A:64:76:8E:34

Range 6 00:1A:64:76:8E:35 00:1A:64:76:AA:A5

Range 7 00:1A:64:76:AA:A6 00:1A:64:76:C7:16

Range 8 00:1A:64:76:C7:17 00:1A:64:76:E3:87

Range 9 00:1A:64:76:E3:88 00:1A:64:76:FF:F8
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When you create a server pattern, you can choose which Ethernet address pool is to be used 
when the pattern is deployed if you enable virtual addressing for Ethernet adapters. When the 
associated server pattern is deployed, MAC addresses are allocated from the selected 
address pool and assigned to individual network adapters in the servers.

Creating an Ethernet address pool 
Complete the following steps to create an Ethernet address pool:

1. From the XClarity Administrator menu bar, click Provisioning → Address Pools, as 
shown in Figure 11-11.

Figure 11-11   Selecting Address Pools

The Configuration Patterns: Address Pools page is displayed, as shown in Figure 11-12.

2. Click the Ethernet Address Pools tab, as shown in Figure 11-12.

Potential risk of duplicated virtual addresses when sever profiles are used: When a 
server profile is deactivated, you can select the Power off the ITE option. If you selected 
this option, the Virtual Addressing is removed from the server. However, if this option is not 
selected, the server does not power off and the Virtual Addressing is not removed and you 
might encounter a situation in which two nodes have the same virtual addressing if this 
server profile is activated on another node. Therefore, ensure that you Power Off/ Power 
Cycle the Server.

For more information about Server Profiles, see 11.7, “Server profiles” on page 320.
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Figure 11-12   Ethernet Address Pools tab

3. Click the Create icon . The New Ethernet (MAC) Address Pools dialog is displayed, as 
shown in Figure 11-13.

Figure 11-13   Ethernet MAC address pool

4. Enter a name and an appropriate description for the address pool.

5. Add one or more ranges of addresses. To add a range of addresses, click Add Range, as 
highlighted in Figure 11-13.
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6. The Ethernet (MAC) Address Range dialog is displayed, as shown in Figure 11-14.

Figure 11-14   Ethernet MAC Address Ranges

7. Enter a range name, first MAC address, and range size. The last MAC address is 
calculated automatically.

8. Click Add.

The range is then added to the Defined Ethernet (MAC) Pool Address Ranges table, and 
the fields in the summary section are updated automatically.

You can edit the range by clicking the Edit icon  or remove the range by clicking the 
Remove icon .

9. Click Save. The new Ethernet address pool is now listed in the Ethernet Address Pools 
table.

11.4.3  Fibre Channel address pools

Fibre Channel address pools are collections of unique worldwide node name (WWNN) and 
worldwide port name (WWPN) addresses that can be assigned to Fibre Channel adapters 
when servers are configured. 

You can use or customize the XClarity Administrator predefined address pools as needed or 
you can create Fibre Channel Address pools. 

When creating server patterns, you can choose which Fibre Channel address pool is to be 
used during deployment. When the server pattern is deployed, addresses are allocated from 
the selected pool and assigned to individual adapter ports.

For more information about worldwide name (WWN) address ranges in this pool, see 11.4.3, 
“Fibre Channel address pools” on page 264.

Potential risk of duplicated virtual addresses when Sever Profiles are used: When a 
server profile is deactivated, you can select the Power off the ITE option. If you select this 
option, the Virtual Addressing is removed from the server. However, if this option is not 
selected, the server does not power off and the Virtual Addressing is not removed. You 
might encounter the situation in which two nodes might have the same virtual addressing if 
this server profile is activated on another node. Therefore, ensure that you Power Off/ 
Power Cycle the Server.

For more information about Server Profiles, see 11.7, “Server profiles” on page 320.
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Fibre Channel address pools
Table 11-3 lists the Brocade WWN address pools. Each Brocade range contains 1,864,135 
addresses.You can use these predefined address pools in your server patterns.

Table 11-3   Brocade WWN address pools

Table 11-4 lists the Emulex WWN address pools. Each Emulex range contains 1,864,135 
addresses.

Table 11-4   .Emulex WWN address pools

Predefined
range 

WWNN starting 
address 

WWNN ending 
address 

WWPN starting 
address 

WWPN ending 
address

Fabric A

Range 1 2B:FA:00:05:1E:00:00:00 2B:FA:00:05:1E:1C:71:C6 2B:FC:00:05:1E:00:00:00 2B:FC:00:05:1E:1C:71:C6

Range 2 2B:FA:00:05:1E:1C:71:C7 2B:FA:00:05:1E:38:E3:8D 2B:FC:00:05:1E:1C:71:C7 2B:FC:00:05:1E:38:E3:8D

Range 3 2B:FA:00:05:1E:38:E3:8E 2B:FA:00:05:1E:55:55:54 2B:FC:00:05:1E:38:E3:8E 2B:FC:00:05:1E:55:55:54

Range 4 2B:FA:00:05:1E:55:55:55 2B:FA:00:05:1E:71:C7:1B 2B:FC:00:05:1E:55:55:55 2B:FC:00:05:1E:71:C7:1B

Range 5 2B:FA:00:05:1E:71:C7:1C 2B:FA:00:05:1E:8E:38:E2 2B:FC:00:05:1E:71:C7:1C 2B:FC:00:05:1E:8E:38:E2

Range 6 2B:FA:00:05:1E:8E:38:E3 2B:FA:00:05:1E:AA:AA:A9 2B:FC:00:05:1E:8E:38:E3 2B:FC:00:05:1E:AA:AA:A9

Range 7 2B:FA:00:05:1E:AA:AA:AA 2B:FA:00:05:1E:C7:1C:70 2B:FC:00:05:1E:AA:AA:AA 2B:FC:00:05:1E:C7:1C:70

Range 8 2B:FA:00:05:1E:C7:1C:71 2B:FA:00:05:1E:E3:8E:37 2B:FC:00:05:1E:C7:1C:71 2B:FC:00:05:1E:E3:8E:37

Range 9 2B:FA:00:05:1E:E3:8E:38 2B:FA:00:05:1E:FF:FF:FE 2B:FC:00:05:1E:E3:8E:38 2B:FC:00:05:1E:FF:FF:FE

Fabric B

Range 1 2B:FB:00:05:1E:00:00:00 2B:FB:00:05:1E:1C:71:C6 2B:FD:00:05:1E:00:00:00 2B:FD:00:05:1E:1C:71:C6

Range 2 2B:FB:00:05:1E:1C:71:C7 2B:FB:00:05:1E:38:E3:8D 2B:FD:00:05:1E:1C:71:C7 2B:FD:00:05:1E:38:E3:8D

Range 3 2B:FB:00:05:1E:38:E3:8E 2B:FB:00:05:1E:55:55:54 2B:FD:00:05:1E:38:E3:8E 2B:FD:00:05:1E:55:55:54

Range 4 2B:FB:00:05:1E:55:55:55 2B:FB:00:05:1E:71:C7:1B 2B:FD:00:05:1E:55:55:55 2B:FD:00:05:1E:71:C7:1B

Range 5 2B:FB:00:05:1E:71:C7:1C 2B:FB:00:05:1E:8E:38:E2 2B:FD:00:05:1E:71:C7:1C 2B:FD:00:05:1E:8E:38:E2

Range 6 2B:FB:00:05:1E:8E:38:E3 2B:FB:00:05:1E:AA:AA:A9 2B:FD:00:05:1E:8E:38:E3 2B:FD:00:05:1E:AA:AA:A9

Range 7 2B:FB:00:05:1E:AA:AA:AA 2B:FB:00:05:1E:C7:1C:70 2B:FD:00:05:1E:AA:AA:AA 2B:FD:00:05:1E:C7:1C:70

Range 8 2B:FB:00:05:1E:C7:1C:71 2B:FB:00:05:1E:E3:8E:37 2B:FD:00:05:1E:C7:1C:71 2B:FD:00:05:1E:E3:8E:37

Range 9 2B:FB:00:05:1E:E3:8E:38 2B:FB:00:05:1E:FF:FF:FE 2B:FD:00:05:1E:E3:8E:38 2B:FD:00:05:1E:FF:FF:FE

Redefined
range 

WWNN starting 
address 

WWNN ending 
address 

WWPN starting 
address 

WWPN ending 
address

Fabric A

Range 1 2F:FE:00:00:C9:00:00:00 2F:FE:00:00:C9:1C:71:C6 2F:FC:00:00:C9:00:00:00 2F:FC:00:00:C9:1C:71:C6

Range 2 2F:FE:00:00:C9:1C:71:C7 2F:FE:00:00:C9:38:E3:8D 2F:FC:00:00:C9:1C:71:C7 2F:FC:00:00:C9:38:E3:8D

Range 3 2F:FE:00:00:C9:38:E3:8E 2F:FE:00:00:C9:55:55:54 2F:FC:00:00:C9:38:E3:8E 2F:FC:00:00:C9:55:55:54

Range 4 2F:FE:00:00:C9:55:55:55 2F:FE:00:00:C9:71:C7:1B 2F:FC:00:00:C9:55:55:55 2F:FC:00:00:C9:71:C7:1B

Range 5 2F:FE:00:00:C9:71:C7:1C 2F:FE:00:00:C9:8E:38:E2 2F:FC:00:00:C9:71:C7:1C 2F:FC:00:00:C9:8E:38:E2

Range 6 2F:FE:00:00:C9:8E:38:E3 2F:FE:00:00:C9:AA:AA:A9 2F:FC:00:00:C9:8E:38:E3 2F:FC:00:00:C9:AA:AA:A9
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Table 11-5 lists the Lenovo WWN address pools. Each Lenovo WWN range contains 116,508 
addresses.

Table 11-5   Lenovo WWN address pools

Range 7 2F:FE:00:00:C9:AA:AA:AA 2F:FE:00:00:C9:C7:1C:70 2F:FC:00:00:C9:AA:AA:AA 2F:FC:00:00:C9:C7:1C:70

Range 8 2F:FE:00:00:C9:C7:1C:71 2F:FE:00:00:C9:E3:8E:37 2F:FC:00:00:C9:C7:1C:71 2F:FC:00:00:C9:E3:8E:37

Range 9 2F:FE:00:00:C9:E3:8E:38 2F:FE:00:00:C9:FF:FF:FE 2F:FC:00:00:C9:E3:8E:38 2F:FC:00:00:C9:FF:FF:FE

Fabric B

Range 1 2F:FF:00:00:C9:00:00:00 2F:FF:00:00:C9:1C:71:C6 2F:FD:00:00:C9:00:00:00 2F:FD:00:00:C9:1C:71:C6

Range 2 2F:FF:00:00:C9:1C:71:C7 2F:FF:00:00:C9:38:E3:8D 2F:FD:00:00:C9:1C:71:C7 2F:FD:00:00:C9:38:E3:8D

Range 3 2F:FF:00:00:C9:38:E3:8E 2F:FF:00:00:C9:55:55:54 2F:FD:00:00:C9:38:E3:8E 2F:FD:00:00:C9:55:55:54

Range 4 2F:FF:00:00:C9:55:55:55 2F:FF:00:00:C9:71:C7:1B 2F:FD:00:00:C9:55:55:55 2F:FD:00:00:C9:71:C7:1B

Range 5 2F:FF:00:00:C9:71:C7:1C 2F:FF:00:00:C9:8E:38:E2 2F:FD:00:00:C9:71:C7:1C 2F:FD:00:00:C9:8E:38:E2

Range 6 2F:FF:00:00:C9:8E:38:E3 2F:FF:00:00:C9:AA:AA:A9 2F:FD:00:00:C9:8E:38:E3 2F:FD:00:00:C9:AA:AA:A9

Range 7 2F:FF:00:00:C9:AA:AA:AA 2F:FF:00:00:C9:C7:1C:70 2F:FD:00:00:C9:AA:AA:AA 2F:FD:00:00:C9:C7:1C:70

Range 8 2F:FF:00:00:C9:C7:1C:71 2F:FF:00:00:C9:E3:8E:37 2F:FD:00:00:C9:C7:1C:71 2F:FD:00:00:C9:E3:8E:37

Range 9 2F:FF:00:00:C9:E3:8E:38 2F:FF:00:00:C9:FF:FF:FE 2F:FD:00:00:C9:E3:8E:38 2F:FD:00:00:C9:FF:FF:FE

Redefined
range 

WWNN starting 
address 

WWNN ending 
address 

WWPN starting 
address 

WWPN ending 
address

Predefined
range 

WWNN starting
address 

WWNN ending
address 

WWPN starting
address 

WWPN ending
address

Fabric A

Range 1 20:80:00:50:76:00:00:00 20:80:00:50:76:01:C7:1B 21:80:00:50:76:00:00:00 21:80:00:50:76:01:C7:1B

Range 2 20:80:00:50:76:01:C7:1C 20:80:00:50:76:03:8E:37 21:80:00:50:76:01:C7:1C 21:80:00:50:76:03:8E:37

Range 3 20:80:00:50:76:03:8E:38 20:80:00:50:76:05:55:53 21:80:00:50:76:03:8E:38 21:80:00:50:76:05:55:53

Range 4 20:80:00:50:76:05:55:54 20:80:00:50:76:07:1C:6F 21:80:00:50:76:05:55:54 21:80:00:50:76:07:1C:6F

Range 5 20:80:00:50:76:07:1C:70 20:80:00:50:76:08:E3:8B 21:80:00:50:76:07:1C:70 21:80:00:50:76:08:E3:8B

Range 6 20:80:00:50:76:08:E3:8C 20:80:00:50:76:0A:AA:A7 21:80:00:50:76:08:E3:8C 21:80:00:50:76:0A:AA:A7

Range 7 20:80:00:50:76:0A:AA:A8 20:80:00:50:76:0C:71:C3 21:80:00:50:76:0A:AA:A8 21:80:00:50:76:0C:71:C3

Range 8 20:80:00:50:76:0C:71:C4 20:80:00:50:76:0E:38:DF 21:80:00:50:76:0C:71:C4 21:80:00:50:76:0E:38:DF

Range 9 20:80:00:50:76:0E:38:E0 20:80:00:50:76:0F:FF:FB 21:80:00:50:76:0E:38:E0 21:80:00:50:76:0F:FF:FB

Fabric B

Range 1 20:81:00:50:76:20:00:00 20:81:00:50:76:21:C7:1B 21:81:00:50:76:20:00:00 21:81:00:50:76:21:C7:1B

Range 2 20:81:00:50:76:21:C7:1C 20:81:00:50:76:23:8E:37 21:81:00:50:76:21:C7:1C 21:81:00:50:76:23:8E:37

Range 3 20:81:00:50:76:23:8E:38 20:81:00:50:76:25:55:53 21:81:00:50:76:23:8E:38 21:81:00:50:76:25:55:53

Range 4 20:81:00:50:76:25:55:54 20:81:00:50:76:27:1C:6F 21:81:00:50:76:25:55:54 21:81:00:50:76:27:1C:6F

Range 5 20:81:00:50:76:27:1C:70 20:81:00:50:76:28:E3:8B 21:81:00:50:76:27:1C:70 21:81:00:50:76:28:E3:8B

Range 6 20:81:00:50:76:28:E3:8C 20:81:00:50:76:2A:AA:A7 21:81:00:50:76:28:E3:8C 21:81:00:50:76:2A:AA:A7
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Table 11-6 lists the QLogic WWN address pools. Each QLogic WWN range contains 116,508 
addresses. 

Table 11-6   QLogic WWN address pools

Range 7 20:81:00:50:76:2A:AA:A8 20:81:00:50:76:2C:71:C3 21:81:00:50:76:2A:AA:A8 21:81:00:50:76:2C:71:C3

Range 8 20:81:00:50:76:2C:71:C4 20:81:00:50:76:2E:38:DF 21:81:00:50:76:2C:71:C4 21:81:00:50:76:2E:38:DF

Range 9 20:81:00:50:76:2E:38:E0 20:81:00:50:76:2F:FF:FB 21:81:00:50:76:2E:38:E0 21:81:00:50:76:2F:FF:FB

Predefined
range 

WWNN starting
address 

WWNN ending
address 

WWPN starting
address 

WWPN ending
address

Predefined
range 

WWNN starting 
address 

WWNN ending 
address 

WWPN ending 
address 

WWPN ending 
address

Fabric A

Range 1 20:80:00:E0:8B:00:00:00 20:80:00:E0:8B:01:C7:1B 21:80:00:E0:8B:00:00:00 21:80:00:E0:8B:01:C7:1B

Range 2 20:80:00:E0:8B:01:C7:1C 20:80:00:E0:8B:03:8E:37 21:80:00:E0:8B:01:C7:1C 21:80:00:E0:8B:03:8E:37

Range 3 20:80:00:E0:8B:03:8E:38 20:80:00:E0:8B:05:55:53 21:80:00:E0:8B:03:8E:38 21:80:00:E0:8B:05:55:53

Range 4 20:80:00:E0:8B:05:55:54 20:80:00:E0:8B:07:1C:6F 21:80:00:E0:8B:05:55:54 21:80:00:E0:8B:07:1C:6F

Range 5 20:80:00:E0:8B:07:1C:70 20:80:00:E0:8B:08:E3:8B 21:80:00:E0:8B:07:1C:70 21:80:00:E0:8B:08:E3:8B

Range 6 20:80:00:E0:8B:08:E3:8C 20:80:00:E0:8B:0A:AA:A7 21:80:00:E0:8B:08:E3:8C 21:80:00:E0:8B:0A:AA:A7

Range 7 20:80:00:E0:8B:0A:AA:A8 20:80:00:E0:8B:0C:71:C3 21:80:00:E0:8B:0A:AA:A8 21:80:00:E0:8B:0C:71:C3

Range 8 20:80:00:E0:8B:0C:71:C4 20:80:00:E0:8B:0E:38:DF 21:80:00:E0:8B:0C:71:C4 21:80:00:E0:8B:0E:38:DF

Range 9 20:80:00:E0:8B:0E:38:E0 20:80:00:E0:8B:0F:FF:FB 21:80:00:E0:8B:0E:38:E0 21:80:00:E0:8B:0F:FF:FB

Fabric B

Range 1 20:81:00:E0:8B:20:00:00 20:81:00:E0:8B:21:C7:1B 21:81:00:E0:8B:20:00:00 21:81:00:E0:8B:21:C7:1B

Range 2 20:81:00:E0:8B:21:C7:1C 20:81:00:E0:8B:23:8E:37 21:81:00:E0:8B:21:C7:1C 21:81:00:E0:8B:23:8E:37

Range 3 20:81:00:E0:8B:23:8E:38 20:81:00:E0:8B:25:55:53 21:81:00:E0:8B:23:8E:38 21:81:00:E0:8B:25:55:53

Range 4 20:81:00:E0:8B:25:55:54 20:81:00:E0:8B:27:1C:6F 21:81:00:E0:8B:25:55:54 21:81:00:E0:8B:27:1C:6F

Range 5 20:81:00:E0:8B:27:1C:70 20:81:00:E0:8B:28:E3:8B 21:81:00:E0:8B:27:1C:70 21:81:00:E0:8B:28:E3:8B

Range 6 20:81:00:E0:8B:28:E3:8C 20:81:00:E0:8B:2A:AA:A7 21:81:00:E0:8B:28:E3:8C 21:81:00:E0:8B:2A:AA:A7

Range 7 20:81:00:E0:8B:2A:AA:A8 20:81:00:E0:8B:2C:71:C3 21:81:00:E0:8B:2A:AA:A8 21:81:00:E0:8B:2C:71:C3

Range 8 20:81:00:E0:8B:2C:71:C4 20:81:00:E0:8B:2E:38:DF 21:81:00:E0:8B:2C:71:C4 21:81:00:E0:8B:2E:38:DF

Range 9 20:81:00:E0:8B:2E:38:E0 20:81:00:E0:8B:2F:FF:FB 21:81:00:E0:8B:2E:38:E0 21:81:00:E0:8B:2F:FF:FB
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Creating a Fibre Channel address pool 
Complete the following steps to create a Fibre Channel address pool:

1. From the XClarity Administrator menu bar, click Provisioning → Address Pools. The 
Configuration Patterns: Address Pools page is displayed, as shown in Figure 11-15. 

Figure 11-15   Lenovo XClarity Fibre Channel Addresses

2. Click the Fibre Channel Address Pools tab, as highlighted in Figure 11-15.

3. Vendor predefined default Fibre Channel Address pools are available, as shown in 
Figure 11-15.

4. Click the Create icon .
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5. The Fibre Channel (WWN) Address Pools dialog is displayed, as shown in Figure 11-16.

Figure 11-16   Fibre Channel address pools

6. Enter a name and description for the Fibre Channel (WWN) address pool.

7. Add one or more ranges of addresses. Click Add Range to add a range of addresses. The 
Fibre Channel Address Range dialog is displayed, as shown in Figure 11-17.

Figure 11-17   Fibre Channel address range
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8. Enter a range name, range size, and the first address for each fabric, as highlighted in 
Figure 11-17 on page 269.The last addresses are calculated automatically. 

9. Click Add. The range is added to the Defined Fibre Channel Pool Address Ranges table 
and the fields in the summary section are updated automatically.

10.You can edit the range by clicking the Edit icon  or remove the range by clicking the 
Remove icon .

11.Click Save. The range is added to the Defined Fibre Channel Pool Address Ranges table 
and the fields in the summary section are updated automatically.

After you define your Address Pools, you can configure the Server Patterns. For more 
information, see 11.5, “Server configuration patterns” on page 270.

11.5  Server configuration patterns

When you create a server pattern, you define the configuration characteristics for a type of 
server. You can create a server pattern from scratch by using default settings or settings from 
a server.

Before you create a server pattern, consider the following points:

� The first time that you create a server pattern, consider creating it from a server. When 
you create a server pattern from a server, XClarity Administrator learns and creates 
extended category patterns for some I/O adapter ports, UEFI, and IMM settings. Then, 
those category patterns are available for use in any server pattern that you create later.

� Identify groups of servers that have the same hardware options and that you want to 
configure the same way. You can use a server pattern to apply the same configuration 
settings to multiple servers, which controls a common configuration from one place.

� Identify the aspects of configuration that you want to customize for the server pattern (for 
example, local storage, network adapters, boot settings, IMM settings, and UEFI settings).

� Set server pattern preferences (server type, I/O adapters, and I/O addressing methods) 
that you want to have as defaults when server patterns are created.

Management node failure: You might lose your server patterns. Therefore, always 
back up the management software after you create or modify server patterns.

XClarity Administrator does not include built-in backup functions. Instead, use the 
backup functions that are available based on the virtual-host operating system on which 
XClarity Administrator is installed.

If you have backup procedures in place for virtual hosts, ensure that you expand them 
to include XClarity Administrator. Also, ensure that all running jobs completed and that 
you shut down XClarity Administrator before you create a backup.

XClarity Administrator also does not include built-in restore functions. Instead, use the 
restore processes that are available from the host where XClarity Administrator is 
installed. 

For more information about backing up and restoring XClarity Administrator, see the 
XClarity Administrator information center, which is available at this website:

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.lenovo.lxca.
doc/backup_bakupandrestore.html 
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11.5.1  Defining server configuration criteria

There are various configuration settings that must be defined when a server pattern is 
created. Some of these settings can be defined from scratch; however, others are available 
only for modification if they are captured or learned from a server. 

This section includes the following topics:

� “Defining local storage”
� “Defining I/O adapters” on page 274
� “Defining boot options” on page 279
� “Defining firmware settings” on page 280
� “Defining system information settings” on page 282
� “Defining management interface settings” on page 283
� “Defining devices and I/O ports settings” on page 289
� “Defining Fibre Channel boot target settings” on page 292
� “Defining port settings” on page 293
� “Defining extended IMM settings” on page 297
� “Defining extended UEFI settings” on page 298
� “Defining extended port settings” on page 301

Defining local storage
You can define the storage configuration to be applied to target servers when this pattern is 
deployed.

Local storage features the following options: 

� Specify Storage Configuration

Choose this option to specify the drive type, RAID configuration, and number of drives that 
are installed in the server. This option is supported only if you are deploying the pattern to 
one or more servers that do not have RAID configurations.

What happens if the server has a RAID configuration: If this option is selected and 
the server pattern is deployed to a server that has a RAID configuration, the arrays and 
volumes are not overwritten.

To apply the RAID configuration that is defined in the pattern, the server’s RAID 
configuration must be cleared first.

Complete the following steps to clear the server’s RAID configuration: 

1. From the XClarity Administrator menu bar, click Hardware → All Servers. The 
Servers page is displayed with a tabular view of all managed servers (rack servers 
and compute nodes).

2. Select the server, and click All Actions → Details (or click the Server name in the 
table). The Inventory Details page is then displayed, which shows the server 
properties and a list of components that are installed in that server.

3. Click Configuration from the left side of the window.

4. Select All Actions → Reset Local Storage to Defaults.

5. Click Reset Storage.

6. After the server’s RAID configuration is cleared, click More → Deploy Server 
Profile to redeploy the server profile.
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Complete the following steps to specify the storage configuration: 

a. Click Specify Storage configuration and the storage configuration settings are 
displayed, as shown in Figure 11-18.

Figure 11-18   Storage configuration settings

b. Enter the appropriate storage configuration settings for your server. The available 
options are listed in Table 11-7.

Table 11-7   Local Storage Settings

Setting Options available

Disk type Any type (Try HDD first)

SAS hard disk drive (HDD)

SAS Solid-State drive (SSD)

SATA hard disk drive (HDD)

SATA Solid-state drive (SSD)

Raid Level RAID 0 (Striping)

RAID 1 (Mirroring)

RAID 5 (Striping with parity)

Number of drives You can select 1 - 8 drives
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You can also expand Volume’s Advanced Settings (The volume's advanced settings 
are applicable only to MegaRAID based storage controllers, details of these settings 
are shown in Figure 11-19 on page 273. You will need to scroll down to see these 
settings. Modify as appropriate and then click Next to continue.

Figure 11-19   Volume’s Advanced Settings.

Available options are listed in Table 11-8.

Table 11-8   Volume Advanced Settings

� Keep existing storage configuration on target

Choose this option to use the storage configuration that is in place on the target server.

� Disable local disk

Choose this option if you are planning to start from SAN.

Setting Options available

Read policy No Read ahead

Always Read ahead

Write policy Write through

Always Write back

Write back with BBU

I/O policy Direct IO

Cached IO

Access policy Read/write

Read Only

Blocked

Cache policy Unchanged

Enabled

Disabled

Initialization status No initialization

Fast Initialization

Full Initialization

Number of hot spare drives You can select 1 - 128 spare drives
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If you are deploying a pattern to a Flex System x240 Compute Node, choose this option to 
disable the on-board storage controller and storage option ROM (UEFI and Legacy). 
Disabling the local disk decreases the overall start time when starting from SAN.

Defining I/O adapters
You can define I/O port settings and addressing mode to be used to configure servers when 
this pattern is deployed.

If you intend to virtualize or reassign your I/O adapter addresses, you can configure this 
pattern to use virtual I/O adapter addressing.

If you are creating a pattern from a server, some adapter information might be automatically 
learned. You can define other I/O adapter patterns to match the hardware that you expect to 
have in the servers when this pattern is deployed. By defining I/O adapter patterns, you can 
configure adapter port settings for your supported adapter, and, if virtual I/O adapter 
addresses are used, you can define SAN boot targets for Fibre Channel adapters that you 
add.

Complete the following steps to define I/O adapter settings:

1. From the New Server Pattern Wizard, click the I/O Adapter tab, as shown in Figure 11-20.

Figure 11-20   New Server Pattern Wizard: I/O Adapters tab

2. When a server pattern is created for a compute node, you can choose the following types 
of I/O adapter addressing mode:

– Burned in
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Use worldwide name (WWN) and MAC addresses that are provided with the adapter 
from manufacturing.

– Virtual

Use virtual I/O adapter addressing to simplify the management of LAN and SAN 
connections to speed deployment and automatic failover by virtualizing WWN and 
MAC addresses.

When virtual addressing is enabled, Ethernet and Fibre Channel addresses are 
allocated by default regardless of defined adapters. You can choose the pool from 
which Ethernet and Fibre Channel addresses are allocated (as shown in Figure 11-21 
on page 275). Then, click Save.

Figure 11-21   Selecting Ethernet and Fibre Channel addressing

Virtual Addressing support: Virtual addressing is supported for Flex System 
compute nodes only. Lenovo rack/tower servers are not supported.
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3. If you are creating a server pattern for a compute node, select one of the scalability 
options that are shown in Figure 11-22. 

Figure 11-22   Scalable node selection

The rows in table change based on what is selected:

– Non-scalable compute node, as shown in Figure 11-22

– Two-node scalable compute nodes, as shown Figure 11-23 on page 276

Figure 11-23   2 Node Scalable Compute Node

– A four-node scalable compute node, as shown in Figure 11-24.
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Figure 11-24   4 Node Scalable Compute Node

4. Choose the I/O adapters that you expect to be installed in the server to which the pattern 
is to be deployed. Complete the following steps to add an adapter:

a. Click the Add I/O Adapter link in the table, as shown in Figure 11-25 on page 278.
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Figure 11-25   Add I/O Adapter

b. Select the PCI slot for the adapter.

c. Select the type of adapter to add by using the scroll bar to see all options available or 
you can filter the adapters by vendor, as shown in Figure 11-26.

Figure 11-26   

d. Select the initial port pattern to be assigned to all ports in the port group when the 
pattern is deployed.

Port patterns are used to modify port settings that are learned from the server. These 
initial port patterns are assigned when the adapter is first added. After the adapter is 
added, you can assign different patterns to individual ports from the I/O Adapter page.

You can create a port pattern by clicking the Create icon . 
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You can create a port pattern based on an existing pattern by clicking the Edit icon .

For more information about port patterns, see “Defining port settings” on page 293.

5.     Click Add to add the port pattern to the table on the I/O Adapter page.

Defining boot options
You can define the boot order to be used for target servers when this pattern is deployed.

Complete the following steps to create a boot-options pattern:

1. From the New Server Pattern Wizard, click the Boot tab, as shown in Figure 11-27

Figure 11-27   Boot preferences

2. Select one of the following system boot modes:

– UEFI only boot 

Select this option to configure a server that supports the UEFI. If you are booting UEFI 
enabled operating systems, this option might shorten boot time by disabling legacy 
option ROMs.

– UEFI first, then legacy 

Select this option to configure a server to attempt to boot by using UEFI first. If there is 
an issue, the server attempts to boot in legacy mode. Select this option only if you are 
booting non-UEFI enabled operating systems.
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– Legacy only boot

Select this option if you are configuring a server to boot an operating system that 
requires legacy (BIOS) firmware. Select this option only if you are booting non-UEFI 
enabled operating systems.

If you select the legacy-only boot mode (which makes boot time much faster), you 
cannot activate any Features on Demand (FoD) keys.

If you choose Legacy only boot, you can specify the following orders:

• Primary boot order. Choose to keep the boot order specified on the server to which 
the pattern is to be deployed. You can also choose to configure the Legacy Only 
boot order to specify the order in which boot options are applied.

• Wake on LAN (WoL) boot order. Choose to keep the current WoL boot order 
specified on the server to which the pattern is to be deployed. You can also choose 
to configure the Legacy Only boot order to specify the order in which WoL boot 
options is to be applied.

– Keep existing boot mode

Select this option to keep the existing settings on the target server. No changes to the 
boot order are made when the pattern is deployed.

3. Select the SAN Boot tab to choose a boot target pattern and specify boot device targets.

If you defined Fibre Channel adapters and enabled virtual addressing when you defined 
the I/O adapters, you can set SAN primary and secondary boot targets for the Fibre 
Channel adapters. You can specify multiple worldwide port name (WWPN) and logical unit 
number (LUN) identifiers for the storage targets.

Defining firmware settings
You can specify the IMM and UEFI firmware settings that are to be used to configure target 
servers when this pattern is deployed.

The firmware settings are organized into categories that group related settings. For each 
category, you can create a category pattern that contains common settings and can be 
reused by multiple server patterns. Most of the firmware settings that you can configure 
directly on the server IMM and UEFI can also be configured through category patterns. The 
firmware settings that are available depend on the server type, your Flex System 
environment, and the scope of the server pattern.

The following category patterns are available:

� Predefined category patterns are patterns that are provided by XClarity Administrator. 
There are predefined patterns for extended port and extended UEFI settings. You can edit 
and save these patterns as a different pattern if the settings must be customized.

� Extended category patterns are patterns for some I/O adapter ports, UEFI, and IMM 
settings that are learned from a specific managed server. XClarity Administrator creates 
these patterns when you create a server pattern from a server. You cannot manually 
create extended category patterns.

� User-defined category patterns are patterns that you can create, including system 
information, management interfaces, devices and I/O ports, Fibre Channel boot targets, 
and I/O adapter ports.
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Complete the following steps to define firmware settings:

1. From within the Server Pattern Wizard, click the Firmware Settings tab to create or select 
various category patterns, as shown in Figure 11-28.

Figure 11-28   Firmware Settings tab

2. Create category patterns by clicking the Create icon  that is next to the category 
pattern type. You also can select the category patterns that define the settings that you 
want to use from the list of category patterns by selecting the drop-down box  on the 
specific category item as detailed. The following patterns are available:

– System information

Use this category pattern to define automatic system-name generation, contact 
names, and locations. For more information about system-information patterns, see 
“Defining system information settings” on page 282.

– Management interfaces

Use this category pattern to define automatic host name generation, management IP 
address assignments, domain name space settings, and internet speed settings. For 
more information about management-interfaces patterns, see “Defining management 
interface settings” on page 283.

– Devices and I/O ports

Use this category pattern to define console redirection and COM ports, PCIe speed, 
onboard devices, adapter option ROM, and option ROM run order. For more 
information about device and I/O port patterns, see “Defining devices and I/O ports 
settings” on page 289.

– Extended IMM

Use this category pattern to define other IMM settings. The extended settings patterns 
are automatically created when you create a server pattern from a server. You cannot 
manually create an extended IMM pattern. For more information about Extended IMM 
settings, see “Defining extended IMM settings” on page 297.

– Extended UEFI

Use this category pattern to define other UEFI settings. The extended settings patterns 
are automatically created when you create a server pattern from a server. You cannot 
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manually create an extended UEFI pattern. For more information about Extended UEFI 
settings, see “Defining extended UEFI settings” on page 298.

Defining system information settings
You can define system name, contact, and location information by creating a system 
information pattern.

Complete the following steps to create a system information pattern:

1. From the XClarity Administrator menu bar, click Provisioning → Patterns. The 
Configuration Patterns: Patterns page is displayed.

2. Click the Category Patterns tab as, shown in Figure 11-29.

Figure 11-29   Category Patterns: System information Patterns

3. Click System Information Pattern, and then click the Create icon , as shown in 
Figure 11-29.

Tip: You also can create a System Information Pattern from the Firmware settings page 
of the New Server Pattern wizard by clicking the Create icon that is next to the System 
Information selection.
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The New system information pattern window opens, as shown in Figure 11-30.

Figure 11-30   System information Pattern settings

4. Specify the following information:

– Enter the name and description for the pattern.

– Choose whether to automatically generate system names. If you click Custom, you 
can specify how names are to be generated when the pattern is deployed. If you click 
Disable, the system name remains unchanged on each server when the pattern is 
deployed. System names are limited to 15 English characters by the IMM. 
Automatically generated names are truncated to 15 characters.

– Specify the person to be contacted for this server and the location of the server.

5. After the information is entered, click Create. The new pattern is listed on the System 
Information Patterns tab in the Configuration Patterns: Category Patterns page. 

Defining management interface settings
You can define host names, IP address, domain name space (DNS), interface speed, and 
port assignments for the management interface by creating a management interface pattern.

If SNMP is enabled: You must specify a contact and system location; otherwise, the 
deployment of this server pattern fails.
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Complete the following steps to create a management interface pattern:

1. From the XClarity Administrator menu bar, click Provisioning → Patterns. The 
Configuration Patterns: Patterns page is displayed.

2. Click the Category Patterns tab, as shown in Figure 11-31.

Figure 11-31   Category Patterns

3. Click Management Interface Patterns, as shown in Figure 11-31. Click the Create icon 
 to open and create a Management Interface Pattern, as shown in Figure 11-32 on 

page 285.

You can also create a management interface pattern from the Firmware settings page 
within the new Server Pattern wizard by clicking the Create icon  that is next to the 
Management Interface selection.

Note: Duplex settings are not supported by server patterns.
284 Lenovo XClarity Administrator Planning and Implementation Guide



Figure 11-32   Management Interface Pattern settings

4. In the New Management Interface Pattern window, specify the following information:

a. Enter the name and description for the pattern, as shown in Figure 11-32.

b. Click the Host name tab (as highlighted in Figure 11-32) if it is not selected and 
choose whether to automatically generate host names. 

If you click Custom, you can specify how names are to be generated when the pattern 
is deployed as shown in Figure 11-33 on page 286.

Host Name Character Limitation: Host names are limited to 63 characters by the 
IMM. Automatically generated names are truncated to 63 characters.
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Figure 11-33   Custom name scheme 

If you click Disable, the host name remains unchanged on each server when the 
pattern is deployed, as shown in Figure 11-34. 

Figure 11-34   Auto-generate set as Disable

5. Click the Management IP Addresses tab to configure IPv4 and IPv6 addresses settings, 
as shown in Figure 11-35.

Figure 11-35   Management IP Addresses tab view
286 Lenovo XClarity Administrator Planning and Implementation Guide



For IPv4 addresses, click Enable, as shown in Figure 11-36.

Figure 11-36   IPv4 address options

You are then prompted to choose one of the following options:

– Obtain dynamic IP addresses from a DHCP server.

– Try DHCP. If it is not successful, obtain a static IP address from the address pool.

– Obtain a static IP address from the address pool

With this option, you select the applicable Address pool that was created as shown in 
Figure 11-37. You also can create an address pool by clicking the Create icon .

Figure 11-37   Select IMM IP Address pool

For IPv6 addresses, click Enable and then choose one of the following options, as shown 
in Figure 11-38 on page 288:

– Use stateless address automatic configuration.
– Obtain a dynamic IP address from a DHCP server.
– Obtain a static IP address from the address pool.
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Figure 11-38   IPv6 Management IP Address options

6. Click the Domain Name System (DNS) tab, as shown in Figure 11-39.

Figure 11-39   Domain Name System (DNS) view 

You can choose Enable or Disable Dynamic Domain Name Services (DDNS), as shown 
in Figure 11-39. If you enable DDNS, you can choose one of the following options:

– Obtain the domain name from a DHCP server.
– Specify the domain name.

7. Click the Interface Settings tab in which you can specify the maximum transmission unit 
(MTU), as shown in Figure 11-40. The MTU is the largest physical packet size (measured 
in bytes) that a network can transmit. The default is 1500.

Figure 11-40   Interface Settings view
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8. Click the Port Assignments tab to specify the numbers to use for the ports. The Default 
settings are highlighted in Figure 11-41.

Figure 11-41   Port Assignments

9. After you complete all of the Management Interface Settings, click Create and the new 
pattern is now listed as an available Pattern.

Defining devices and I/O ports settings
You can enable console redirection and enable and define the characteristics of the COM 1 
port by creating a device and I/O ports pattern.

Complete the following steps to create a device and I/O ports pattern:

1. From the XClarity Administrator menu bar, click Provisioning → Patterns.

2. Click the Category Patterns tab.

3. Click Devices and I/O Ports Pattern. Then, click the Create icon .

You can also create a device and I/O ports pattern from the Firmware Settings page of the 
New Server Pattern wizard by clicking the Create icon  that is next to the Devices and 
I/O Ports selection.

When advanced features on Flex IO modules are used: If advanced features, such as 
Switch Partitioning (SPAR), Easy Connect, and stack, are enabled on Flex System 
EN4093R, CN4093, SI4093, and SI4091 switches, network configurations might not be 
applied correctly on internal ports.

For more information about the advanced features, including (SPAR), Easy Connect, and 
stacking, see NIC Virtualization in Flex System Fabric Solutions, which is available from 
Lenovo Press at this website:

http://lenovopress.com/sg248223 

By default, the Flex System SI4093 switch is shipped with SPAR enabled. If you want to 
deploy network settings by using port patterns to internal ports on these switches, you 
must manually remove the switch internal ports from SPAR or remove the SPAR 
configurations from the switch.
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4. In the New Devices and I/O Ports Pattern dialog, enter the name and description for the 
pattern, as shown in Figure 11-42.

Figure 11-42   Device and I/O pattern name

5. You can then choose Enable or Disable console redirection, as shown in Figure 11-43. 

Figure 11-43   Console redirection options

6. If you enable console redirection, you can choose to enable or disable the following 
components:

– Serial over LAN.

– Service processor redirection. 

If you Enable service processor redirection, you can also choose one of the following 
CLI modes:

• Disable
• Enable with user-defined key stroke sequence
• Enable with EMS compatible key stroke sequence

Choose to enable or disable COM ports 1 and 2. 

COM Port 2 is enabled only when Service Processor redirection is set to Enabled.

If you choose to enable COM ports, specify or edit the settings that are highlighted in 
Figure 11-44 on page 291.
290 Lenovo XClarity Administrator Planning and Implementation Guide



Figure 11-44   COM port settings

7. Choose to enable or disable Legacy option ROM serial data port. If you chose to enable 
Legacy option ROM serial data port, specify or edit the settings for COM port 2, as 
highlighted in Figure 11-44.

8. Click Create. The new pattern is listed as an available pattern on the Devices and I/O 
Ports Patterns tab, as shown in Figure 11-45.

Figure 11-45   Device and IO patterns 
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Defining Fibre Channel boot target settings
You can configure the server to boot from a storage area network (SAN) device instead of 
from local disk drive by creating a Fibre Channel boot target pattern.

Complete the following steps to create a Fibre Channel boot target pattern:

1. From the XClarity Administrator menu bar, click Provisioning → Patterns. The 
Configuration Patterns: Patterns page is displayed.

2. Click the Category Patterns tab.

3. Click Fibre Channel Boot Target Pattern, and then, click the Create icon  and the 
New Fibre Channel Boot Target Pattern dialog appears as shown in Figure 11-46. 

Figure 11-46   Category: Fibre Channel Boot Target 

4. In the Fibre Channel Boot Target Pattern dialog, specify the following information:

– Enter a name and description for the pattern.

– Specify one or more WWPN addresses and LUN identifiers to use as primary boot 
targets. In addition, you can optionally specify one or more WWPN addresses and LUN 
identifiers to use as secondary boot targets. 

Fibre Channel Boot Targets: Fibre Channel boot targets are supported for compute 
nodes only. Rack servers are not supported.
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For example, you can add the storage primary paths as primary targets and the 
storage secondary paths as secondary targets. By using different target groups in 
different server patterns, you can balance the storage system load during simultaneous 
boot requests from multiple hosts.

If you specify 00:00:00:00:00:00:00:00 for the WWPN, XClarity Administrator 
attempts to boot from the first discovered target.

5. Click Create. The new pattern is listed on the Fibre Channel Boot Target Patterns tab in 
the Configuration Patterns: Category Patterns page.

Defining port settings
You can define typical port settings for a specific I/O adapter type by creating a port pattern.

XClarity Administrator provides the Virtual Fabric Balanced Ethernet. Port pattern for virtual 
fabric vNIC mode (Ethernet only) predefined port pattern.

You can use network settings in port patterns to configure switch internal ports; however, the 
switch-related settings can apply to the following types of switches that have full support:

� Flex System Fabric CN4093 10Gb Converged Scalable Switch (00FM510)
� Flex System Fabric EN4093R 10Gb Scalable Switch (00FM514)
� Flex System Fabric SI4093 System Interconnect Module (00FE327)
� Flex System Fabric SI4091 System Interconnect Module (00FM518)

You cannot use port patterns to configure the switch global settings, such as VLAN IDs, 
global UFP mode, global CEE mode, and global FIPs. You must manually configure the global 
settings by using the following rules that are compatible with the internal port settings that you 
intend to deploy before you deploy the port patterns: 

� Ensure that globalCEEState is On when PFC is configured.

� Ensure that globalCEEState is On when vPort is set to FCoE mode.

� Ensure that globalCEEState is On and globalFIPsState is On when FIPs are configured.

� Ensure that globalUFPMode is set to Enable when the switch internal port mode is set to 
UFP mode.

For more information about determining the compatibility checks between the global settings 
and internal port settings and how to configure these settings for that switch, see the 
documentation that came with your switch.

Complete the following steps to create an I/O adapter port pattern:

1. From the XClarity Administrator menu bar, click Provisioning → Patterns. The 
Configuration Patterns: Patterns page is displayed.
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2. Click the Category Patterns tab.

Figure 11-47   Port Pattern selection
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3. Click Port Pattern. Then, click the Create icon , as shown in Figure 11-47 on 
page 294. The New Port Pattern page opens, as shown in Figure 11-48.

Figure 11-48   New Port Pattern page

You can also create a port pattern from the Add I/O Adapter page by clicking the Create 
icon  that is next to the Initial port pattern selection.

4. In the New Port Pattern dialog that is shown in Figure 11-48, specify the following 
information:

– Enter the name and description for the pattern.

– Specify the following adapter and port compatibility settings as highlighted in 
Figure 11-49 on page 297. When patterns are assigned to adapters and ports, the 
following pattern settings are filtered based on compatibility with the target adapter or 
port:

• Target adapter type

• Target port operational mode, including
- pNIC mode
- vNIC virtual fabric mode
- vNIC switch independent mode
- vNIC unified fabric protocol mode

These settings enable NIC virtualization. For more information, see NIC 
Virtualization in Flex System Fabric Solutions, SG24-8233, which is available at this 
website:

http://lenovopress.com/sg248223
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• Port extended settings pattern (used to configure extra port settings that are 
learned from the server)

– If you set the Target Port Operational mode to pNIC mode, choose apply 
corresponding settings to the Flex switch internal ports (also highlighted in 
Figure 11-48 on page 295), where applicable. If selected, you can configure the 
following VLAN and advanced settings:

• Specify the target port protocol.

• Specify the default LAN, which is used only by the operating system when the 
operating system sends untagged packets.

• Specify a comma-separated list of VLANs.

• Choose to configure manual control and specify the triggers.

• Choose to configure PFC on the selected priority and to specify a second priority 
ID.

• If you set the target port protocol to Ethernet and FCoE, optionally select and 
specify the priority 2 ID.

– If you set the target port operational mode to vNIC virtual fabric mode, configure the 
physical function settings, including the type and VLAN tag for each function.

– If you set the target port operational mode to vNIC switch independent mode, choose 
to apply corresponding settings to the Flex switch internal ports, where applicable. If 
selected, you can configure the following physical function, switch internal port, and 
advanced settings:

• Specify the type, minimum bandwidth, and VLAN tag for each enabled function.

• Specify the default LAN, which is used only by the operating system when the 
operating system sends untagged packets.

• Specify a comma-separated list of VLANs.

• Choose to configure manual control and specify the triggers.

• Choose to configure flow control type, including: 

- Keep existing flow control 

- Priority-based flow control: After you define priority-based flow control in a server 
pattern, ensure that you enable the priority-based flow control on the related 
internal port of the switch to make the settings active.

- Link-level flow control: Before you define link level flow control in a server pattern, 
ensure that you disable the priority-based flow control on the related internal port of 
the switch.

For more information about these flow-control types, see the documentation that 
was included your Flex switch.

– If you set the target port operational mode to vNIC unified fabric protocol mode, choose 
to apply corresponding settings to the Flex switch internal ports, where applicable. If 
selected, you can configure the following UFP function and advanced settings:

• Specify the target port protocol.
• Specify the mode, minimum bandwidth, and VLAN tag for each enabled function.
• Choose to configure failure and specify the number of triggers for each function.

5. When complete, click Create. The new pattern is listed on the Port Patterns tab in the 
Configuration Patterns: Category Patterns page.
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Defining extended IMM settings
The extended IMM settings are learned and dynamically created from a specific managed 
server. XClarity Administrator creates these patterns when you create a server pattern from a 
server. 

You cannot manually create extended IMM patterns; however, you can copy and modify the 
patterns that were created.

Complete the following steps to modify extended IMM patterns:

1. From the XClarity Administrator menu bar, click Provisioning → Patterns. The 
Configuration Patterns: Patterns page is displayed. Click the Category Patterns tab.

2. Click Extended IMM Patterns and select the pattern to be modified. Then, click the Edit 
icon .

3. Modify the fields as required. You can also select to Include/Exclude settings from the 
Extended IMM Settings category pattern by clicking Include/Exclude settings.

Several settings are available, as highlighted in Figure 11-49. You can expand and 
collapse each section by clicking the plus + or minus - buttons. 

Figure 11-49   Potential Extended IMM settings.

After you select the required settings, click Done.

4. When you complete editing the Extended IMM Pattern, click Save to the save changes to 
the current category pattern, or click Save As to save changes as a new Extended IMM 
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category pattern. As a best practice, modify the description field to reflect that the pattern 
was modified.

5. The modified or new category pattern is listed as an available pattern on the Extended 
IMM Patterns tab, as shown Figure 11-50.

Figure 11-50   Modified Extended IMM Pattern

Defining extended UEFI settings
The extended UEFI settings are learned and dynamically created from a specific managed 
server. XClarity Administrator creates these patterns when you create a server pattern from a 
server. You cannot manually create extended UEFI patterns; however, you can copy and 
modify the patterns that were created.
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As described in section 11.3, “Pre-defined category patterns” on page 255, XClarity 
Administrator provides some predefined Category patterns. The patterns that are highlighted 
in Figure 11-51 are the predefined Extended UEFI patterns. The Pattern Origin column 
indicates “Lenovo Defined:”, which is highlighted in Figure 11-51.

Figure 11-51   Predefined Extended UEFI Patterns, Lenovo Defined

The following predefined UEFI patterns are available: 

� M5 High Performance

UEFI patterns that are optimized for high-performance computing environments (Flex 
System x240 compute nodes and System x3550 and x3650 servers only).

� M5 Low Latency

UEFI patterns that are optimized for low-latency computing environments (Flex System 
x240 compute nodes and System x3550 and x3650 servers only).

� M5 Virtualization

UEFI patterns that are optimized for virtualized computing environments (Flex System 
x240 compute nodes and System x3550 and x3650 servers only).

� x240 High Performance

UEFI patterns that are optimized for high-performance computing environments (Flex 
System x240 compute nodes only).
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� x240 Low Latency

UEFI patterns that are optimized for low-latency computing environments (Flex System 
x240 compute nodes only).

� x240 Standard Workload

UEFI patterns that are optimized for standard-workload computing environments (Flex 
System x240 compute nodes only).

� x240 Transactional Workload

UEFI patterns that are optimized for transactional-workload computing environments (Flex 
System x240 compute nodes only).

� x240 Virtualization

UEFI patterns that are optimized for virtualized computing environments (Flex System 
x240 compute nodes only).

� X6 High Performance

UEFI patterns that are optimized for high-performance computing environments (Flex 
System x480 X6 and x880 X6 compute nodes and System x3850 X6 and x3950 X6 
servers only).

� X6 Low Latency

UEFI patterns that are optimized for low-latency computing environments (Flex System 
x480 X6 and x880 X6 compute nodes and System x3850 X6 and x3950 X6 servers only).

� X6 Virtualization

UEFI patterns that are optimized for virtualized computing environments (Flex System 
x480 X6 and x880 X6 compute nodes and System x3850 X6 and x3950 X6 servers only).

Complete the following steps to modify the extended UEFI patterns:

1. From the XClarity Administrator menu bar, click Provisioning → Patterns. The 
Configuration Patterns: Patterns page is displayed.

2. Click the Category Patterns tab.
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3. Click Extended UEFI Patterns. Select the pattern to be modified. Then, click the Edit icon 
. The Edit Extended UEFI pattern page opens, as shown in Figure 11-52.

Figure 11-52   Extended UEFI Pattern view

4. Modify the fields, as required. You also can modify the settings to include or exclude by 
clicking Include/Exclude Settings, as highlighted in Figure 11-52.

For more information about the settings, see Appendix C, “Extended UEFI Settings” on 
page 379.

5. After you complete modifying the Extended UEFI Settings, modify the description to reflect 
a change. Then, click Save to the save changes to the current category pattern or click 
Save As to save changes in a new category pattern.

The new or modified category pattern is listed on the Extended Port Patterns tab in the 
Configuration Patterns: Category Patterns page.

Defining extended port settings
Extended port settings are learned and dynamically created from a specific managed server. 
XClarity Administrator creates these patterns when you create a server pattern from a server. 
You cannot manually create extended port patterns; however, you can copy and modify the 
patterns that were created.
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XClarity Administrator provides the Virtual fabric balanced Ethernet predefined extended port 
pattern, which is for Virtual Fabric mode vNIC mode, Ethernet only. 

Complete the following steps to modify extended port patterns:

1. From the XClarity Administrator menu bar, click Provisioning → Patterns. The 
Configuration Patterns: Patterns page is displayed.

2. Click the Category Patterns tab.

3. Click Extended Port Patterns, as shown in Figure 11-53.

Figure 11-53   Extended Port Patterns selection

4. Select the pattern to be modified and click the Edit icon , as shown in Figure 11-53.

If you select more than one pattern, you receive an error notification (as shown in 
Figure 11-54) that indicates that only one pattern at a time can be copied, deployed, 
edited, or renamed.

Figure 11-54   Multiple selections of extended ports patterns give error notification
302 Lenovo XClarity Administrator Planning and Implementation Guide



5. The Port Pattern opens, as shown in Figure 11-55. Modify the fields as required.

Our example is taken from the Emulex 10Gb Adapter Port 1.1. 

Figure 11-55   Emulex 10GB NIC Port Pattern for port 1.1

You can select the settings that you want to include or exclude in the category pattern by 
clicking Include/Exclude settings. These settings are specific for each adapter type. 

6. Click Save to the save changes to the current category pattern or click Save As to save 
changes in a new category pattern. The new category pattern is listed on the Extended 
Port Patterns tab in the Configuration Patterns: Category Patterns page.

After you define or modify the applicable settings for your environment, you can then create a 
Server Pattern. For more information, see 11.6, “Creating a Server Pattern”.

11.6  Creating a Server Pattern

When you create a server pattern, you define the configuration characteristics for a type of 
server. You can create a server pattern from a server scratch or by using default settings.

Before you create a server pattern, consider the suggestions that are described in 11.5.1, 
“Defining server configuration criteria” on page 271.
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11.6.1  Creating a server pattern from a server

Complete the following steps to create a server pattern from an existing server.

1. From the XClarity Administrator menu bar, click Provisioning → Patterns, as shown in 
Figure 11-56.

Figure 11-56   Pattern in Provisioning menu

The Configuration Patterns: Patterns page is displayed, as shown in Figure 11-57.

Figure 11-57   Configuration Patterns view with Server Patterns Tab selected

2. Click the Server Patterns tab, if it is not selected.

3. Click the Create icon . 
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The New Server Patterns Wizard view is displayed, as shown in Figure 11-58.

Figure 11-58   New Server Pattern Wizard 

4. Click Create a new pattern from an existing server to use settings from a server, as 
shown in Figure 11-59. 

Figure 11-59   Create New Pattern from an existing server selection

5. Select the managed server on which the new pattern is to be based from the displayed list 
as shown in Figure 11-60 on page 306.
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Figure 11-60   Servers available to pull as the base configuration

In our example, we selected the x240 M5 system.

6. Give the pattern a descriptive name and click Next to continue, as shown Figure 11-61.

Figure 11-61   Provide name for Pattern

XClarity Administrator creates the pattern, as shown in Figure 11-62 on page 307.
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Figure 11-62   Capturing server pattern from x240 M5 Flex Compute node

When you create a server pattern from a server, XClarity Administrator learns the settings 
from a managed server (including the extended port, UEFI, and IMM settings) and 
dynamically creates category patterns for those settings.

If the server is new, XClarity Administrator learns the manufacturing settings. If the server 
is managed by XClarity Administrator, XClarity Administrator uses the customized 
settings. You can then modify the settings specifically for the server that the pattern is to 
be deployed.

7. After the pattern is created, you can view the captured settings. In the Local Storage tab, 
you can specify the storage configuration, disable local storage, keep the default settings, 
or keep existing storage configuration on target, as shown in Figure 11-63. For this 
example, we leave the settings as default.

Figure 11-63   Local Storage tab

8. Click Next to continue 
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9. Click the I/O Adapters tab, in which you can view the current servers I/O Adapters 
settings, as shown in Figure 11-64.

Figure 11-64   I/O Adapters learned settings

If wanted, you can modify adapter addressing and define more adapters to match the 
hardware that you expect to configure with this pattern; however, we leave the captured 
values as they are for now.

10.Click Next to Continue

11.Click the Boot tab (as shown in Figure 11-65 on page 309), you can view the current Boot 
order preferences. We select Leave as default for now; however, this setting can be 
modified later by using this template to create a pattern to roll out to other x240 M5 
compute nodes.

Note: If you plan to deploy UEFI enabled operating systems, you must configure the 
wanted UEFI boot order outside of this pattern.
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Figure 11-65   System boot preferences

12.Click the Firmware settings tab (as shown in Figure 11-66 on page 310), which includes 
the IMM and Server Firmware settings (UEFI). The following categories are listed with 
their corresponding Learned Pattern, as shown in Figure 11-66 on page 310. For more 
information about defining Firmware settings, see “Defining firmware settings” on 
page 280:

– System Information: System Information pattern controls:

• Automatic System name generation
• Contact name
• Location Description

– Management interface: Management Interface patterns control IMM Management 
Interface configurations:

• Automatic host name generation
• Management IP Address assignment
• Domain Name System (DNS) settings
• Interface Speed settings.

– Device and IO Ports-Devices and IO port pattern controls:

• Console redirection and COM ports
• PCIe Gen Speed
• On-board Devices
• Adapter Option ROM
• Option ROM Execution Order
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– Extended IMM: This settings pattern controls all other IMM settings. Extended Settings 
patterns are automatically created when a server pattern is created from a server. 
Extended settings patterns cannot be created from scratch because the settings must 
be learned from a live server.

– Extended UEFI: This settings pattern controls all other UEFI Settings. Extended 
Settings Patterns are automatically created when a server pattern is created from a 
server. Extended settings patterns cannot be created from scratch because the 
settings must be learned from a live server.

Figure 11-66   Learned Firmware settings for IMM and UEFI.

13.After your server pattern is configured, click Save or Save and Deploy, as shown in 
Figure 11-66.

If you click Save, XClarity Administrator saves the Learned Server Pattern.

If you click Save and Deploy, XClarity Administrator saves the Learned pattern and opens 
the Deploy Server Pattern view, as shown in Figure 11-67 on page 311, where you can 
select other servers to deploy this pattern to or you can deploy this pattern to empty bays 
in a Flex Chassis in anticipation of extra servers being installed in the environment.
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Figure 11-67   Deploy Server Pattern

Consider the following points: 

– Applicable servers are marked with the ready status . 

– You can filter on various aspects; however, to see only the systems that feature a 
deploy status of Ready, enter ready in the Filter View field or click Any Deploy 
Status → Deploy Status → Ready, as shown in Figure 11-68.

Figure 11-68   Filter options to see applicable systems only

– If you want to include empty bays, you must select Show Empty Bays, as shown in 
Figure 11-69 on page 312.
Chapter 11. Configuration patterns 311



Figure 11-69   Show Empty Bays and Ready status filter options

14.For now, we select Cancel, save the learned pattern, and opt to deploy the server pattern 
another time.

15.The Configuration Patterns, Server Patterns view opens, as shown in Figure 11-70. Here, 
you see the pattern in the table that was created from the x240 M5 system.

Figure 11-70   Server Pattern tab view with learned pattern shown

Note: If you select this pattern again, the following options are available:

� Create New pattern
� Copy this pattern
� Edit this pattern
� Rename this pattern
� Delete this pattern
� Deploy this pattern

These options can be chosen by clicking the specific icons, as shown in Figure 11-71 
on page 313. You also can select the pattern, then click All Actions and the all actions 
menu is available with which you can select the option that you need, as shown in 
Figure 11-71 on page 313.
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Figure 11-71   Options available on patterns listed

The process that is used to create a server pattern from scratch is described next.

11.6.2  Creating a pattern from scratch

Complete the following steps to create a server pattern from scratch:

1. From the XClarity Administrator menu bar, click Provisioning → Patterns, as shown in 
Figure 11-56 on page 304.

2. Click the Server Patterns tab, if it is not selected.

3. Click the Create icon .

4. Click Create a new pattern from scratch to use default settings, as shown in 
Figure 11-72.

Figure 11-72   Create a new pattern from scratch option
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5. You are prompted to specify the pattern’s Form Factor, as shown in Figure 11-73.

Figure 11-73   Form factor selection

Click the drop-down menu  and make your selection: Flex Compute Node or System 
x Server.

For Flex systems, use a “Flex Compute Node” pattern.

For rack systems, use a “System x Server” pattern.

When you make a selection, you might be prompted the notification that is shown in 
Figure 11-74. Click Change.

Figure 11-74   Check when changing form factor

Note: The options that are presented on the remaining tabs might differ depending on 
whether you are creating a new pattern for a Flex compute node or rack server.
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6. Enter the name of the pattern and a description then, click Next, as shown in 
Figure 11-75. 

Figure 11-75   New System x Server Pattern
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The Storage Tab opens, as shown in Figure 11-76.

Figure 11-76   Local Storage tab storage options.

7. Select the local storage configuration. For information about local storage settings, see 
“Defining local storage” on page 271. Click Next.

8. Specify the I/O adapters that you want configured with this server pattern. 

Optionally, you can modify the adapter addressing and define more adapters to match the 
hardware that you expect to configure with this pattern. Click Next.

For information about I/O adapter settings, see “Defining I/O adapters” on page 274.

9. Define the boot order to be applied when this pattern is deployed to a server and click 
Next.

For more information about defining the server boot options and SAN boot targets 
settings, see “Defining boot options” on page 279.

10.Select server firmware settings from the list of category patterns or create a category 
pattern. For information about firmware settings, see “Defining firmware settings” on 
page 280.
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11.Click Save to save the pattern and the server pattern appears in the Configuration 
Patterns:Server Patterns table.

You also can click Save and Deploy to save and immediately deploy the pattern to one or 
more servers. If you choose this option, the Deploy Server Pattern - Pattern Name page 
appears, as shown in Figure 11-77. 

Figure 11-77   Deploy Server pattern page

12.You can select an alternative Pattern from your available patterns or leave on the current 
pattern that is configured.

13.For Activation, select the following required option: 

– Full: Activates all settings and restarts the server now.

– Partial: Activates IMM settings but does not restart the server. UEFI and server settings 
are active after the next restart.

– Deferred: Generates a profile with the settings for review, but does not activate settings 
on the server.

14.Choose one or more applicable servers or empty chassis bays (by selecting the option to 
Show Empty Bays, as highlighted in Figure 11-77) to which you want to deploy the server 
pattern. 
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15.If you select the Show Empty Bays option, the bays are displayed in the available list of 
servers, as shown in Figure 11-78.

Figure 11-78   Empty Bays available for provisioning

16.After you selected the servers or empty bays, click Deploy.

Deploying a pattern to an Empty Bay or Placeholder chassis: You can also deploy 
a server pattern to one or more empty bays in a chassis that is managed by XClarity 
Administrator or in a placeholder chassis. A placeholder chassis is a Flex Chassis that 
can be pre-provisioned before the hardware is installed. 

Deploying a server pattern before the compute node is installed reserves management 
IP addresses, reserves virtual Ethernet or Fibre Channel addresses, and pushes the 
network setting to the relative switch internal ports.

For more information about working with Placeholder Chassis, see the Lenovo XClarity 
information center that is available at this website:

http://www-01.ibm.com/support/knowledgecenter/api/redirect/flexsys/informati
on/topic/com.lenovo.lxca.doc/server_workwithplaceholderchassis.html
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17.A notification window opens to reconfirm whether you want to deploy to the servers that 
are displayed in the list, as shown in Figure 11-79. (You can click Cancel and you are 
returned to the previous window.) 

Figure 11-79   Notification to reconfirm whether to deploy server pattern

Click Deploy to deploy the server pattern to your selected servers or empty bays.

18.You are notified that the deployment request was submitted and that you can monitor the 
progress by clicking Jump to Jobs Page. You also can view the profile creation progress 
by clicking Jump to Profiles page. Server profiles do not appear in the Server profiles 
table until the profile is created, as shown in Figure 11-80.

Figure 11-80   Configuration Patterns: Server Profiles page

For more information about working with Server profiles, see 11.7, “Server profiles” on 
page 320.
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11.7  Server profiles 

A server profile is an instance of a server pattern that is applied to a specific server. The 
server profile contains server-specific configuration, including assigned name, IP addresses, 
and MAC addresses.

Server profiles are generated and assigned automatically when a server pattern is deployed 
to one or more servers. One server profile is created for each target server. Each server 
profile represents the specific configuration of a single server and contains information (such 
as assigned IP addresses and MAC addresses) that is unique for that specific server.

The server profile is activated during the IMM start process. You can choose to perform the 
following tasks:

� Reboot the server when the pattern is deployed to activate the server profile immediately
� Defer activation until the next reboot
� Defer activation until you manually activate the server profile

Multiple server profiles can inherit properties from a single-server pattern. After a server 
pattern is deployed to one or more servers, you can quickly deploy configuration changes to 
multiple servers by editing the parent server pattern and category patterns. The dependant 
server profiles are automatically updated and redeployed to their associated servers. By 
editing the server pattern, you can control a common configuration from a single place.

If you replace a server or if you install a pre-provisioned compute node in an empty bay, you 
must activate the server profile for that new server to provision the configuration changes on 
the new server.

You can change the server profile that is associated with a server by using the following 
methods, depending on the reason for changing:

� If you want to move or repurpose a server:

a. Deactivate the current server profile on the current server (see 11.7.1, “Deactivating a 
server profile” on page 321).

b. Deploy the new server pattern to the new server.

� If a server failed and you want to use a spare server in its place:

a. Deactivate the current server profile on the failed server (see 11.7.1, “Deactivating a 
server profile” on page 321).

b. Activate the same server profile on the spare server (see 11.7.2, “Activating a server 
profile” on page 324).

c. When the failed server is fixed, you can repeat these steps to switch the profile again.

� If a server failed and you want to replace the hardware:

a. Deactivate the current server profile on the failed server see 11.7.1, “Deactivating a 
server profile” on page 321).

b. Replace the failed server.

c. Activate the same server profile on the new server (see 11.7.2, “Activating a server 
profile” on page 324).

Deploying Server Patterns: You can deploy a server pattern to multiple servers; however, 
multiple patterns cannot be deployed to a single server.
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11.7.1  Deactivating a server profile

You can remove a server profile from a server or chassis bay by deactivating the profile.

Complete the following steps to deactivate a server profile:

1. From the XClarity Administrator menu bar, click Provisioning → Server Profiles. The 
Configuration Patterns: Server Profiles page is displayed, as shown in Figure 11-81.

Figure 11-81   Server Profiles page

2. Select the server profile to deactivate. The current state of the server profile is listed in the 
Profile Status column, as highlighted in Figure 11-81. Click the Deactivate server profile 
icon .

3. If you are deactivating a Server profile, you might be prompted to choose one or both of 
the following deactivation options, as shown in Figure 11-82 on page 322:

Setting retained by the server when a server profile is deactivated: Servers retain 
their identification information (for example, host name, IP address, and virtual MAC 
address) when a profile is deactivated. To avoid name and address conflicts, ensure that 
you clear any identification information that is on the original server before you activate an 
inactive profile on a different server.
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Figure 11-82   Deactivating a server profile

– Reset IMM to defaults

This option resets the identity information, including host name and management 
interface IP address, and resets IMM to the default settings. The reset IMM to defaults 
option is not selected by default, unless the user specified a Management Interface 
pattern that defines an address pool-assigned IP or custom host name; then, the 
option is selected for that profile.

Resetting the IMM is necessary to avoid IMM address and host name conflicts with the 
addresses that are assigned to the deactivated profile.

If you select to Reset IMM to defaults: You must be aware that selecting this 
option resets the IMM back to factory defaults. Consider the following points:

� For a flex node, the CMM and XClarity Administrator can maintain 
communication with the server. The system also can be configured by deploying 
another pattern to the server that configures the IP and host name or via the 
following method to configure the Chassis IP addresses:

a. From the XClarity Administrator console, click Hardware → Flex Chassis.

b. Select the Flex Chassis that you want to configure and click Actions → Edit 
Management IP Addresses.

c. Collapse or Expand the different sections, find the Compute node IP settings 
section, and enter the IPv4 Address, as appropriate.

d. Click Save.

� For a Rack Server, IMM must be configured again via the IMM CLI or via the web 
console by using the Factory Default, IP Address, User ID, and Password to 
access the server:

– IP Address: The default static IPv4 address that is assigned to the IMM2 is 
192.168.70.125. The IMM2 initially is configured to attempt to obtain an 
address from a DHCP server. If it cannot obtain the address, it uses the static 
IPv4 address and the default subnet is 255.255.255.0 (class C).

– Login credentials: USERID and Passw0rd (with a zero, not letter O).
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– Power off the ITE: Powers off the server. When the server is powered back on, virtual 
address assignments revert to the burned in defaults.

4. After you make your selection, then click Deactivate.

The deactivation process begins as shown in Figure 11-83 on page 323.

Figure 11-83   Deactivation process

5. After the deactivation process is complete, you see a Profile deactivation Summary 
window, as shown in Figure 11-84. To close the window, click Close.

Figure 11-84   Deactivation summary 

The state of the server profile on the Configuration Pattern: Server Profiles page changes 
to Inactive, as shown in Figure 11-85.

Risk of duplicated Virtual addresses when Sever Profiles are used: When a 
server profile is deactivated, you can select the Power off the ITE option. If you 
select this option, the Virtual Addressing is removed from the server; however, if you 
do not select this option, the server does not power off and the Virtual Addressing is 
not removed. Also, you can see the situation in which two nodes can have the same 
virtual addressing if this server profile is activated on another node. Therefore, 
ensure that you Power Off/ Power Cycle the Server if you want to remove the Virtual 
Addressing. 
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Figure 11-85   Server profile now inactive

11.7.2  Activating a server profile

You can activate a server profile on a replaced, reassigned, or newly installed and managed 
server. If you replace a server or if you install a pre-provisioned compute node in an empty 
bay, you must activate the server profile for that new server to provision the configuration 
changes on the new server.

Complete the following steps to activate a server profile:

1. From the XClarity Administrator menu bar, click Provisioning → Server Profiles. The 
Configuration Patterns: Server Profiles page is displayed, as shown in Figure 11-86.

Figure 11-86   Configuration Patterns: Server Profiles page

Retained server settings when a server profile is deactivated: Servers retain their 
identification information (for example, host name, IP address, and virtual MAC address) 
when a profile is deactivated. To avoid name and address conflicts, ensure that you clear 
any identification information that is on the original server before you activate an inactive 
profile on a different server. This process also requires the original server to be powered 
off.
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2. Select the server profile to activate. The current state of the server profile is listed in the 
Profile Status column. You can activate server profiles that are in the Inactive or Pending 
activation state, as shown in Figure 11-86.

3. Click the Activate server profile icon .

4. Select the server on which you want to activate the profile and click Activate. 

The state of the server profile on the Configuration Pattern: Server Profiles page changes 
to Active, as shown Figure 11-87. 

Figure 11-87   Server Profile now active
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Chapter 12. Service and support

The Lenovo XClarity Administrator web interface provides a set of tools that you can use to 
define support contacts for each managed endpoint, collect diagnostic data and send that 
data to Lenovo Support, set up automatic notification to Lenovo Support when a serviceable 
event occurs on your system, view problem-report status. You can contact Lenovo Support to 
get help and technical assistance when you run into problems.

Topics in this chapter are:

� 12.1, “Setting up Call Home” on page 328
� 12.2, “Viewing problem records and status” on page 332
� 12.3, “Opening a service ticket” on page 332
� 12.4, “Downloading and collecting diagnostic files” on page 334
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12.1  Setting up Call Home

You can configure XClarity Administrator to automatically notify Lenovo Support when certain 
serviceable events are received from the managed endpoints, such as an unrecoverable 
memory error from a System x rack server. This automatic support notification is called call 
home.

Call Home is disabled by default, you will need to configure and enable it. There are three 
possible usage scenarios: 

� Call home is configured and enabled

When call home is configured and enabled, XClarity Administrator automatically opens a 
service ticket and transfers diagnostic files to the Lenovo Support Center when a 
serviceable event occurs so that the issue can be addressed. 

Note: When call home is enabled in XClarity Administrator, call home is disabled on 
managed chassis and rack servers to avoid duplicate problem records from being created.

� Call home is configured but not enabled

If call home is configured but not enabled, you can manually open a service ticket using 
the call home function to collect and transfer diagnostic files to the Lenovo Support Center 
at any time. For more information, see Opening a service ticket.

� Call home is not configured

If you decided not to use call home, you can still manually open a service ticket and send 
diagnostic files to the Lenovo Support Center by following the instructions on the Service 
requests and PMRs website. For information about collecting and downloading 
diagnostic logs, see Downloading XClarity Administrator diagnostic files and Collecting 
and downloading diagnostic files for an endpoint.

For information about viewing the problems records that have been opened automatically by 
call home, see 12.2, “Viewing problem records and status” on page 332.

Complete the following steps to configure and enable call home:

1. Ensure that all ports that are required by XClarity Administrator (including ports that are 
required for call home) are available before you enable call home. For more information 
about ports, see 2.2, “Port requirements” on page 16.

2. Ensure that a connection exists to the Internet addresses that are specified in the 
following table.(Table 12-1) Because the IP addresses might change, use the DNS name 
when possible.

Table 12-1   Required connection for call home

3. If XClarity Administrator does not have a direct connection to the Internet, ensure that the 
proxy server is configured to use basic authentication.

4. From the XClarity Administrator menu bar, click Administration → Service and Support. 
The Service and Support page is displayed.

5. Click the Call Home Configuration tab.

DNS name IP address range

esupport.ibm.com 129.42.0.0/18
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6. Fill in the required field (marked with *) in the configure call home section. See Figure 12-1

Figure 12-1   Fill in required information and click apply

7. Optional: Fill in the system information.

Note: This box does not 
become active until all 
mandatory fields  (with a 
*) are filled in plus the 
Apply button  is clicked.





Will not work until all 
required information 
(with a *) are filled in and 
Apply button clicked.

Please refer to “Re-enabling 
call home on all managed 
endpoints” on page 331
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8. Optional: Select Enable Proxy if you need the call home communication to route through 
a proxy server. All fields will now be mandatory.

Figure 12-2   Proxy configuration

Note: Ensure that the proxy server is configured to use basic authentication

9. Once all the necessary information have been filled in. Click Apply

Note: You can now test your configuration by clicking on the Test Configuration button. 
the test will take a few minutes and return successful if the setting are valid.

10.The Enable Call Home checkbox will now be active.

11.Click Enable Call Home

Note: Once the box is checked, XClarity Administrator will initiate a test configuration. This 
is only done for the first time you enable call home.

Within a few minutes, you should be get an automated email. Example shown in 
Figure 12-3.

Figure 12-3   Email acknowledgement with names and serial number greyed out.

Create separate contact and location information
When an event triggers the call home service, XClarity Administrator will use the contact and 
location information that is specified in the call-home configuration (on the Call Home 
Configuration tab).
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You can separately specify the contact and location information on a particular endpoint so 
that when a call home event is triggered on that endpoint, the specific contact and location is 
used. Specifying contact and location information for a specific endpoint is valuable in cases 
where different endpoints are administered by different users.

To define the call home contact and location information for a specific endpoint:

1. click Administration → Service and Support. The Service and Support page is 
displayed.

2. click on the Endpoint Actions tab

3. Select the endpoint (CMM or IMM) you want to configure

4. You can create ( ), edit ( ) or delete ( ) a contact profile by clicking on the 
respectively icon. As shown in Figure 12-4

Figure 12-4   Create, edit or delete

Re-enabling call home on all managed endpoints
When the call home is enabled in XClarity Administrator, call home is disabled on each 
managed endpoint to avoid duplicate problem records from being created. If you intend to 
discontinue using XClarity Administrator to manage your endpoints, you can re-enable call 
home on all managed endpoints from the XClarity Administrator web interface in lieu of 
re-enabling call home for each individual endpoint at a later time.

Complete the following steps to re-enable call home on all managed endpoints.

1. From the XClarity Administrator menu bar, click Administration → Service and Support. 
The Service and Support page is displayed.

2. Click on the Call Home Configuration tab.

3. Uncheck Enable Call Home to disable call home for XClarity Administrator.

4. Click Enable Call Home on all endpoints.

Note: Re-enabling call home on all endpoints might not cause call home to become 
operational for those endpoints. Configuration might be required on each individual 
endpoint if it had not been configured previously.
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12.2  Viewing problem records and status

You can view problem records that have been opened automatically by call home, including 
the current status and diagnostic files that were transmitted to the Lenovo Support Center.

To view the electronic service requests that have been submitted to the Lenovo Support 
Center, click the Administration → Service and Support, and then click the Problem 
Record Status tab, as shown in Figure 12-5.

Figure 12-5   Problem Record Status Tab

If you know that a event was triggered but does not show in the list, you may need to click on 
the refresh button  to get the full list.

The State column will display the status of the problem record. You can click on Refresh 
Server List button  to force the update of the list. It will retrieved the “state” from the 
support center’s system. Example of a list that was before (Figure 12-5) and after “refreshed”, 
(Figure 12-6).

Figure 12-6   Problem record status after refresh

Users can choose to delete those problem records (State = Closed) from the list by selecting 
the record and click on the Delete problem records button .

12.3  Opening a service ticket

If call home is enabled, XClarity Administrator opens a service ticket, collects and downloads 
diagnostic files, and sends them to Lenovo Support Center automatically when a serviceable 
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event occurs. You can also perform the same actions manually at any time. Opening a 
service ticket starts the process of determining a solution to your problem by making the 
pertinent information available to Lenovo Support quickly and efficiently. Lenovo service 
technicians can start working on your solution as soon as you have completed and submitted 
a service ticket.

Complete the following steps to manually open a service ticket.

1. From the XClarity Administrator menu bar, click Administration → Service and Support. 
The Service and Support page is displayed.

2. Click on the Endpoint Actions tab.

3. Select the endpoint that you want to open a service ticket.

4. Click the All Action → Manually Open Service Ticket. As shown in Figure 12-7

Figure 12-7   Manually open a service ticket

5. You will get a pop-up message windows, as shown in Figure 12-8.

Figure 12-8   Submitting the service ticket
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6. Call home needs to be enabled for the above function to work. If Call Home is not enabled 
or configured, you will get a error message, as shown in Figure 12-9.

Figure 12-9   Error message if call home is not enabled

If call home is not configured or enabled, you can submit a service ticket by following the 
instructions on the Service requests and PMRs website.

https://www-947.ibm.com/support/servicerequest/Home.action 

12.4  Downloading and collecting diagnostic files

XClarity Administrator includes multiple logs for each component of the management server. 
Each component’s loggers operate in their own in-memory buffer. Their granularity and buffer 
size can be modified as shown in Figure 12-10.

Figure 12-10   Log Setting Tab

However we do not recommend changing their default values unless directed by the Service 
Center to aid in troubleshooting of a specific problem.

If XClarity Administrator detects an internal exception, data is automatically collected and an 
entry is created in the Management Server Files tab. The LogDump ID specifies the 
component of XClarity Administrator that posted the exception.
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Each log file that was captured will have a LogDump component ID. The component ID range 
are listed Table 12-2.

Table 12-2   Component ID

Note: The LogDump Configuration ID is correct as of July 2015. Additional IDs may be added 
in the future when new features are added to XClarity Administrator.

If the problem at hand is known to be related to a particular component in XClarity 
Administrator, the Lenovo Support personnel may ask that you only download and sent to 
them the required log files based on their component ID. An example as shown in 
Figure 12-11

Figure 12-11   Log file with component ID

Download all log files by clicking the  Download Logs Only, or download all service data 
(including diagnostic data and logs) by clicking the  Download All Service Data.

LogDump Configuration ID Component name

00001 - 01000 Data Management

01001 - 02000 Events / monitoring

02001 - 03000 Core / virtual Appliance

03001 - 04000 Security

04001 - 05000 Service & Support (includes Call Home)

05001 - 06000 Configuration Patterns

06001 - 07000 Updates

07001 - 08000 Backup / Restore & Failover (HA)

08001 - 09000 Flexcat (bare metal OS deployment)

09001 - 10000 Remote Control

10001 - 11000 Jobs Framework

JobDump 
component ID
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A message is displayed that shows the estimated amount of data to be collected. 
Downloading all service data or log files might take a significant amount of time, depending 
on the number and size of the diagnostic files. As shown in Figure 12-12

Figure 12-12   Generate archive and save to system

Note: Ensure that you do not already have a job in progress for downloading all service data 
(see Monitoring jobs). If a user started a job that is still in progress, that same user must wait 
until the job completes before attempting to download all service data again; otherwise, the 
second attempt will fail.

When the diagnostics-log repository reaches its maximum capacity, the oldest set of 
diagnostic logs is deleted to make room for the new log.

Remove all log files by clicking the Clear all logs icon .

Downloading XClarity Administrator diagnostic files
XClarity Administrator maintains a collection of logs and diagnostic files whenever an alert 
occurs on XClarity Administrator. You can download and send these logs and diagnostic files 
(also called service data or first failure data capture) to Lenovo Support so that Lenovo 
Support can assist in resolving issues that might arise.

Work with Lenovo Support to determine if you should download all diagnostic files or 
download selected diagnostic files. Complete the following steps to download the diagnostic 
file:

1. From the XClarity Administrator menu bar, click Administration → Service and Support. 
The Service and Support page is displayed.
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2. Click on the Management Server Files tab (if you are on a different tab). As shown in 
Figure 12-13

Figure 12-13   Management Server Files tab

3. Select the log that you want to download, and click the Download Selected Log icon 
( )

4. Save the log to local system. The log is saved as a zip file.

5. Send the file to Lenovo Support.

Collecting and downloading diagnostic files for an endpoint
When you have an issue on a chassis or server that requires the assistance of Lenovo 
Support, you will be ask to collect, download and sent to them the logs and diagnostic files.

The diagnostic files (also called service data) and a list of inventory (called first failure data 
capture or FFDC) of an endpoint will help to identify the cause of the issue. 

Even with call home configured and enabled, Lenovo Support Center may require additional 
data, or you may be ask to re-collect diagnostic data for that endpoint or for another endpoint. 

Complete the following steps to download the diagnostic file:

1. From the XClarity Administrator menu bar, click Administration → Service and Support. 
The Service and Support page is displayed.

2. Click on the Endpoint Actions tab. 

3. Select the endpoint for which you want to collect data, and click the Collect Service data 
icon .

4. It will take a while for XClarity Administrator to collect the service data, a pop-up window 
will appear showing the progress.

Do not change unless 
directed by Lenovo 
Support!
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5. When the collection is finished, a Archive Options windows will pop-up, as shown in 
Figure 12-14.

Figure 12-14   Archive options

6. You can associate the log files with the existing Problem record number by selecting the 
Problem record number (radio button) and click Associate.

7. You can then click the Download button to immediately download the files to your 
workstation or close the Archive Options windows without downloading the file.

8. The Server data collected is packaged in one TGZ file and you can find it at the Endpoint 
Diagnostic Files tab, as shown in Figure 12-15

Figure 12-15   Endpoint Diagnostic Files tab

Note: Click the refresh button  to display the latest collected files.

9. You can select it and download as required.
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Chapter 13. Backup, restore, updates, and 
maintenance

It is important to have a backup and maintenance plan for your environment. If you have 
backup and maintenance procedures in place, such procedures must be expanded to include 
Lenovo XClarity Administrator. If the procedures are not expanded, you must start planning 
for such an expansion.

This chapter includes the following topics:

� 13.1, “Backup and restore” on page 340
� 13.2, “Updating the XClarity Administrator virtual appliance” on page 353
� 13.3, “Shutting down or restarting XClarity Administrator” on page 359
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13.1  Backup and restore

XClarity Administrator is packaged as a virtual appliance. It contains a pre-built virtual 
machine (VM) with an operating system and the XClarity Administrator application installed. It 
does not feature built-in backup and recovery functions. We rely on the backup and recovery 
functions that are available on the virtual-host operating system in which the virtual appliance 
is installed.

After the initial setup and configuration of XClarity Administrator, create a backup of the 
appliance (VM). It is also a good practice to perform a backup regularly and before any of the 
following major configuration changes:

� Updating the XClarity Administrator server
� Managing new chassis or rack servers
� Adding users to XClarity Administrator
� Creating and deploying new configuration patterns

XClarity Administrator appliance is available in two versions: one for VMware ESXi and the 
other for Microsoft Hyper-V.

13.1.1  Backing up XClarity Administrator from VMware ESXi

There are many third-party applications available to perform the backup and recovery 
operation. We describe the use only of the native tools of your vSphere environment to 
perform the backup.

If your VMware infrastructure includes vCenter, you can use the backup capability that is 
provided with vCenter to back up XClarity Administrator.

If you do not have vCenter in your environment, use vSphere client to perform the backup.

As described VMware knowledge base article number 1025279, we do not recommend the 
use of the snapshots feature as a means to perform backup and recovery:

http://kb.vmware.com/selfservice/microsites/search.do?cmd=displayKC&externalId=102
5279 

The basic concept of a backup simple and straightforward. The process includes the following 
overall steps:

1. Shut down the VM.
2. Locate the data store where the XClarity Administrator VM is installed.
3. Create a folder.
4. Copy all files in the XClarity Administrator folder to the new folder.

Note: Before any backup, ensure that there are no running jobs and that you have 
shutdown the XClarity Administrator VM.
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Use of vSphere Client to manually back up the VM
Complete the following steps to create a backup of the XClarity Administrator VM on the ESXi 
host by using the VMware vSphere Client:

1. From the XClarity Administrator menu bar, click Administration → Shut Down 
Management Server → Shutdown, as shown in Figure 13-1.

Figure 13-1   Shut Down Management Server option

2. You then see Figure 13-2 to confirm the shutdown.

Figure 13-2   Shutdown

3. Start your VMware vSphere Client and connect to your ESXi server that hosts the XClarity 
Administrator VM.

4. Create a folder in the data store that contains the backup files:

a. Select the ESXi host in the navigation tree and then, click the Configuration tab in the 
right window.

a. Click Storage.

b. Right-click the datastore for XClarity Administrator, and then, click Browse Datastore, 
as shown in Figure 13-3.
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Figure 13-3   Selecting Browse Datastore option

c. Select the root folder and create a folder in which a copy of the XClarity Administrator 
files is placed, as shown in Figure 13-4.

Figure 13-4   Creating a backup folder

5. Click the XClarity Administrator folder. Select all of the files in the folder and then copy 
them to the backup folder that you created.

6. After all of the files are copied, you can restart the XClarity Administrator VM from the 
VMware vSphere Client.

Use of the vSphere Web Client to manually back up the VM
Complete the following steps:

1. Shut down the XClarity Administrator VM.

2. Start your vSphere Web Client and login to your vCenter.

3. Select the ESXi server that host the XClarity Administrator VM.

4. Click the Related Objects tab.

5. Click Datastores.

6. Right-click the datastore where XClarity Administrator is installed.
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7. Click Browse Files, as shown in Figure 13-5.

Figure 13-5   Web Client: Browse Files option

8. Click the Create a New Folder icon to create a folder, as shown in Figure 13-6.

Figure 13-6   Creating a folder for backup

9. Locate the XClarity Administrator VM folder and copy all files to the new folder.

10.Restart the XClarity Administrator VM after all files are copied.

13.1.2  Restoring XClarity Administrator from VMware ESXi

There are instances in which you must restore XClarity Administrator. Depending on the 
specific backup method that you used to back up the XClarity Administrator VM, we 
recommend that you use the same method to recover the XClarity Administrator VM.

The restore procedure that is described in this section is based on creating a backup by using 
the procedure that is described in 13.1.1, “Backing up XClarity Administrator from VMware 
ESXi” on page 340.

The process includes the following overall tasks:

1. Shut down and delete the XClarity Administrator VM.
2. Locate your backup XClarity Administrator folder.
3. Copy all files in the backup folder to the XClarity Administrator folder.
4. Select the file with extension of VMX and right-click Add to Inventory.
5. Restart the XClarity Administrator VM.

Complete the following steps to restore XClarity Administrator from a backup by using the 
VMware vSphere Client:

1. Start the VMware vSphere Client and connect to the ESXi host on which XClarity 
Administrator is installed.
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2. Right-click XClarity Administrator VM in the left navigation tree and then, click Power → 
Power Off, as shown in Figure 13-7.

Figure 13-7   Power off XClarity Administrator VM

3. After the VM is powered off, right-click XClarity Administrator VM in the left navigation 
tree and then, click Remove from Inventory, as shown in Figure 13-8.

Figure 13-8   Remove XClarity Administrator VM from inventory

4. Select the ESXi host in the navigation tree and then, click the Configuration tab in the 
right window.

5. Click Storage.
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6. Right-click the datastore for XClarity Administrator and then, click Browse Datastore, as 
shown in Figure 13-9.

Figure 13-9   Browse VMFS Datastore

7. Select the XClarity Administrator folder.

8. Delete all files in the folder.

9. Select the folder where the backup files are stored.

10.Select all of the files in the folder and copy them to the XClarity Administrator folder.

11. In the XClarity Administrator folder, right-click the VMX file and then, click Add to 
inventory, as shown in Figure 13-10.

Figure 13-10   Add to Inventory
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12.Complete the wizard to add XClarity Administrator, as shown in Figure 13-11.

Figure 13-11   Add to Inventory wizard

13.Restart XClarity Administrator from the VMware vSphere Client.

14.When you restart the backup VM, the operation pauses. You see your VM with a small 
yellow icon next to it, as shown in Figure 13-12. 

Figure 13-12   Restart operation paused for input select from user

15.Click the Summary tab and select I Moved It, as shown in Figure 13-13. Click OK.

Figure 13-13   Select I Moved It
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The following variation can be used. 

1. Start the VMware vSphere Client and connect to the ESXi host on which XClarity 
Administrator is installed.

2. Right-click Lenovo XClarity Administrator VM in the left navigation tree and then, click 
Power → Power Off.

3. Right-click Lenovo XClarity Administrator VM in the left navigation tree again and then, 
click Delete from Disk.

4. Select the ESXi host in the navigation tree and then, click the Configuration tab in the 
right window.

5. Click Storage.

6. Right-click the datastore for XClarity Administrator and then, click Browse Datastore.

7. Select the folder where the backup files are stored.

8. In the folder, right-click the VMX file and then, click Add to inventory.

9. Complete the wizard to add XClarity Administrator.

10.Restart XClarity Administrator from the VMware vSphere Client.

11.When you are prompted to choose whether the VM was moved or copied, select I Moved 
It in Figure 13-13 on page 346

The difference between these processes is that with the variation, you are now working 
directly with your backup copy. If there is another issue with this copy that you must restore 
again, you can restore only from previous (older) version of the backup.

The advantage of this variation is that you can get XClarity Administrator back up quicker 
(minus the delete files and copy files step).

13.1.3  Backing up XClarity Administrator from Microsoft Hyper-V

XClarity Administrator is packaged as a virtual appliance. It contains a pre-built VM with an 
operating system and the XClarity Administrator application already installed. 

There are many other methods that can be used to perform the back, including the use of 
third-party software (free or paid license) that runs on a Microsoft Hyper-V. For this example, 
we focus on the use of the native feature in Microsoft Windows, Windows Server Backup 
perform the backup and recovery operation.

Before a backup is created, ensure that no jobs are running on XClarity Administrator. For 
more information about jobs, see 7.6, “Monitoring jobs” on page 190.

Note: If you select I Copied It in Figure 13-13 on page 346, the VM is assigned a unique 
ID (UUID) that is different than that of the original VM, which makes the VM act as a new 
instance that cannot see the managed endpoints. 
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if you do not have Windows Server Backup installed, complete the following steps:

1. Start Server Manager Dashboard.

2. Select Add roles and features, as shown in Figure 13-14.

Figure 13-14   Server Manager Dashboard

3. Select the Windows Server Backup option, as shown in Figure 13-15.

Figure 13-15   Select Windows Server backup option
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4. Click Install to start the installation and complete the wizard, as shown in Figure 13-16.

Figure 13-16   Click Install to start the installation

Complete the following steps to back up XClarity Administrator by using Windows Server 
Backup:

1. Start Windows Server Backup and browse to Local Backup.

2. In the Action window, click Backup Once to start the Backup Once Wizard, as shown in 
Figure 13-17.

Figure 13-17   Local Backup, Backup Once
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3. On the Backup Options page, click Different Options and then, click Next, as shown in 
Figure 13-18.

Figure 13-18   Different options

4. On the Select Backup Configuration page, click Custom and then, click Next, as shown in 
Figure 13-19.

Figure 13-19   Backup Configuration - Custom

5. On the Select Items for Backup page, click Add Items to open the Select Items window.
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6. Expand the Hyper-V item, click Lenovo XClarity Administrator VM, and then, click OK, 
as shown in Figure 13-20.

Figure 13-20   Add item to backup

7. In the Select items for Backup window, click Next to continue.

8. On the Specify Destination Type page, choose the type of storage for the backup (a local 
drive or a remote shared folder) and then, click Next, as shown in Figure 13-21.

Figure 13-21   Select backup destination type
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9. On the Select Backup Destination or Specify Remote Folder page, specify the location to 
which you want the backup stored and then, click Next.

10.Click Backup to start the backup process, as shown in Figure 13-22.

Figure 13-22   Backup in progress

11.After the backup completes, close the wizard.

13.1.4  Restoring XClarity Administrator from Microsoft Hyper-V

Depending on the method that you used to backup the XClarity Administrator VM, you use 
the same tool to restore the VM. The specific process that is used to restore from a backup 
often is based on the process that was used to create the backup. For example, used 
Windows Backup Server to backup the VM; therefore, we use it to restore the VM.

Complete the following steps to restore XClarity Administrator from a backup by using 
Windows Server Backup.

1. Start Windows Server Backup and browse to Local Backup.

2. In the Action panel, click Recover to start the Recovery Wizard.

3. On the Getting Started page, specify the location where the backup is stored and then, 
click Next.

4. On the Select Backup Date page, choose the backup that you want to restore and then, 
click Next.

5. On the Select Recovery Type page, select Hyper-V option and then, click Next.

Note: The backup destination must be a different location from where the VM files are 
kept. You cannot select a volume that includes VM files to store the backup file.
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6. On the Select Items to Recover page, expand Hyper-V and select the XClarity 
Administrator VM. Click Next.

7. On the Specify Recovery Options page, choose VM to its original location and then, 
click Next.

8. On the Confirmation page, click Recover. The VM is restored and registered in Hyper-V.

9. Restart XClarity Administrator from the Hyper-V Manager.

13.2  Updating the XClarity Administrator virtual appliance

Although XClarity Administrator is packaged as a virtual appliance, you can update the virtual 
appliance to install the latest software. You want to install the latest server software that is 
available, which often includes fixes or new features. The release notes list the content of the 
update package.

Before you can update the XClarity Administrator software, you must first check for available 
updates and then download the update package. XClarity Administrator downloads the 
selected update package from the web and stores the update packages in the updates 
repository.

To check for and download software updates, XClarity Administrator must be connected to 
the Internet. If it is not connected to the Internet, you can manually download the software 
updates from the website to a workstation that has network access to the XClarity 
Administrator host and then import the updates into the updates repository. 

An overview of the update process is shown in Figure 13-23.

Figure 13-23   Overview of update process
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Complete the following steps to update XClarity Administrator:

1. From the XClarity Administrator main menu, click Administration → Update 
Management Server to display the Management Server Update page, as shown in 
Figure 13-24.

Figure 13-24   Update Management Server

2. Download the latest XClarity Administrator update.

Complete the following steps if XClarity Administrator is connected to the Internet:

a. Retrieve information about the latest software updates by clicking the Refresh 
Repository icon . New software updates are listed in the table on the 
Management Server Update page, as shown in Figure 13-25 on page 355.
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Figure 13-25   Updates available after Refreshed the repository

b. Select the software update from the table.

c. Click the Download Selected icon .

You will now see progress of the downloads as shown in Figure 13-26 on page 356. When 
the download is complete, the Download Status for that software update changes to 
Downloaded.

Note: You must acquire the updates before you can perform the update. There might be 
more than one update (such as in the case of FP1, which is a Fix pack 1 and a 
Repository Pack). Select one update by selecting the update and then clicking the 
Download selected icon. Wait for the download to start, then repeat steps b and c for 
the other update.
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Figure 13-26   Downloading update from internet

Complete the following steps if XClarity Administrator is not connected to the Internet:

a. Download the update from the following Fix Central website to a workstation that has 
network connection to the XClarity Administrator host:

http://www.ibm.com/support/fixcentral/ 

b. From the Management Server Update page, click the Import icon .

c. Click Select Files and browse to the location of the update on your workstation. Then, 
click Open.

d. The downloaded update pack must be extracted to a \temp directory. Select all files for 
import, as shown in Figure 13-27.

Figure 13-27   Import update file

e. Click Import.

When the import is complete, the software update is listed in the table on the 
Management Server Update page and the Download Status for that software update is 
“Acquired”, as shown in Figure 13-28 on page 357.
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Figure 13-28   Update imported

3. Back up the XClarity Administrator virtual appliance (see 13.1, “Backup and restore” on 
page 340).

4. Ensure that no jobs are currently running. You can view a list of currently running jobs from 
the Jobs log.

5. Select the update package that you want to install.

6. Click the Perform updates icon, as shown in Figure 13-29.

Figure 13-29   Perform update

7. XClarity Administrator must be restarted for the update process to continue. Click Restart 
to continue, as shown in Figure 13-30.

Figure 13-30   Restart to start the update process
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8. The update process occurs in the background. After some time, your browser 
automatically refreshes and shows the message that it acknowledges the update request, 
as shown in Figure 13-31.

Figure 13-31   Browser showing the message

Tip: There are no visual indications about the progress of updating XClarity 
Administrator in the browser. You can monitor the update progress by connecting to the 
console of your virtual host system, as shown in Figure 13-32.

Figure 13-32   VM Console showing the update in progress
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9. After the virtual appliance is restarted, log in to XClarity Administrator again and click 
Administration → Update Management Server to display the Management Server 
Update page. You see that the virtual appliance was updated to the newer version, as 
shown in Figure 13-33.

Figure 13-33   New version of appliance

13.3  Shutting down or restarting XClarity Administrator

You are required to restart XClarity Administrator in the following situations:

� When a server certificate is regenerated
� When a new server certificate is uploaded

Complete the following steps to restart XClarity Administrator:

1. Ensure that no jobs are running. Jobs that are running are canceled during the shutdown 
or restart process. 
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2. From the XClarity Administrator menu bar, click Administration → Shut Down 
Management Server, as shown in Figure 13-34.

Figure 13-34   Shutdown or Restart server

A confirmation dialog is displayed with a list of jobs that are running. If you shut down or 
restart XClarity Administrator, the jobs are canceled.

3. Click Shut down or Restart.
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Appendix A. MIB Appendix

This appendix describes the Simple Network Management Protocol (SNMP) management 
information base (MIB) for Lenovo XClarity Administrator. 

This management information base (MIB) file describes the SNMP traps that are generated 
by Lenovo XClarity Administrator. You can compile this MIB file in any SNMP trap manager so 
that the SNMP trap sent from Lenovo XClarity Administrator can be rendered meaningfully.

This appendix includes the following topics:

� “Downloading the XClarity Administrator MIB file” on page 362
� “Information contained within the SNMP Traps” on page 363
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Downloading the XClarity Administrator MIB file

At the time of this writing, the Lenovo XClarity Administrator MIB file can be downloaded from 
the following website: 

http://pic.dhe.ibm.com/infocenter/flexsys/information/index.jsp?topic=%2Fcom.lenov
o.lxca.doc%2Fevents_mib.html 

Complete the following steps to download the Lenovo XClarity Administrator MIB file: 

1. Locate the link, as shown in Figure A-1.

Figure A-1   Locate lenovoMgrAlert.Mib file
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2. Right-click the lenovoMgrAlert.Mib link and select Save Link As, as shown in 
Figure A-2.

Figure A-2   Save MIB file 

3. Save the file to your computer, leaving the name of the MIB file as lenovoMgrAlert.mib.

The lenovoMgrAlert.mib file is now ready to be loaded and compiled into any trap receiver. 
For more information about how to compile an MIB file, follow the instructions that were 
included with your trap receiver software.

Information contained within the SNMP Traps

This section describes the information that is contained in the MIB file for XClarity 
Administrator.

The following objects are included in all outgoing SNMP traps: 

� mgrTrapDateTime: Timestamp of Local Date and Time when alert was generated

� mgrTrapAppId: Lenovo Event Manager

� mgrTrapTxtId: Host name or IP address of Lenovo Event Manager server that generated 
the trap

� mgrTrapSysContact: User-configured system contact ID

� mgrTrapSysLocation: User configured system location information

� mgrTrapID: Trap ID, as listed in Table A-1 on page 364.

� mgrTrapSeverity: Alert Severity Value:

– Informational Only Alert(100)
– Warning (300)
– Minor (400)
– Major(500)
– Critical Alert(600)
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� mgrTrapEvtID: Event identifier, character, or 4- or 8-byte hexadecimal string

� mgrTrapMsgID: Message identifier

� mgrTrapMsgText: Alert Message Text; English only

� mgrTrapEventClass: The class identifier that is associated with the event that caused the 
trap; one of SYSTEM, AUDIT, COOLING, POWER, DISKS, MEMORY, PROCESSORS, 
SYSTEM, TEST, ADAPTOR, EXPANSION, IOMODULE, or BLADE

� mgrTrapUserid: The user ID that is associated with the event if the event is internal and 
event class is Audit

� mgrTrapService: Serviceability indicator:

– 000 - Unknown
– 100 - None
– 200 - Service Center
– 300 - Customer

The following objects might be included to some SNMP traps: 

� mgrTrapUuid: The UUID of the system that generated the event.

� mgrTrapSN: The serial number of the system that generated the event.

� mgrTrapMtm: The model type of the system that generated the event.

� mgrTrapSrcLoc: The source location of the system that generated the event. This field is 
English text that describes the location; for example, Slot#xx.

� mgrTrapSrcName: The host name or display name of the managed endpoint that generated 
the event.

� mgrTrapSrcI: The IP address of the managed endpoint from which the generated event 
was received.

� mgrTrapFailFRUs: A comma-separated list of the failing FRU UUIDs, if applicable.

� mgrTrapFailSNs: A comma-separated list of the failing FRU serial numbers, if applicable.

Table A-1 lists the SNMP OID and SNMP Trap ID information for all the potential SNMP traps 
that can be generated by Lenovo XClarity Administrator.

Table A-1   SNMP OID and SNMP trap information

Event type Description OID Trap ID

Configuration Pattern configuration

mgrTrapCPConfigN Configuration Pattern Non-Critical 
Alert: Configuration change

1 .1.3.6.1.4.1.19046.200.0.1

mgrTrapCPConfigA Configuration Pattern System 
Alert: Configuration change

2 .1.3.6.1.4.1.19046.200.0.2

Configuration Pattern task

mgrTrapCPTaskN Configuration Pattern Non-Critical 
System Alert: Task

3 .1.3.6.1.4.1.19046.200.0.3

mgrTrapCPTaskA Configuration Pattern System 
Alert: Task

4 .1.3.6.1.4.1.19046.200.0.4

Security configuration 

mgrTrapSEConfigN Security Non-Critical Alert: 
Configuration change

5 .1.3.6.1.4.1.19046.200.0.5
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mgrTrapSETaskN security Non-Critical System Alert: 
Task

7 .1.3.6.1.4.1.19046.200.0.7

mgrTrapSETaskA Security System Alert: Task 8 .1.3.6.1.4.1.19046.200.0.8

Remote Login

mgrTrapSERemoteLoginN System Alert: Remote Login 9 .1.3.6.1.4.1.19046.200.0.9

Service- and Support configuration

mgrTrapSSConfigN Service and Support Non-Critical 
Alert: Configuration change

10 .1.3.6.1.4.1.19046.200.0.10

mgrTrapSSConfigA Service and Support System Alert: 
Configuration change

11 .1.3.6.1.4.1.19046.200.0.11

Service and Support task

mgrTrapSSTaskN Service and Support Non-Critical 
System Alert: Task

12 .1.3.6.1.4.1.19046.200.0.12

mgrTrapSSTaskA Service and Support System Alert: 
Task

13 .1.3.6.1.4.1.19046.200.0.13

 Monitor and Event configuration

mgrTrapMEConfigN Monitor and Event Non-Critical 
Alert: Configuration change

14 .1.3.6.1.4.1.19046.200.0.14

mgrTrapMEConfigA Monitor and Event System Alert: 
Configuration change

15 .1.3.6.1.4.1.19046.200.0.15

Monitor and Event task

mgrTrapMETaskN Monitor and Event Non-Critical 
System Alert: Task

16 .1.3.6.1.4.1.19046.200.0.16

mgrTrapMETaskA Monitor and Event System Alert: 
Task

17 .1.3.6.1.4.1.19046.200.0.17

mgrTrapMELogFullA Monitor and Event System Alert: 
Log 100% full

18 .1.3.6.1.4.1.19046.200.0.18

mgrTrapMELogSysA Monitor and Event System Alert: 
Log 80% full

19 .1.3.6.1.4.1.19046.200.0.19

FlexCat configuration 

mgrTrapFCConfigN FlexCat Non-Critical Alert: 
Configuration change

20 .1.3.6.1.4.1.19046.200.0.20

mgrTrapFCConfigA FlexCat System Alert: 
Configuration change

21 .1.3.6.1.4.1.19046.200.0.21

FlexCat task

mgrTrapFCTaskN FlexCat Non-Critical System Alert: 
Task

22 .1.3.6.1.4.1.19046.200.0.22

Discovery task

mgrTrapDITaskN Discovery Non-Critical System 
Alert: Task

25 .1.3.6.1.4.1.19046.200.0.25

Event type Description OID Trap ID
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mgrTrapDITaskA Discovery System Alert: Task 26 .1.3.6.1.4.1.19046.200.0.26

Updates task

mgrTrapUPTaskN Updates Non-Critical System 
Alert: Task

27 .1.3.6.1.4.1.19046.200.0.27

mgrTrapUPTaskA Updates System Alert: Task 28 .1.3.6.1.4.1.19046.200.0.28

Data Management task

mgrTrapDMTaskN Data Management Non-Critical 
System Alert: Task

29 .1.3.6.1.4.1.19046.200.0.29

mgrTrapDMTaskA Data Management System Alert: 
Task

30 .1.3.6.1.4.1.19046.200.0.30

Remote control task

mgrTrapRCTaskN Remote Control Non-Critical 
System Alert: Task

31 .1.3.6.1.4.1.19046.200.0.31

mgrTrapRCTaskA Remote Control System Alert: 
Task

32 .1.3.6.1.4.1.19046.200.0.32

LXCC Configuration Pattern configuration

mgrTrapMPConfigN LXCC Configuration Pattern 
Non-Critical Alert: Configuration 
change

33 .1.3.6.1.4.1.19046.200.0.33

mgrTrapMPConfigA LXCC Configuration Pattern Alert: 
Configuration change

34 .1.3.6.1.4.1.19046.200.0.34

LXCC Configuration Pattern task

mgrTrapMPTaskN LXCC Configuration Pattern 
Non-Critical System Alert: Task

35 .1.3.6.1.4.1.19046.200.0.35

mgrTrapMPTaskA LXCC Configuration Pattern 
System Alert: Task

36 .1.3.6.1.4.1.19046.200.0.36

LXCC Infrastructure configuration

mgrTrapMIConfigN LXCC Infrastructure Non-Critical 
Alert: Configuration change

37 .1.3.6.1.4.1.19046.200.0.37

mgrTrapMIConfigA LXCC Infrastructure Alert: 
Configuration change

38 .1.3.6.1.4.1.19046.200.0.38

LXCC Infrastructure task

mgrTrapMITaskN LXCC Infrastructure Non-Critical 
System Alert: Task

39 .1.3.6.1.4.1.19046.200.0.39

mgrTrapMITaskA LXCC Infrastructure System Alert: 
Task

40 .1.3.6.1.4.1.19046.200.0.40

LXCC Adapter configuration

mgrTrapMXConfigN LXCC Adapter Non-Critical Alert: 
Configuration change

41 .1.3.6.1.4.1.19046.200.0.41

Event type Description OID Trap ID
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mgrTrapMXConfigA LXCC Adapter Alert: Configuration 
change

42 .1.3.6.1.4.1.19046.200.0.42

 LXCC Adapter task

mgrTrapMXTaskN LXCC Infrastructure Non-Critical 
System Alert: Task

43 .1.3.6.1.4.1.19046.200.0.43

mgrTrapMXTaskA LXCC Infrastructure System Alert: 
Task

44 .1.3.6.1.4.1.19046.200.0.44

LXCC Console configuration

mgrTrapMCConfigN LXCC Console Non-Critical Alert: 
Configuration change

45 .1.3.6.1.4.1.19046.200.0.45

mgrTrapMCConfigA LXCC Console Alert: 
Configuration change

46 .1.3.6.1.4.1.19046.200.0.46

LXCC Console task

mgrTrapMCTaskN LXCC Console Non-Critical 
System Alert: Task

47 .1.3.6.1.4.1.19046.200.0.47

mgrTrapMCTaskA LXCC Console System Alert: Task 48 .1.3.6.1.4.1.19046.200.0.48

Default application 

mgrTrapSysN Non-Critical System Alert: See the 
event identifier for the specific 
condition.

98 .1.3.6.1.4.1.19046.200.0.98

mgrTrapSysA System Alert: See the event 
identifier for the specific condition.

99 .1.3.6.1.4.1.19046.200.0.99

CMM/IMM hardware 

mgrTrapLdrToS System Alert: OS Loader Timeout 100 .1.3.6.1.4.1.19046.200.0.100

mgrTrapNwChangeS System Alert: Network change 
notification

101 .1.3.6.1.4.1.19046.200.0.101

mgrTrapOsToS System Alert: OS Timeout value 
exceeded

102 .1.3.6.1.4.1.19046.200.0.102

mgrTrapPowerN Non-Critical Alert: Power 103 .1.3.6.1.4.1.19046.200.0.103

mgrTrapRLogin Non-Critical Alert: Remote Login. 104 .1.3.6.1.4.1.19046.200.0.104

mgrTrapSysLogS system Alert: System Log 75% full. 105 .1.3.6.1.4.1.19046.200.0.105

mgrTrapBootSSystem Alert: System Boot Failure. 106 .1.3.6.1.4.1.19046.200.0.106

mgrTrapCPUC Critical Alert: CPU Error. 107 .1.3.6.1.4.1.19046.200.0.107

mgrTrapCPUN Non-Critical Alert: CPU Error 108 .1.3.6.1.4.1.19046.200.0.108

mgrTrapFanC Critical Alert: Single Fan failure. 109 .1.3.6.1.4.1.19046.200.0.109

mgrTrapFanN Non-Critical Alert: Fan Error. 110 .1.3.6.1.4.1.19046.200.0.110

mgrTrapHardwareC Critical Alert: Other Failure - refer 
to Message ID for specific 
condition

111 .1.3.6.1.4.1.19046.200.0.111

Event type Description OID Trap ID
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mgrTrapHardwareN Non-Critical Alert: Warning - refer 
to Message ID for specific 
condition

112 .1.3.6.1.4.1.19046.200.0.112

mgrTrapHdC Critical Alert: Hard disk drive 
failure

113 .1.3.6.1.4.1.19046.200.0.113

mgrTrapIhcC Critical Alert: Incompatible 
hardware configuration.

114 .1.3.6.1.4.1.19046.200.0.114

mgrTrapMemoryC Critical Alert: Memory Error. 115 .1.3.6.1.4.1.19046.200.0.115

mgrTrapMemoryN Non-Critical Alert: Memory Error. 116 .1.3.6.1.4.1.19046.200.0.116

mgrTrapPFAS System Alert: Predictive Failure 
Analysis (PFA) information

117 .1.3.6.1.4.1.19046.200.0.117

mgrTrapPoffS System Alert: Power Off. 118 .1.3.6.1.4.1.19046.200.0.118

mgrTrapPonS System Alert: Power On. 119 .1.3.6.1.4.1.19046.200.0.119

mgrTrapPowerC Critical Alert: Power failure. 120 .1.3.6.1.4.1.19046.200.0.120

mgrTrapRdpsC Critical Alert: Redundant Power 
Supply failure.

121 .1.3.6.1.4.1.19046.200.0.121

mgrTrapRdpsN Non-Critical Alert: Redundant 
Power Supply failure

122 .1.3.6.1.4.1.19046.200.0.122

mgrTrapTempC Critical Alert: Temperature 
threshold exceeded

123 .1.3.6.1.4.1.19046.200.0.123

mgrTrapTempN Non-Critical Alert: Temperature 
threshold exceeded

124 .1.3.6.1.4.1.19046.200.0.124

mgrTrapVoltC Critical Alert: Voltage threshold 
exceeded

125 .1.3.6.1.4.1.19046.200.0.125

mgrTrapVoltN Non-Critical Alert: Voltage 
threshold exceeded

126 .1.3.6.1.4.1.19046.200.0.126

mgrTrapBladeC Critical Alert: Blade 127 .1.3.6.1.4.1.19046.200.0.127

mgrTrapBladeN Non-Critical Alert: Blade 128 .1.3.6.1.4.1.19046.200.0.128

mgrTrapBladeS System Alert: Blade 129 .1.3.6.1.4.1.19046.200.0.129

mgrTrapChassisC Critical Alert: Chassis Module 130 .1.3.6.1.4.1.19046.200.0.130

mgrTrapChassisN Non-Critical Alert: Chassis Module 131 .1.3.6.1.4.1.19046.200.0.131

mgrTrapChassisS System Alert: Chassis Module 132 .1.3.6.1.4.1.19046.200.0.132

mgrTrapIOC Critical Alert: I/O Module 133 .1.3.6.1.4.1.19046.200.0.133

mgrTrapION Non-Critical Alert: I/O Module 134 .1.3.6.1.4.1.19046.200.0.134

mgrTrapIOS System Alert: I/O Module 135 .1.3.6.1.4.1.19046.200.0.135

mgrTrapSysInvS System Alert: Inventory 136 .1.3.6.1.4.1.19046.200.0.136

mgrTrapLogFullN Non-Critical Alert: Event Log 100% 
Full

137 .1.3.6.1.4.1.19046.200.0.137

IOM

Event type Description OID Trap ID
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Sal trap

mgrTrapAuditLogMsg An audit log trap was received 200 .1.3.6.1.4.1.19046.200.0.200

mgrTrapAuditLogCleared All audit logs are cleared by user 201 .1.3.6.1.4.1.19046.200.0.201

mgrTrapAuditLogFullAlert Audit logs nearly full 202 .1.3.6.1.4.1.19046.200.0.202

mgrTrapAuditLogWrapAround Audit logs wrapped 203 .1.3.6.1.4.1.19046.200.0.203

Default IOM trap

mgrTrapSwAppA System Alert: See the event 
identifier for the specific condition

204 .1.3.6.1.4.1.19046.200.0.204

mgrTrapColdStart ColdStart:The SNMP entity that 
supports a notification originator 
application; is reinitializing and its 
configuration might be altered

205 .1.3.6.1.4.1.19046.200.0.205

mgrTrapWarmStart WarmStart: The SNMP entity that 
supports a notification originator 
application; is reinitializing and its 
configuration is not altered

206 .1.3.6.1.4.1.19046.200.0.206

mgrTrapLinkDown LinkDown: A failure in one of the 
communication links

207 .1.3.6.1.4.1.19046.200.0.207

mgrTrapLinkUp The communication link is up 208 .1.3.6.1.4.1.19046.200.0.208

mgrTrapAuthenticationFailure AuthenticationFailure: The 
sending protocol entity is the 
addressee of a protocol message 
that is not properly authenticated

209 .1.3.6.1.4.1.19046.200.0.209

mgrTrapEgpNeighborLoss An EGP neighbor for whom the 
sending protocol entity was an 
EGP peer marked down and the 
peer relationship no longer obtains

210 .1.3.6.1.4.1.19046.200.0.210

mgrTrapNewRoot NewRoot: The sending agent 
became the new root of the 
Spanning Tree

211 .1.3.6.1.4.1.19046.200.0.211

mgrTrapTopologyChange TopologyChange: Sent by a bridge 
when any of its configured ports 
change from the Learning state to 
the Forwarding state or from the 
Forwarding state to the Blocking 
state

212 .1.3.6.1.4.1.19046.200.0.212

mgrTrapAltSwDefGwUp The indicated gateway is up 213 .1.3.6.1.4.1.19046.200.0.213

mgrTrapAltSwDefGwDown The indicated gateway is down 214 .1.3.6.1.4.1.19046.200.0.214

mgrTrapAltSwDefGwInService Default Gateway is in service 215 .1.3.6.1.4.1.19046.200.0.215

mgrTrapAltSwDefGwNotInService Default Gateway is not in service 216 .1.3.6.1.4.1.19046.200.0.216

mgrTrapAltSwVrrpNewMaster A VRRP routing device changed 
state to master

217 .1.3.6.1.4.1.19046.200.0.217

Event type Description OID Trap ID
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mgrTrapAltSwVrrpNewBackup A VRRP routing device changed 
state to back up

218 .1.3.6.1.4.1.19046.200.0.218

mgrTrapAltSwVrrpAuthFailure A VRRP routing device 
authentication failed

219 .1.3.6.1.4.1.19046.200.0.219

mgrTrapAltSwLoginFailure A user login failed 220 .1.3.6.1.4.1.19046.200.0.220

mgrTrapAltSwTempExceedThreshol
d

The actual temperature reading is 
above the warning temperature 
threshold

221 .1.3.6.1.4.1.19046.200.0.221

mgrTrapAltSwValidLogin A user logged in to a device 222 .1.3.6.1.4.1.19046.200.0.222

mgrTrapAltSwApplyComplete A new configuration was applied 223 .1.3.6.1.4.1.19046.200.0.223

mgrTrapAltSwSaveComplete A new configuration was saved 224 .1.3.6.1.4.1.19046.200.0.224

mgrTrapAltSwFwDownloadSucess The firmware was downloaded 
successfully

225 .1.3.6.1.4.1.19046.200.0.225

mgrTrapAltSwFwDownloadFailure The firmware download failed 226 .1.3.6.1.4.1.19046.200.0.226

mgrTrapAltSwStgNewRoot NewRoot: The sending agent 
became the new root of the 
Spanning Tree

227 .1.3.6.1.4.1.19046.200.0.227

mgrTrapAltSwCistNewRoot NewRoot: The sending agent 
became common and internal 
Spanning Tree (CIST) New Root

228 .1.3.6.1.4.1.19046.200.0.228

mgrTrapAltSwStgTopologyChanged There was an STG topology 
change

229 .1.3.6.1.4.1.19046.200.0.229

mgrTrapAltSwCistTopologyChanged TopologyChange: CIST Topology 
Changed

230 .1.3.6.1.4.1.19046.200.0.230

mgrTrapAltSwHotlinksMasterUp The Master interface is active 231 .1.3.6.1.4.1.19046.200.0.231

mgrTrapAltSwHotlinksMasterDn The Master interface is not active 232 .1.3.6.1.4.1.19046.200.0.232

mgrTrapAltSwHotlinksBackupUp The Backup interface is active 233 .1.3.6.1.4.1.19046.200.0.233

mgrTrapAltSwHotlinksBackupDn The Backup interface is not active 234 .1.3.6.1.4.1.19046.200.0.234

mgrTrapAltSwHotlinksNone There are no active interfaces at 
device

235 .1.3.6.1.4.1.19046.200.0.235

mgrTrapAltSwNtpNotServer No Primary or secondary Network 
Time Protocol (NTP) server cannot 
be contacted

236 .1.3.6.1.4.1.19046.200.0.236

mgrTrapAltSwNtpUpdateClock Received Network Time Protocol 
(NTP) update

237 .1.3.6.1.4.1.19046.200.0.237

mgrTrapAltSwValidLogout A user logged out of a device 238 .1.3.6.1.4.1.19046.200.0.238

mgrTrapAltSwStgBlockingState Port state is changed to blocking 
state

239 .1.3.6.1.4.1.19046.200.0.239

mgrTrapAltSwECMPGatewayUp ECMP gateway is up 240 .1.3.6.1.4.1.19046.200.0.240

mgrTrapAltSwECMPGatewayDown ECMP gateway is down 241 .1.3.6.1.4.1.19046.200.0.241

Event type Description OID Trap ID
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mgrTrapAltSwLACPPortBlocked LACP is operationally down and 
traffic is blocked on the port

242 .1.3.6.1.4.1.19046.200.0.242

mgrTrapAltSwLACPPortUnblocked LACP is operationally up and 
traffic is no longer blocked on the 
port

243 .1.3.6.1.4.1.19046.200.0.243

mgrTrapAltVMGroupVMotion A virtual machine moved from a 
port to another

244 .1.3.6.1.4.1.19046.200.0.244

mgrTrapAltVMGroupVMOnline An advance provisioned VM came 
online

245 .1.3.6.1.4.1.19046.200.0.245

mgrTrapAltVMGroupVMVlanChange A VM entered a vlan or changed 
the vlan

246 .1.3.6.1.4.1.19046.200.0.246

mgrTrapAltSwTempReturnThreshold The switch temperature returned 
below maximum safety limits.

247 .1.3.6.1.4.1.19046.200.0.247

mgrTrapAltSwStackSwitchAttached A new switch attached to the stack 248 .1.3.6.1.4.1.19046.200.0.248

mgrTrapAltSwStackSwitchDettached A switch detached from the stack 249 .1.3.6.1.4.1.19046.200.0.249

mgrTrapAltSwStackBackupPresent A new backup switch for a stack 
was set.

250 .1.3.6.1.4.1.19046.200.0.250

mgrTrapAltSwStackBackupGone The backup switch was made 
unavailable

251 .1.3.6.1.4.1.19046.200.0.251

mgrTrapAltSwStackMasterAfterInit The switch became master after 
init

252 .1.3.6.1.4.1.19046.200.0.252

mgrTrapAltSwStackMasterFromBac
kup

The switch in a stack became 
master from backup

253 .1.3.6.1.4.1.19046.200.0.253

mgrTrapAltSwStackDuplicateJoinAtt
empt

A new switch with duplicate 
UUID/bay attempted to join the 
stack.

254 .1.3.6.1.4.1.19046.200.0.254

mgrTrapAltSwStackLinkUp A stack link is up 255 .1.3.6.1.4.1.19046.200.0.255

mgrTrapAltSwStackLinkDown A stack link is down 256 .1.3.6.1.4.1.19046.200.0.256

mgrTrapAltSwStackXferError The transfer between the master 
and a member terminated with 
error

257 .1.3.6.1.4.1.19046.200.0.257

mgrTrapAltSwStackXferSuccess The transfer between the master 
and a member terminated with no 
error

258 .1.3.6.1.4.1.19046.200.0.258

mgrTrapAltSwStackSwitchTypeMism
atch

A new switch of different type 
attempted to join the stack

259 .1.3.6.1.4.1.19046.200.0.259

mgrTrapAltSwStackImageSlotMisma
tch

The slot of the boot image of a 
newly attached switch does not 
match that of the master

260 .1.3.6.1.4.1.19046.200.0.260

mgrTrapAltSwStackImageVersMism
atch

The version of the boot image of a 
newly attached switch does not 
match that of the master

261 .1.3.6.1.4.1.19046.200.0.261

Event type Description OID Trap ID
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mgrTrapAltSwStackChassisTypeMis
match

A new switch in a chassis of 
different and incompatible type 
attempted to join the stack

262 .1.3.6.1.4.1.19046.200.0.262

mgrTrapAltSwStackBcsBayMismatc
h

A new switch in a BCS chassis in 
bay with different and incompatible 
port mapping attempted to joint the 
stack

263 .1.3.6.1.4.1.19046.200.0.263

mgrTrapAltSwStackBootCfgMismatc
h

The booted configuration of a 
newly attached switch does not 
match that of the master

264 .1.3.6.1.4.1.19046.200.0.264

mgrTrapAltSwStackNvramMasterJoi
n

A switch that was configured as a 
master in NVRAM attached to the 
stack

265 .1.3.6.1.4.1.19046.200.0.265

mgrTrapAltSwStackForceDetach The master sent a FORCE 
DETACH message to a member

266 .1.3.6.1.4.1.19046.200.0.266

mgrTrapAltSwLFDPortErrdisabled A port is error-disabled because of 
excessive link flaps

267 .1.3.6.1.4.1.19046.200.0.267

mgrTrapAltSwVlagInstanceUp vLAG instance is up 268 .1.3.6.1.4.1.19046.200.0.268

mgrTrapAltSwVlagInstanceRemoteU
p

vLAG is down, but remote instance 
is up

269 .1.3.6.1.4.1.19046.200.0.269

mgrTrapAltSwVlagInstanceLocalUp vLAG is down, but local instance is 
up

270 .1.3.6.1.4.1.19046.200.0.270

mgrTrapAltSwVlagInstanceDown vLAG instance is down 271 .1.3.6.1.4.1.19046.200.0.271

mgrTrapAltSwVlagIslUp The connection between vLAG 
switches is up

272 .1.3.6.1.4.1.19046.200.0.272

mgrTrapVmCheckSpoofedvm A spoofed VM MAC was found 273 .1.3.6.1.4.1.19046.200.0.273

mgrTrapAltSwVlagIslDown The connection between vLAG 
switches is down

274 .1.3.6.1.4.1.19046.200.0.274

mgrTrapSwOflowConnectControllerF
ailure

The connection to openflow 
controller is broken

275 .1.3.6.1.4.1.19046.200.0.275

mgrTrapSwOflowConnectController
Success

The connection to openflow 
controller is successful

276 .1.3.6.1.4.1.19046.200.0.276

mgrTrapSwOflowEmergencyState The openflow switch moving to 
emergency state

277 .1.3.6.1.4.1.19046.200.0.277

mgrTrapSwOflowNoEmergencyState The openflow switch came out of 
emergency state

278 .1.3.6.1.4.1.19046.200.0.278

mgrTrapSwOflowSwitchOflowMode The device is working in openflow 
switch mode

279 .1.3.6.1.4.1.19046.200.0.279

mgrTrapSwOflowSwitcNormalMode The device is in normal mode 280 .1.3.6.1.4.1.19046.200.0.280

mgrTrapSwOflowSwitcFlowtableClr The flow table entries cleared from 
the device table

281 .1.3.6.1.4.1.19046.200.0.281

mgrTrapSwOflowSwitcStatsClr Openflow statistics cleared from 
the device

282 .1.3.6.1.4.1.19046.200.0.282
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mgrTrapSwOflowFlowtableEntryUna
vail

The device cannot add flow entry 
in openflow because of 
unavailability of system resources

283 .1.3.6.1.4.1.19046.200.0.283

mgrTrapSwOflowFlowtableLimit The device reached its configured 
flow limit

284 .1.3.6.1.4.1.19046.200.0.284

mgrTrapSwOflowPortDownControlle
r

The port operationally down by 
openflow controller

285 .1.3.6.1.4.1.19046.200.0.285

mgrTrapSwOflowPortUpController The port operationally up by 
openflow controller

286 .1.3.6.1.4.1.19046.200.0.286

mgrTrapSwOflowVersionNegotiation
Error

The device cannot connect to 
controller Openflow because of 
bad versions or negotiation failure

287 .1.3.6.1.4.1.19046.200.0.287

mgrTrapAltSwDefAdminDisable Default admin account was 
disabled

288 .1.3.6.1.4.1.19046.200.0.288

mgrTrapAltSwAcntStrngPswdNotMet The configured password does not 
match strong password complexity

289 .1.3.6.1.4.1.19046.200.0.289

mgrTrapAltSwAcntLocked An account was locked 290 .1.3.6.1.4.1.19046.200.0.290

mgrTrapAltSwAcntUnlocked An account was unlocked 291 .1.3.6.1.4.1.19046.200.0.291

mgrTrapAltSwSNMPBlockIPTrap When SNMP requests are 
blocked, a trap is sent that shows 
the block

292 .1.3.6.1.4.1.19046.200.0.292

mgrTrapAltARPtablefull ARP Table is full 293 .1.3.6.1.4.1.19046.200.0.293

Event type Description OID Trap ID

SNMP free tool that supports SNMP v3: To see and verify the information that is listed in 
Table A-1 on page 364, we used a free tool that is called Manage Engine MIB Browser. 
The tool can be downloaded from the following website:

https://www.manageengine.com/products/mibbrowser-free-tool/

Manage Engine MIB Browser includes the following features:

� Load/unload MIBs and fetch MIB data of SNMP(v1, v2c, v3) agents
� Perform SNMP operations from Windows, Linux, and Mac devices
� Parse traps that are based on predefined match criteria
� View traps from SNMP agents and set up alert emails
� Use SNMPv3 security as defined in USM and VACM standards
� View SNMP Table data and get graphical representation in real time
� Get the complete list of OIDs implemented on your device
Appendix A. MIB Appendix 373

https://www.manageengine.com/products/mibbrowser-free-tool/


374 Lenovo XClarity Administrator Planning and Implementation Guide



Appendix B. Extended IMM Settings

This appendix lists the Possible IMM settings that can included or excluded as part of an IMM 
category pattern that is then deployed to a server.

You can include other settings (as listed in Table B-1) in the pattern to configure the value that 
is written to the server for that setting when the pattern is deployed.

You can also deselect settings to exclude them from the pattern. Excluding a setting from the 
pattern means that deploying the pattern does not change the value for this setting on the 
server.

Table B-1   Extended IMM settings

B

Additional category Additional Category or Setting Setting

General settings

Integrated Module Information IMM LU Position

Integrated Module Power Power On Server Power On Every

Power On At Specified Date

Power On At Specified Time

Power On Clear Date

Power Off Server Power Off Every

Shutdown And Power Off

Power Off At Specified Time

Power Off On Server Power Off On Every

Shutdown And Restart

Power Off On At Specified Time

Integrated Module Thermal Thermal Mode Policy
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Integrated Module PXE Setting PXE Next Boot Enabled

Integrated Module Watchdog OS Watchdog

Loader Watchdog

Power Off Delay

Remote Alert Recipient

Alert Configuration Retry Limit

Entries Delay

Retry Delay

SNMP Alerts SNMP Alert Status

SNMP Alerts - Critical Alert

SNMP Critical Alerts Status

SNMP Alerts - Warning Alert

SNMP Warning Alerts Status

SNMP Alerts - System Alert

SNMP System Alerts Status

Serial Port Configuration Serial Parity Bits

Serial Stop Bits

LAN Over USB Setting LAN Over USB

USB IP Settings IP

USB IP Settings Subnet

USB IP Settings OS IP

USB Port Forwarding Setting USB Port Forwarding

USB Forward Port

Additional category Additional Category or Setting Setting
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Network Settings Interface

SNMP Configuration SNMPv1 Agent

SNMPv3 Agent

SNMP Traps

Community Name 1

Community Name 2

Community Name 3

Community 1 Access Type

Community 2 Access Type

Community 3 Access Type

Community 1 Host IP Address 1

Community 1 Host IP Address 2

Community 1 Host IP Address 3

Community 2 Host IP Address 1

Community 2 Host IP Address 2

Community 2 Host IP Address 3

Community 3 Host IP Address 1

Community 3 Host IP Address 2

Community 3 Host IP Address 3

Telnet Configuration TelnetSessions

SMTP Configuration SMTP Server Name

SMTP Server Port

SSH Configuration SSH Enable

Additional category Additional Category or Setting Setting
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Storage

Storage Auto Configure RAID RAID level

Drive number

Strip size

Write policy

Read policy

I/O policy

Access policy

Disk cache policy

Initialization status

Drive Interface Type

Drive Media Type

Hotspare Number

Volume Size

Volume Name

Additional category Additional Category or Setting Setting
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Appendix C. Extended UEFI Settings

This appendix lists the possible Extended UEFI settings that can be included or excluded as 
part of an Extended UEFI category pattern that is then deployed to a server.

You can select settings (as listed in Table C-1) in the pattern to configure the value that is 
written to the server for that setting when the pattern is deployed.

You can also deselect settings to exclude them from the pattern. Excluding a setting from the 
pattern means that deploying the pattern does not change the value for this setting on the 
server.

Table C-1   Extended UEFI and Boot Manager settings

C

 Category Setting Additional Options

UEFI

Advanced RAS PCIe Isolation

POST Attempts POST Attempts Limit

Legacy Support Force Legacy Video on Boot

Rehook INT 19h

Legacy Thunk Support

Infinite Boot Retry

BBS Boot

Non-Planar PXE

Backup Bank Management Backup Bank Management Method

Number Of Successful Consecutive Boots

Number Of Weeks

Operating Modes Choose Operating Mode

Turbo Mode
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Disk GPT Recovery Disk GPT Recovery

System Recovery POST Watchdog Timer

POST Watchdog Timer Value

Reboot System on NMI

Halt On Severe Error

Processors Turbo Mode

Processor Performance States

C-States

C1 Enhanced Mode

Hyper-Threading

Execute Disable Bit

Trusted Execution Technology

Intel Virtualization Technology

Hardware Prefetcher

Adjacent Cache Prefetch

DCU Streamer Prefetcher

DCU IP Prefetcher

DCA

Energy Efficient Turbo

Uncore Frequency Scaling

MWAIT/MMONITOR

QPI Link Disable

COD Preference

Early Snoop Preference

Per Core P-state.

Cores in CPU Package

QPI Link Frequency

Turbo Limits

Power Active Energy Manager

Power/Performance Bias

Platform Controlled Type

Workload Configuration

S3 Enable

Lenovo Efficiency Mode

 Category Setting Additional Options
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Devices and I/O Ports Set Option ROM Execution Order Set Option ROM Execution Order

Enable / Disable Onboard Device(s) Ethernet

Video

I/O Mezzanine 1

I/O Mezzanine 1 Dev 2

I/O Mezzanine 2

ETE Expansion Conn

Enable / Disable Adapter Option ROM Support SAS Controller

Ethernet

Ethernet 2

Ethernet 3

Ethernet 4

Video

I/O Mezzanine 1

I/O Mezzanine 1 Dev 2

I/O Mezzanine 2

ETE Expansion Conn

Ethernet 2

Ethernet 3

Ethernet 4

PCIe Gen1/Gen2/Gen3 Speed Selection I/O Mezzanine 1

I/O Mezzanine 1 Dev 2

I/O Mezzanine 2

ETE Expansion Conn

Active Video

PCI 64-Bit Resource Allocation

MM Config Base

Intel?? VT for Directed I/O (VT-d)

 Category Setting Additional Options
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Memory Memory Mode

Sparing

Memory Speed

Memory Power Management

Socket Interleave

Patrol Scrub

Memory Data Scrambling

Page Policy

Rank Margining Test

RMT Pattern Length

Serial Debug Message Level

Boot Manager

Boot Modes Optimized Boot

Quiet Boot

 Category Setting Additional Options
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ronyms
AD Active Directory

AP Asia Pacific

API application programming interface

ARP Address Resolution Protocol

BBS BIOS Boot Specification

BBU battery backup unit

BCS BladeCenter S

BIOS basic input output system

CA Certification Authority

CD compact disk

CEE Converged Enhanced Ethernet

CIM Common Information Model

CIST Common and Internal Spanning 
Tree

CLI command-line interface

CMM Chassis Management Module

COD configure on disk

COM Component Object Model

CPU central processing unit

CSR Certificate Signing Request

CSV comma separated variable

DC direct current

DCA Direct Cache Access

DCU data cache unit

DDNS Dynamic Domain Name System

DDP Distributed Data Protocol

DHCP Dynamic Host Configuration 
Protocol

DN distinguished name

DNS Domain Name System

DSA Dynamic System Analysis

DVD Digital Video Disc

ECMP Equal Cost Multipath

EGP Exterior Gateway Protocol

EMEA Europe, Middle East, Africa

EMS Emergency Messaging Service

ESB Enterprise Switch Bundle

ESR Extended Support Release

ETE everything to everything

FET Fabric Extender Transceiver 

FFDC first failure data capture

Abbreviations and ac
© Copyright Lenovo 2016. All rights reserved.
FM Fabric Manager

FOD features on demand

FRU field replaceable unit

FSM Flex System Manager

GB gigabyte

GC global catalog

GCG Greater China Group

GPT GUID Partition Table

GUI graphical user interface

HA high availability

HDD hard disk drive

HTTP Hypertext Transfer Protocol

I/O input/output

IBM International Business Machines

ID identifier

IFM IBM Fabric Manager

IMM integrated management module

INT interrupt

IOM I/O module

IP Internet Protocol

ISA industry standard architecture

ISO International Organization for 
Standards

IT information technology

ITE IT element

JRE Java Runtime Environment

KVM keyboard video mouse

LACP Link Aggregation Control Protocol

LAN local area network

LDAP Lightweight Directory Access 
Protocol

LLA Link-Local address

LUN logical unit number

LXC Lenovo XClarity

MAC media access control

MB megabyte

MIB management information base

MM Management Module

MTU maximum transmission unit

NDIS network driver interface 
specification
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NIC network interface card

NIST National Institute of Standards and 
Technology

NMI non-maskable interrupt

NTP Network Time Protocol

NVRAM non-volatile random access 
memory

OID object identifiers

OS operating system

OU Organizational Unit

OVF Open Virtualization Format

PC personal computer

PCI Peripheral Component 
Interconnect

PFA Predictive Failure Analysis

PFC Priority-based Flow Control

PMR problem management report

POST power-on self test

PXE Preboot eXecution Environment

QPI QuickPath Interconnect

RAID redundant array of independent 
disks

RAM random access memory

RAS remote access services; row 
address strobe

REST representational state transfer 

RHEL Red Hat Enterprise Linux

ROM read-only memory

S&S service & support

SAN storage area network

SAS Serial Attached SCSI

SATA Serial ATA

SFTP secure FTP

SLP Service Location Protocol

SMB server message block

SMTP simple mail transfer protocol

SNMP Simple Network Management 
Protocol

SP service processor

SPAR Switch Partitioning

SSA serial storage architecture

SSD solid state drive

SSH Secure Shell

SSL Secure Sockets Layer

STG Server & Technology Group

SW software

TCP Transmission Control Protocol

TLS Transport Layer Security

TOR top-of-rack

UDP user datagram protocol

UEFI Unified Extensible Firmware 
Interface

UFP Unified Fabric Port 

URL Uniform Resource Locator

USB universal serial bus

USM User-based Security Model 

UUID Universally Unique Identifier

UXSP UpdateXpress System Packs

VACM View Access Control Model 

VLAN virtual LAN

VM virtual machine

VMFS virtual machine file system

VMX Virtual Machine Extensions

VRRP virtual router redundancy protocol

VT Virtualization Technology

WWN World Wide Name

WWNN World Wide Node Name

WWPN World Wide Port Name

XML Extensible Markup Language
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Related publications

The publications listed in this section are considered particularly suitable for a more detailed 
discussion of the topics covered in this book.

Lenovo Press publications

The following Lenovo Press publications provide additional information about the topic in this 
document. 

� Lenovo XClarity Administrator product guide

https://lenovopress.com/tips1200 

� NIC Virtualization in Flex System Fabric Solutions

http://lenovopress.com/sg248223 

Other publications and online resources

These publications and websites are also relevant as further information sources:

� Lenovo XClarity Administrator Information Center

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.lenovo.lxca.doc
/aug_product_page.html 

� Lenovo XClarity support hardware

http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-XCLACOM 

� Lenovo XClarity Integrator for VMware vCenter

http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-VMWARE 

� Lenovo XClarity Integrator Offerings for Microsoft System Center Management Solutions

http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-MANAGE 

� Flex System Information Center

http://pic.dhe.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.common.
nav.doc/ic-homepage.html 

� Fix Central

http://ibm.com/support/fixcentral 

� Lenovo Bootable Media Creator

http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-BOMC 

� Lenovo UpdateXpress

http://ibm.com/support/entry/portal/docdisplay?lndocid=LNVO-XPRESS 

� Best practices for virtual machine snapshots in the VMware environment

http://kb.vmware.com/selfservice/microsites/search.do?cmd=displayKC&externalId=
1025279 
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� TCP and UDP Ports required to access VMware vCenter Server, VMware ESXi and ESX 
hosts, and other network components 

http://kb.vmware.com/selfservice/microsites/search.do?cmd=displayKC&externalId=
1012382 
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